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Preface
This Administrator's Guide introduces Trend Micro Safe Lock Intelligent Manager and
covers all aspects of product management.

Topics in this chapter include:

• About the Documentation on page vii

• Audience on page viii

• Document Conventions on page viii

• Terminology on page ix

About the Documentation
Trend Micro Safe Lock Intelligent Manager documentation includes the following:

Table 1. Trend Micro Safe Lock Intelligent Manager Documentation

Documentation Description

Installation Guide A PDF document that discusses requirements and
procedures for installing Safe Lock Intelligent Manager.

Administrator's Guide A PDF document that discusses getting started information
and Safe Lock Intelligent Manager usage and management.

Readme file Contains a list of known issues. It may also contain late-
breaking product information not found in the printed
documentation.

Knowledge Base An online database of problem-solving and troubleshooting
information. It provides the latest information about known
product issues. To access the Knowledge Base, go to the
following website:

http://esupport.trendmicro.com

Download the latest version of the PDF documents and Readme at:

http://esupport.trendmicro.com


Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

viii   

http://docs.trendmicro.com

Audience
Trend Micro Safe Lock Intelligent Manager documentation is intended for
administrators responsible for Safe Lock Intelligent Manager management, including
agent installation. These users are expected to have advanced networking and server
management knowledge.

Document Conventions
The following table provides the official terminology used throughout the Trend Micro
Safe Lock Intelligent Manager documentation:

Table 2. Document Conventions

Convention Description

UPPER CASE Acronyms, abbreviations, and names of certain commands
and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs, and
options

Italics References to other documents

Monospace Sample command lines, program code, web URLs, file
names, and program output

Navigation > Path The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

Note Configuration notes

http://docs.trendmicro.com
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Convention Description

Tip Recommendations or suggestions

Important Information regarding required or default configuration
settings and product limitations

WARNING! Critical actions and configuration options

Terminology
The following table provides the official terminology used throughout the Trend Micro
Safe Lock Intelligent Manager documentation:

Table 3. Safe Lock Intelligent Manager Terminology

Terminology Description

Server The Safe Lock Intelligent Manager server program

Server endpoint The host where the Safe Lock Intelligent Manager server
is installed

Agents The hosts running the Safe Lock program

NAT agents The agents that are built under the routers with the
Network Address Translation (NAT) function enabled

Managed agents

Managed endpoints

The hosts running the Safe Lock program that are known
to the Safe Lock Intelligent Manager server program

Target endpoints The hosts where the Safe Lock Intelligent Manager
managed agents will be installed
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Terminology Description

Administrator (or Safe Lock
Intelligent Manager
administrator)

The person managing the Safe Lock Intelligent Manager
server

Web console The user interface for configuring and managing Safe
Lock Intelligent Manager settings and managed agents

CLI Command line interface

License activation Includes the type of Safe Lock Intelligent Manager server
installation and the allowed period of usage that you can
use the application

Agent installation folder The folder on the host that contains the Safe Lock
Intelligent Manager agent files. If you accept the default
settings during installation, you will find the installation
folder at the following location:

"c:\Program Files\Trend Micro\Safe Lock"

Server installation folder The folder on the host that contains the Safe Lock
Intelligent Manager server files. If you accept the default
settings during installation, you will find the installation
folder at the following location:

"c:\Program Files\Trend Micro\Safe Lock
Intelligent Manager"
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Chapter 1

Introduction
Trend Micro Safe Lock Intelligent Manager delivers a simple, no-maintenance solution
to lock down and protect fixed-function computers, helping protect businesses against
security threats and increase productivity.

Topics in this chapter include:

• About Trend Micro Safe Lock Intelligent Manager on page 1-2

• About Trend Micro Safe Lock on page 1-8
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About Trend Micro Safe Lock Intelligent
Manager

Trend Micro Safe Lock Intelligent Manager provides centralized monitoring and
management of Trend Micro Safe Lock agent deployment, status, and events. For
example, administrators can remotely deploy agents, create initial agent Approved Lists,
and change agent Application Lockdown states. Additionally, Safe Lock Intelligent
Manager performs malware scans and administrators can view root cause information
on files blocked from running by Safe Lock agents, reducing the time and effort needed
to verify events and allowing quick responses to incidents.

What's New in Trend Micro Safe Lock Intelligent Manager
2.0 SP 1 Patch 1

Trend Micro Safe Lock Intelligent Manager 2.0 SP1 Patch 1 includes the following new
features and enhancements

Table 1-1. Features

FEATURE DESCRIPTION

Platform support Trend Micro Safe Lock Intelligent Manager now
supports Windows 10.

Automatic log forwarding to external
servers

You can have event logs automatically forwarded
to an external syslog server for centralized
management and monitoring along with other
devices in your environment.

New account type The new Storage Device Control account has the
privileges of a Read Only account and at the
same time allows for remote control of storage
device access on managed endpoints.

Protection against storage device
access

You can allow or block storage device access to
managed endpoints.
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FEATURE DESCRIPTION

Event log enhancement Events of adding trusted file hashes are logged
and are accessible from the Server Event screen
(Logs > Server Events) of the Intelligent
Manager web console.

Enhanced remote management of
agent settings

• Agent settings can now be updated remotely
by exporting and importing the settings using
the Intelligent Manager web console.

• On top of remotely adding items to agent
Approved Lists (from the Intelligent Manager
web console), you can now remotely remove
items from agent Approved Lists using the
Remote Tasks Tool.

Enhanced security of agent settings The agent Setup.ini file can now be encrypted to
prevent unauthorized access to important settings
such as the password.

Server Features and Benefits
Trend Micro Safe Lock Intelligent Manager includes the following features and benefits.

Table 1-2. Features and Benefits

Feature Benefit

Dashboard The web console dashboard provides summarized
information about monitored Safe Lock agents.
Administrators can check deployed Safe Lock agent
status easily, and can generate security reports related to
Safe Lock agent activity for specified periods.

Quick Scan Trend Micro Intelligent Manager provides malware scans
of files blocked by application protection and sets actions
for the affected files, such as delete, quarantine, or add to
Approved List.
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Feature Benefit

Centralized Agent
Management

Administrators can monitor Safe Lock agent status,
examine connection status, view configurations, collect
agent logs on-demand or by policy, and remotely turn
agent Application Lockdown on or off.

Centralized Event
Management

On endpoints protected by Safe Lock agents,
administrators can monitor events and status and respond
when files are blocked from running. Safe Lock Intelligent
Manager provides event management features that let
administrators know about blocked file events quickly and
allows them to manage these events. For example, events
can be marked open or closed for tracking, and the
detailed event information needed to resolve events can
be collected quickly and easily.

Root Cause Information
Analysis

When blocked file events happen, administrators can
determine if they are the result of a significant incident or
not. Safe Lock Intelligent Manager provides malware
scanning features and root cause information and
diagrams to help administrators investigate blocked files
quickly. For example, administrators can check if a
blocked file is required to launch a mission-critical
program, or if the blocked file is detected as malware.
Administrators can also learn where blocked files are run
from and what process launched them.

Server Event Auditing Operations performed by Safe Lock Intelligent Manager
web console accounts are logged. Safe Lock Intelligent
Manager records an operating log for each account,
tracking who logs on, who deletes event logs, and more.

Safe Lock Intelligent Manager Requirements

Important

1. Trend Micro Safe Lock Intelligent Manager has specific requirements that vary based
on other software running on the server endpoint.

2. See the latest Safe Lock Intelligent Manager readme file for the most up-to-date list of
supported operating systems.



  Introduction

  1-5

Table 1-3. Required Software for Safe Lock Intelligent Manager

Required
Software Specifications

Operating systems • Windows Server 2003 No-SP/SP1/SP2 (32-bit and 64-bit)

• Windows Server 2003 R2 No-SP/SP2 (32-bit and 64-bit)

• Windows Server 2008 SP1/SP2 (32-bit and 64-bit)

• Windows Server 2008 R2 No-SP/SP1 (64-bit)

• Windows Server 2012 No-SP (64-bit)

• Windows Server 2012 R2 No-SP (64-bit)

• Windows XP SP2/SP3 (32-bit)

• Windows 7 No-SP/SP1 (32-bit and 64-bit)

• Windows 8 No-SP (32-bit and 64-bit)

• Windows 8.1 No-SP (32-bit and 64-bit)

• Windows 10 Enterprise (32-bit and 64-bit)

• Windows 10 IoT Enterprise (32-bit and 64-bit)

Web browser (for
Safe Lock Intelligent
Manager web
console access)

Note
Safe Lock Intelligent Manager does not support any
exporting functions from its web console when accessed
via iOS systems.

• Microsoft Internet Explorer 7 or later

• The latest version of Google Chrome

• The latest version of Mozilla Firefox

Table 1-4. Required Hardware for Safe Lock Intelligent Manager (without Safe Lock
agent)

Required Hardware Specification

RAM • 2GB minimum

• 4GB or more recommended
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Required Hardware Specification

Processor • 1 CPU core minimum

• 1 CPU core or more recommended

Available disk space • 10GB minimum

• 20GB or more recommended

Table 1-5. Required Hardware for Safe Lock Intelligent Manager (with Safe Lock
agent)

Required Hardware Specification

RAM • 2GB minimum

• 4GB or more recommended

Processor • 1 CPU core minimum

• 2 CPU cores or more recommended

Available disk space • 10GB minimum

• 20GB or more recommended

Table 1-6. Required Hardware for Safe Lock Intelligent Manager (with or without
Safe Lock agent) + SQL Express 2008

Required Hardware Specification

RAM • 4GB minimum

• 8GB or more recommended

Processor • 1 CPU core minimum

• 2 CPU cores or more recommended

Available disk space • 30GB minimum

• 50GB or more recommended
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Table 1-7. Required Hardware for Safe Lock Intelligent Manager (with or without
Safe Lock agent) + SQL Server

Required Hardware Specification

RAM • 32GB or more required

Processor • 2 CPU cores minimum

• 4 CPU cores or more recommended

Available disk space • 1TB minimum

• 2TB or more recommended

Server Accounts Overview
Trend Micro Safe Lock Intelligent Manager features web console accounts with different
privileges and limitations. Use these accounts to configure Safe Lock Intelligent Manager
and to monitor or manage Safe Lock agents.

The following table outlines typical Safe Lock Intelligent Manager tasks and the account
privileges required to perform them.

 Task Account Privilege Required

1 Add Safe Lock Intelligent Manager
accounts.

• admin

2 Use remote deployment tools
(SLrst.exe) to centrally deploy
agents from the server.

• N/A

Note
Using the SLrst.exe tool does
not require specific account
privileges, but does require the
Safe Lock agent password to
deploy tasks.
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 Task Account Privilege Required

3 Use the Safe Lock Intelligent Manager
console and remote deployment tools
(SLtasks.exe) to manage the
Approved List and Write Protection
List on Safe Lock agents.

• admin

• Full Control

4 Monitor Server Event logs. • admin

• Full Control

5 Monitor Agent Event logs. • admin

• Full Control

• Storage Device Control

• Read Only

6 Download Trend Micro Safe Lock
agent installer image.

• admin

• Full Control

• Storage Device Control

• Read Only

About Trend Micro Safe Lock
Trend Micro Safe Lock protects fixed-function computers like Industrial Control
Systems (ICS), Point of Sale (POS) terminals, and kiosk terminals from malicious
software and unauthorized use. By using fewer resources and without the need for
regular software or system updates, Safe Lock can reliably secure computers in industrial
and commercial environments with little performance impact or downtime.

What's New in Trend Micro Safe Lock 2.0 SP 1 Patch 1

Trend Micro Safe Lock 2.0 SP1 Patch 1 includes the following new features and
enhancements.
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Table 1-8. Features

FEATURE DESCRIPTION

Platform support Trend Micro Safe Lock now supports Windows 10.

Protection against storage
device access

You can allow or block storage device access to
managed endpoints.

Application lockdown
enhancement

Application lockdown is enhanced with pop-up
notifications on managed endpoints to inform the latest
application blocking. This notification is disabled by
default. To enable the feature, use the SLCmd.exe
program.

Enhanced security of agent
settings

The agent Setup.ini file can now be encrypted to prevent
unauthorized access to important settings such as the
password.

Agent Features and Benefits

Trend Micro Safe Lock includes the following features and benefits.

Application Lockdown

By preventing programs, DLL files, drivers, and scripts not specifically on the Approved
List of applications from running (also known as application white listing), Safe Lock
provides both improved productivity and system integrity by blocking malicious
software and preventing unintended use.

Safe Lock write protection blocks modification and deletion of files, folders, and registry
entries.

Exploit Prevention

Known targeted threats like Downad and Stuxnet, as well as new and unknown threats,
are a significant risk to ICS and kiosk computers. Systems without the latest operating
system updates are especially vulnerable to targeted attacks.
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Safe Lock provides both intrusion prevention, which helps prevent threats from
spreading to the endpoint, and execution prevention, which helps prevent threats from
spreading to the endpoint or from running.

Easy Management

When software needs to be installed or updated, the Trusted Updater and Predefined
Trusted Updater List provide an easy way to make changes to the endpoint and
automatically add new or modified files to the Approved List, all without having to
unlock Trend Micro Safe Lock.

Small Footprint

Compared to other endpoint security solutions that rely on large pattern files that
require constant updates, application lockdown uses less memory and disk space,
without the need to download updates.

Role Based Administration

Trend Micro Safe Lock provides a separate administrator and Restricted User account,
providing full control during installation and setup, as well as simplified monitoring and
maintenance after deployment.

Graphical and Command Line Interfaces

Anyone who needs to check the software can use the console, while system
administrators can take advantage of the command line interface (CLI) to access all of
the features and functions available.

Trend Micro Portable Security Compatible

Out-of-the-box compatibility with Trend Micro Portable Security ensures
straightforward removal of any threats that do get on to the endpoint, without the need
to update the Approved List or unlock the endpoint.
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Safe Lock Requirements
This section introduces Safe Lock system requirements and upgrade limitations.

Hardware Requirements
Trend Micro Safe Lock does not have specific hardware requirements beyond those
specified by the operating system, with the following exceptions:

Table 1-9. Required Hardware for Safe Lock

Hardware/Software Description

Available disk space 200MB minimum

300MB recommended

Monitor resolution 640x480

Important
Safe Lock cannot be installed on a system that already runs one of the following:

• Trend Micro OfficeScan

• Trend Micro Titanium

• Another Trend Micro endpoint solution

Operating Systems

Note
Memory Randomization, API Hooking Prevention, and DLL Injection Prevention are not
supported on 64-bit platforms.
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Table 1-10. List of Supported Operating Systems

Windows Version
Type Windows Version Name

Windows Clients Windows 2000 SP4 (32-bit)

Note
Safe Lock installed on Windows 2000 SP4 (without
update rollup), Windows XP SP1, or Windows Server
2003 does not support the following functions: DLL/
Driver Lockdown, Script Lockdown, Integrity
Monitoring, USB Malware Protection, Storage Device
Blocking, and Predefined Trusted Updater.

Windows XP SP1*/SP2/SP3 (32-bit) (except Starter and
Home editions)

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.

Windows Vista No-SP/SP1/SP2 (32-bit) (except Starter and
Home editions)

Windows 7 No-SP/SP1 (32-bit and 64-bit) (except Starter and
Home editions)

Windows 8 No-SP (32-bit and 64-bit)

Windows 8.1 No-SP (32-bit and 64-bit)

Windows 10 Enterprise (32-bit and 64-bit)
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Windows Version
Type Windows Version Name

Note

• Make sure to unlock the endpoint before updating
your Windows 10 operating system for the
Anniversary Update.

• Memory Randomization is not supported on
operating systems running Windows 10 Creators
Update.

Windows 10 IoT Enterprise (32-bit and 64-bit)

Note

• Make sure to unlock the endpoint before updating
your Windows 10 operating system for the
Anniversary Update.

• Memory Randomization is not supported on
operating systems running Windows 10 Creators
Update.

Windows Server Windows 2000 Server SP4* (32-bit)

Note
Safe Lock installed on Windows 2000 SP4 (without
update rollup), Windows XP SP1, or Windows Server
2003 does not support the following functions: DLL/
Driver Lockdown, Script Lockdown, Integrity
Monitoring, USB Malware Protection, Storage Device
Blocking, and Predefined Trusted Updater.

Windows Server 2003 SP1/SP2 (32-bit)
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Windows Version
Type Windows Version Name

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.

Windows Server 2003 R2 No-SP/SP2 (32-bit and 64-bit)

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.

Windows Server 2008 SP1/SP2 (32-bit and 64-bit)

Windows Server 2008 R2 No-SP/SP1 (64-bit)

Windows Server 2012 No-SP (64-bit)

Windows Server 2012 R2 No-SP (64-bit)

Windows Embedded
Standard

Windows (Standard) XP Embedded SP1*/SP2 (32-bit)
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Windows Version
Type Windows Version Name

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.

Windows Embedded Standard 2009 (32-bit)

Windows Embedded Standard 7 (32-bit and 64-bit)

Windows Embedded Standard 8 (32-bit and 64-bit)

Windows Embedded Standard 8.1 (32-bit and 64-bit)

Windows Embedded
POSReady

Windows Embedded POSReady (32-bit)

Windows Embedded POSReady 2009 (32-bit)

Windows Embedded POSReady 7 (32-bit and 64-bit)

Windows Embedded
Enterprise

Windows Embedded Enterprise XP SP1*/SP2/SP3 (32-bit)

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.
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Windows Version
Type Windows Version Name

Windows Embedded Enterprise Vista (32-bit)

Windows Embedded Enterprise 7 (32-bit and 64-bit)

Windows Embedded
Server

Windows Embedded Server 2003 SP1/SP2 (32-bit)

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.

Windows Embedded Server 2003 R2 (32-bit)

Note

• Safe Lock installed on Windows 2000 SP4
(without update rollup), Windows XP SP1, or
Windows Server 2003 does not support the
following functions: DLL/Driver Lockdown, Script
Lockdown, Integrity Monitoring, USB Malware
Protection, Storage Device Blocking, and
Predefined Trusted Updater.

• Safe Lock does not support a custom action of
“quarantine” on Windows XP or Windows 2003.

Windows Embedded Server 2008 (32-bit and 64-bit)

Windows Embedded Server 2008 R2 (64-bit)

Windows Embedded Server 2012 (64-bit)

Windows Embedded Server 2012 R2 (64-bit)
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Note

See the latest Safe Lock readme file for the most up-to-date list of supported operating
systems for agents.

Agent Upgrade Preparation

WARNING!

Before upgrading, take the appropriate action below for your installation method and
installed Safe Lock agent version.

Download the latest updates from the Trend Micro Software Download Center. Go to
http://downloadcenter.trendmicro.com/.

Table 1-11. Upgrade Actions Required by Installation Method and Installed Agent
Version

Installation Method
Installed

Agent
Version

Required
Action

Settings
Retained

Local installation using
Windows Installer

1.0 No preparation
needed

No settings
retained

1.1 No preparation
needed

Compatible
settings retained

2.0 or later No preparation
needed

No settings
retained

Local installation using
Command Line Interface
Installer

1.0 Manually uninstall No settings
retained

1.1 No preparation
needed

Compatible
settings retained

2.0 or later Manually uninstall No settings
retained

http://downloadcenter.trendmicro.com/
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Installation Method
Installed

Agent
Version

Required
Action

Settings
Retained

Remote installation

Note
Safe Lock supports
remote installation
using Safe Lock
Intelligent Manager.

1.0 Manually uninstall No settings
retained

1.1 Manually uninstall No settings
retained

2.0 or later Manually uninstall No settings
retained

Supported Methods for Updating Safe Lock Agents
Safe Lock agents can be updated using various methods depending on its current
version.

Table 1-12. Supported Methods for Updating Safe Lock Agents

Current
Version

Target
Version

Supported Method for Updating Safe Lock
Agents

Local Installation Remote Installation

Using an
Installer

Using a
Patch

Module

Remote
Setup
Tool

Remote
Tasks
Tool

1.1 Latest
version

✓    

2.0  ✓ ✓  

2.0 Patch 1  ✓ ✓  

2.0 SP 1  ✓ ✓ ✓

Agent Use Overview
Trend Micro Safe Lock is a whitelist solution that locks down computers, preventing all
applications not on the Approved List from running. Safe Lock can be configured and
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maintained using the graphical user interface (GUI) agent console or the command line
interface (CLI). System updates can be applied without turning off Application
Lockdown at the endpoint through the Predefined Trusted Updater List or by using the
Trusted Updater.

Consider this typical use case scenario:

1. Set up the Approved List and turn on Application Lockdown on the endpoint so
that unapproved applications cannot be run.

2. Use the Trusted Updater to update or install software whose installer is not on the
Predefined Trusted Updater list.

3. Configure and enable the Restricted User account for later maintenance.

If someone tries to run an application not specifically on the Approved List, the
following message displays:

Figure 1-1. Trend Micro Safe Lock blocking message
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Chapter 2

Managing Safe Lock
This chapter introduces Trend Micro Safe Lock Intelligent Manager web console screen
for agent management.

Topics in this chapter include:

• About the Agents Screen on page 2-2
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About the Agents Screen
To display the Agent Management screen, go to Agents in the navigation at the top of
the web console. This screen displays a list of agents managed by Safe Lock Intelligent
Manager and allows you to perform the following tasks:

Task
Category Task Details

Create or
edit agent
groups

Filter the list of displayed
endpoints based on a
specified criterion

For more information, see Querying Agents
on page 2-3.

Create agent groups For more information, see Grouping
Agents on page 2-5.

Remove, relocate, or
unregister agents

For more information, see Removing
Agents and Groups on page 2-7.

Move agents or groups to a
selected location

Select one or more agents or groups and
click Move.

Edit tags Edit tags to help you identify and search for
agents.

For more information, see Editing Tags on
page 2-6.
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Task
Category Task Details

Remotely
change
agent
settings

Remotely enable or disable
Application Lockdown

For more information, see Remotely
Changing Application Lockdown Status on
page 2-8.

Allow or block storage
devices (CD/DVD drives,
floppy disks, and network
drives) from accessing the
managed endpoint

Select one or more endpoints and click
Send Command > Configure Device
Control.

Add trusted files For more information, see Remotely
Adding Trusted Applications and Files on
page 2-8.

Export agent settings For more information, see Remotely
Exporting Agent Settings on page 2-11.

Import agent settings For more information, see Remotely
Importing Agent Settings on page 2-12.

View agent
statuses,
settings, or
logs

View agent statuses and
settings

For more information, see Checking Agent
Statuses and Settings on page 2-4.

Collect logs and statuses For more information, see Collecting Logs
and Status on page 2-10.

Export agent settings and
summary in a CSV file

Select one or more agents and click
Export.

Querying Agents

Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.

2. Search for specific endpoints by selecting criteria from the drop-down list and
specifying additional search criteria as required.
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Tip
Safe Lock Intelligent Manager supports partial string matching.

Option Description

Endpoint Type the host name of the endpoint.

Tags Type the tag name.

IP Address Type the IPv4 address.

IP Range Type the IPv4 address.

Operating System Select an operating system.

Application Lockdown
State

Select the Application Lockdown state: Application
Lockdown On or Application Lockdown Off.

Status Collected On Select from the default time ranges or Custom and
specify your own range.

Logs Collected On Select from the default time ranges or Custom and
specify your own range.

3. Click Search (if required).

Safe Lock Intelligent Manager displays all hosts that match the search criteria.

Checking Agent Statuses and Settings
You can look up the following information of a managed endpoint from the Agent
Management screen.

• Endpoint information: This includes the IP address, operating system, and tags.

• Agent summary: This includes summary information such as the last update time
of the Approved List, NAT frequency, last NAT connection time, license status,
license expiration date, agent version, and the last agent upgrade time.

• Agent settings: This includes the current agent settings and the date and time for
the last change.
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• Pending commands: This is a list of commands to be deployed to NAT agents
upon their next connection with the Intelligent Manager. For more information on
configuring the connection frequency, see Customizing Installation Parameters on page
8-14.

Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.

2. Click a target endpoint.

The Agent Status screen appears.

Grouping Agents
Group agents according to location, type, or purpose to help you manage multiple
agents.

Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.

2. From the directory on the left, click the group folder where you want to add a sub
group, and click Add Group.

Note

• The group name must be within 64 characters.

• You can establish up to 9 layers of subfolders to the Group directory, with up to
100 folders at each group layer.

3. Click All Agents from the directory, select agents from the table, and click Move.
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Tip

Alternatively drag-and-drop agents and groups to another group in the directory.

Editing Tags

You can edit tags to help you identify and search for agents.

To edit tags, follow the steps below.
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Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.

2. Select one or more agents.

3. Click Edit Tags.

4. Type or modify the agent tags.

Tip
Safe Lock Intelligent Manager does not use a delimiter for tags.

5. Click Save.

Removing Agents and Groups
Remove groups, ungroup agents, or unregister agents from the Safe Lock Intelligent
Manager server.

Agents unregister from Safe Lock Intelligent Manager during uninstallation. However, if
you are unable to uninstall an agent before removing it from the environment, the agent
may continue to appear on the Agent Management screen. To remove the endpoints
that Safe Lock Intelligent Manager no longer manages from the list of monitored agents,
use the Remove feature to “unregister” the agents.

Note
Removing an agent from the list of monitored agents does not delete any preexisting agent
event logs.

Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.
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2. Select the agents and groups in the list that you want to remove, ungroup, or
unregister.

3. Click Remove.

4. Confirm that you want to remove, ungroup, or unregister the selected items.

Safe Lock Intelligent Manager removes the agents from the list.

Remotely Changing Application Lockdown Status

Note
Safe Lock agent administrators can also change the Application Lockdown status from the
Safe Lock agent console.

Procedure

1. Go to Agents in the navigation at the top of the web console.

2. For a single agent, click the endpoint name to display agent status details, and then
click the button to change the Application Lockdown status.

• Turn Application Lockdown On

• Turn Application Lockdown Off

3. For multiple agents and groups, select these items from the Agent Management
table, click Send Command, select Configure Application Lockdown, and click
the button to change the Application Lockdown status.

• Turn On

• Turn Off

Remotely Adding Trusted Applications and Files
Remotely allow applications and files to run on managed endpoints using hash values.
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Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.

2. Select one or more agents and groups.

3. Click Send Command and select Add Trusted Files.

The Add Trusted Files screen appears.

4. Click Download File Hash Generator to download the tool for calculating hash
values. For detailed steps, see Calculating the Hash Values on page 2-9.

5. Click Add File Hash to add a single hash value or click Import to add a batch of
hash values.

6. Mark application installers in the Installer column.

Note

This allows the files created or modified by these installers to be automatically added
to the Approved List on the selected endpoints.

Calculating the Hash Values

Use File Hash Generator to calculate hash values. To download this tool, see Remotely
Adding Trusted Applications and Files on page 2-8.

Procedure

1. Execute WKFileHashGen.exe from the downloaded folder.

The Trend Micro File Hash Generator screen appears.

2. Use any of the following methods to select files and calculate hash values:
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Note

• To ensure that all necessary files are calculated for hash values, Trend Micro
recommends adding the root folder of the target application to the File Hash
Generator for calculation.

• The Add Folder button will only calculate installer files, script files, and files in
the Portable Executable format.

• Drag-and-drop folders or files to the File Hash Generator screen.

• Click the drop-down button and click Add Files to select files.

• Click the drop-down button and click Add Folder to add all the files in the
selected folder.

Hash values appear in the File Hash (SHA-1) column.

3. For a single file, right-click the item and select Copy hash. For multiple files, click
Export All to generate a list of hash values.

Collecting Logs and Status

Logs and status contain information about agent activity. Collecting logs and status
updates the Safe Lock Intelligent Manager database with the latest information from the
selected agents.

Procedure

1. Go to Agents in the navigation at the top of the web console.

The Agent Management screen appears.

2. Select one or more agents.

3. Click Send Command and select Collect Logs & Status.
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Safe Lock Intelligent Manager updates the date and time displayed in the Last
Status Collected On and Last Logs Collected On columns after each Safe Lock
agent successfully sends logs and status to Safe Lock Intelligent Manager.

Remotely Exporting Agent Settings

You can remotely obtain agent configuration settings and Approved Lists by exporting
and downloading them from the Intelligent Manager.

Procedure

1. Click Agents from the Intelligent Manager console.

The Agent Management screen appears.

2. Select a target endpoint.

3. Click Send Command, select Export Settings, and select one of the following:

• Approved List

• Agent Configurations

The Intelligent Manager starts issuing the command. The progress can be viewed
from the pop-up Command Deployment Status window.

4. To export more settings, repeat the above steps.

When the exports are complete, you will be confirmed by this message on the top
of the screen:

5. Click View Details to download the exported settings.
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Note
Intelligent Manager can keep up to 20 sets of exported settings and cleans any file
from this list as soon as the file is downloaded.

Remotely Importing Agent Settings
You can remotely apply new agent settings to agents or agent groups from the
Intelligent Manager web console. This feature allows you to:

• remotely overwrite agent configurations

• remotely overwrite Approved Lists

• remotely add approved items to Approved Lists

Procedure

1. Prepare a customized agent configuration file or Approved List.

a. Export and download an agent configuration file or Approved List. For
detailed steps, see Remotely Exporting Agent Settings on page 2-11.

b. Customize the downloaded file.

Note
Intelligent Manager can only import an Approved List of up to 20 MB and a
configuration file of up to 1 MB.

2. Click Agents from the Intelligent Manager console.

The Agent Management screen appears.

3. To import the customized file to one or more ungrouped agents or agents in
different groups, follow the steps below.

a. From the Endpoint column, select one or more agents.

b. Click Send Command.
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c. Select Import Settings.

d. Select Approved List or Agent Configuration.

The import dialog appears.

4. To import the customized file to an agent group, follow the steps below.

a. From the left panel, right-click an agent group and go to Send Command >
Import Settings.

b. Select Approved List or Agent Configuration.

The import dialog appears.

5. By default, Intelligent Manager does the following:

• Approved List: accumulates items from the customized Approved List to the
target Approved Lists. To replace the target Approved Lists with the
customized Approved List, select Overwrite the existing Approved List.

• Agent Configuration: overwrites the target Approved Lists with the
customized Approved List.

6. Click Browse to select the customized file.

7. Click Import and Apply.
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Chapter 3

Monitoring Safe Lock
This chapter introduces Trend Micro Safe Lock Intelligent Manager monitoring
practices.

Topics in this chapter include:

• About the Dashboard on page 3-2

• About the Agent Events Screen on page 3-8

• About the Server Events Screen on page 3-13

• Maintaining Logs on page 3-14
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About the Dashboard
The Safe Lock Intelligent Manager dashboard provides at-a-glance information using
tabs and widgets. The dashboard displays the following components in a customized
view for each web console account:

• Tabs: Allow users to organize widgets on customizable screens

• Widgets: Provide various data summaries on a tab

About Web Console Accounts and the Dashboard
Each web console account can customize the dashboard tabs and widgets for that
account’s specific needs. Customizing the tabs or widgets for one account has no effect
on the tabs or widgets for a different account.

Note
When an account logs on to Safe Lock Intelligent Manager for the first time, default tabs
and widgets appear on the dashboard.

See About Default Tabs on page 3-3.

About Dashboard Tabs
The Safe Lock Intelligent Manager dashboard uses tabs to provide a flexible data
monitoring solution for administrators. Tabs provide a container for widgets, allowing
web console accounts to create their own customized dashboard. The dashboard
supports up to 30 tabs per account.

Closing tabs permanently removes them from that account. There is no way to recover
closed tabs, but you can re-create similar tabs later. Closing a tab has no impact on the
dashboard of other user accounts.

Use the slide show function to assist in monitoring widgets on different tabs by using
the following controls:

• Click Play Tab Slide Show to rotate through tabs automatically at a specified
interval.
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Tip
Configure the duration of rotation intervals in Tab Settings.

See Configuring Tab Settings on page 3-5.

• Click Pause Tab Slide Show to stop the slide show at the current tab.

Tip
Navigating to a different tab also stops the slide show.

About Default Tabs
The dashboard provides the following default tabs:

• Event Overview: This tab contains widgets that display information relating to
agent events on managed Safe Lock endpoints.

Widget Description

Open Warnings Displays the latest open warnings.

Top Blocked Files Displays the files that are blocked the most.

Blocked Event
History

Displays blocked events during the specified time period.

Top Endpoints
Triggering Blocked
Events

Displays the endpoints that triggered the most blocked
events.

Blocked File Scan
Results

Displays malware scan results for blocked files.

• Agent Overview: This tab contains widgets that display information relating to
managed Safe Lock endpoints.

Widget Description

Application
Lockdown State

Displays the Application Lockdown status for agents.
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Widget Description

Versions Displays the number of endpoints with specific versions of
Safe Lock installed.

Latest Component
Updates

Displays the latest versions of components.

Note
Change the default names of tabs on the Tab Settings screen.

See Configuring Tab Settings on page 3-5.

Adding Tabs
Add tabs to the dashboard to provide a customized information summary to your Safe
Lock Intelligent Manager account.

Procedure

1. Go to Dashboard in the navigation at the top of the web console.

2. Click the + tab.

The New Tab screen appears.

3. In the Title field, type a meaningful title for the tab.

4. Select a layout for the tab.

Note
The number of widgets that you can add to a tab depends on the layout for the tab.
Once the tab contains the maximum number of widgets, you must remove a widget
from the tab or create a new tab for the widget.

5. Configure slide show and auto-fit settings.

6. Click Save.

The empty tab appears on the dashboard.
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7. Click Add Widgets to populate the tab with widgets.

Configuring Tab Settings

Procedure

1. Go to Dashboard in the navigation at the top of the web console.

2. Click Tab Settings.

The Tab Settings screen appears.

3. In the Title field, type a meaningful title for the tab.

4. Select a layout for the tab.

5. Configure slide show and auto-fit settings.

About Widgets
Widgets are the core components for the dashboard. Tabs provide the layout and
widgets provide the actual data summary for the dashboard.

The following widgets are available:

Widget Category Description

Application
Lockdown
State

Agent Status Displays the Application Lockdown State for agents.

Versions Agent Status Displays the number of endpoints with specific
versions of Safe Lock installed.

Open Warnings Events Displays the latest open warnings.

Top Endpoints
Triggering
Blocked Events

Events Displays the endpoints that triggered the most
blocked events.
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Widget Category Description

Blocked Event
History

Events Displays blocked events during a specified time
period.

Top Blocked
Files

Events Displays the files that are blocked the most.

Blocked File
Scan Results

Events Displays malware scan results for blocked files.

Latest
Component
Updates

Server Status Displays the latest versions of components.

You can configure the data scope on many widgets individually. For example, some
widgets allow you to specify the following:

• Time period

• Pie chart or line chart

• Legend

Move widgets in tabs by dragging and dropping widgets to various locations on a tab.
The layout for a tab determines where you can move a widget.

Using Widgets

Perform the following tasks on each widget:

Task Steps

Move a widget Move widgets on tabs by clicking and holding on the title bar at
the top of the widget and dragging to various locations on a tab.

Tip
The layout for a tab determines where you can move a
widget. As you drag, a red, dotted border appears when the
widget is able to move to an area.
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Task Steps

Resize a widget Horizontally resize a widget on a multi-column tab by doing the
following:

1. Hover the pointer at the edge of a widget.

A vertical, gray bar appears.

2. Drag the pointer left or right.

Vertically resize widgets on a multi-column tab by enabling Auto-
fit in the Tab Settings. This automatically adjusts widgets to be
the same height as the widgets beside them.

Refresh widget data Click the Refresh icon at the top of the widget.

Specify automatic
refresh settings

1. Click the More Options icon at the top of the widget.

2. Select Refresh Settings.

The Refresh Settings screen appears.

3. To enable automatic refresh for this widget, do the following:

a. Select Automatically refresh the widget.

b. Specify a frequency.

Rename a widget 1. Click the More Options icon at the top of the widget.

2. Select Widget Settings.

The Widget Settings screen appears.

3. Type a meaningful title for the widget.

Close a widget 1. Click the More Options icon at the top of the widget.

2. Select Close Widget.

Adding Widgets
The number of widgets that you can add to a tab depends on the layout for the tab.
Once the tab contains the maximum number of widgets, you must remove a widget
from the tab or create a new tab for the widget.
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Procedure

1. Go to Dashboard in the navigation at the top of the web console.

2. Go to the tab on the dashboard that you want to add the widget to.

3. Click Add Widget.

The Add Widget screen appears.

4. Optionally, click one of the following to filter the widgets that display:

Category Description

Most Recent
Widgets

Queries for widgets added to a tab recently

All Widgets Queries for all widgets available

Agent Status Queries for only widgets that display data about managed
Safe Lock agents.

Events Queries for only widgets that display data about managed
Safe Lock agent events.

Server Status Queries for only widgets that display data about Safe Lock
Intelligent Manager.

5. Select one or more widgets to add to the current tab.

6. Click Add.

About the Agent Events Screen
To display the Agent Events screen, go to Logs > Agent Events in the navigation at
the top of the web console.

This screen displays a list of events related to applications not in the Approved List on
agents managed by Safe Lock Intelligent Manager.

When Lockdown is off and a file not on an agent's Approved List attempts to run or
make changes to the endpoint, Safe Lock logs the event but allows the file to run.
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When Lockdown is on and a file not on an agent's Approved List attempts to run or
make changes to the endpoint, Safe Lock stops the file and may prompt the user for the
appropriate action. Event logs contain information from managed agents about files not
in the Approved List and any action taken.

You can take the following actions on files not in the Approved List when Lockdown is
on:

• “Add to Approved List”: Prevent the file from executing for this instance but add
the file to the agent's Approved List.

• “Ignore”: Prevent the file from executing but do not move or change the file.

• “Quarantine”: Prevent the file from executing and hold the file in quarantine for
later analysis.

• “Delete”: Prevent the file from executing and delete the file.

Querying Agent Event Logs
Querying refines the list of displayed agent event logs.

Procedure

1. Go to Logs > Agent Events in the navigation at the top of the web console.

The Agent Events screen appears.

2. Click the drop-down list under Agent Events.

A list of criteria to search by appears.

3. Select the type of criteria to search by.

Appropriate search fields appear for the selected criteria.

4. Follow the appropriate steps depending on the selected criteria:

Option Description

All Events Displays all events logged by agents
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Option Description

Time Period Do one of the following:

• Select a listed time range.

• Specify a custom time range.

a. Go to Custom in the list.

b. Specify your custom time range.

c. Click Search.

Level Select an event level.

Source Select an event source.

Event Select a specific event.

Endpoint Type the beginning or all of an endpoint host name and click
Search.

Tags Type all or part of the tag and click Search.

IP Address Type the IPv4 address and click Search.

IP Range Type the IPv4 address range and click Search.

Blocked File
Name

Type all or part of a file name and click Search.

Blocked File
Hash

Type a file hash and click Search.

Marked Select Open or Closed.

Integrity
Monitoring

a. Select one of the following:

• File or folder

• Registry key or value

b. Type the search criteria and click Search.

Your search results appear in the list of events.
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Exporting Agent Events
Save data about selected agent event log entries as a CSV file.

Procedure

1. Go to Logs > Agent Events in the navigation at the top of the web console.

The Agent Events screen appears.

2. Select the events in the list that you want to export information for.

3. Click Export.

4. Save the file.

Importing Agent Events
Safe Lock Intelligent Manager supports importing agent events from the following
applications:

• Trend Micro Safe Lock Intelligent Manager: Logs exported by Safe Lock Intelligent
Manager 2.0 in CSV format

• Trend Micro Portable Security: Collect logs from Safe Lock agents running
versions 1.1 and 2.0 in DB format

Note
Portable Security exports Safe Lock logs to the tmsllog.db file by default.

Procedure

1. Go to Logs > Agent Events in the navigation at the top of the web console.

The Agent Events screen appears.

2. Click Import.

The Import screen appears.



Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

3-12   

3. Select the CSV file you want to import.

4. Click Open.

5. Click OK.

The event logs are imported into Safe Lock Intelligent Manager.

Note

If you interrupt or cancel the import, no data will be added to the Safe Lock
Intelligent Manager database.

Marking Warning Events

To help you track Warning events, change the status displayed for them under Marked
in the list.

Note

Safe Lock Intelligent Manager does not display a Marked status for Information events.

Procedure

1. Go to Logs > Agent Events in the navigation at the top of the web console.

The Agent Events screen appears.

2. Select the Warning event or events you want to change the status of.

3. Change the status by doing one of the following:

• Click Mark Open.

• Click Mark Closed .
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About the Server Events Screen
To display the Server Events screen, go to Logs > Server Events in the navigation at
the top of the web console.

This screen displays a log of audited Safe Lock Intelligent Manager web console account
activity.

Note

Server event logs contain collected information about actions taken by Safe Lock
Intelligent Manager web console account users and policies.

Querying Server Event Logs
Querying refines the list of displayed server event logs.

Procedure

1. Go to Logs > Server Events in the navigation at the top of the web console.

The Server Events screen appears.

2. Click the drop-down list under Server Events.

A list of search criteria.

3. Select the type of search criteria.

Appropriate search fields appear for the selected criteria.

4. Follow the appropriate steps depending on the selected criteria:

Option Description

Time Period Do one of the following:

• Select a listed time range.

• Specify a custom time range.
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Option Description
a. Go to Custom in the list.

b. Specify your custom time range.

c. Click Search.

User Name Type the beginning or all of a Safe Lock Intelligent Manager account
user name.

Event Select a specific event.

Your search results appear in the list of server event logs.

Exporting Server Event Logs
Save data about selected server event log entries as a CSV file.

Procedure

1. Go to Logs > Server Events in the navigation at the top of the web console.

The Server Events screen appears.

2. Select the server log entries in the list that you want to export information for.

3. Click Export.

4. Save the file.

Maintaining Logs
Purge older logs to reduce the size of the Safe Lock Intelligent Manager database.

Procedure

1. Go to Logs > Log Maintenance in the navigation at the top of the web console.
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The Log Maintenance screen appears.

2. Under Purge agent event log entries older than, specify the maximum age of
agent event log entries to keep.

3. Under keep at most, specify the maximum number of agent event entries to keep.

Note
If the number of entries exceeds the limit set under keep at most, Safe Lock
Intelligent Manager purges agent event logs newer than the age specified in the
Purge agent event log entries older than field.

4. Under Purge server auditing log entries older than, specify the maximum age
of server event log entries that will be preserved.

5. To prohibit automatically purging without a backup, do the following:

a. Select Always back up logs before automatically purging.

b. Click Backup Path.

c. Specify the full path for backups.

d. If you want Safe Lock Intelligent Manager to create folders in the specified
path that do not exist, select Create the folder if not already present.

6. To manually purge log entries based on their age, do the following:

a. In the Manual Purge section, select the minimum age of entries to preserve.

b. Click Purge Now.
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WARNING!
Safe Lock Intelligent Manager does not automatically back up manually purged
log entries.

To back up existing log entries, perform the appropriate steps to export the
entries manually.

See Exporting Agent Events on page 3-11.

See Exporting Server Event Logs on page 3-14.

Forwarding Events to an External Syslog
Server

You can forward server and agent event logs to an external syslog server for additional
managing and monitoring capabilities. The Intelligent Manager forwards logs in the
Common Event Format (CEF). Make sure your syslog server supports the Common
Event Format (CEF).

Procedure

1. Go to Logs > Log Settings > Syslog Server.

2. Select Forward logs to syslog server (CEF only).

3. Specify the protocol, IP address, and port of the syslog server.
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Chapter 4

Configuring Administration Settings
This chapter introduces Trend Micro Safe Lock Intelligent Manager administration
settings.

Topics in this chapter include:

• About the Component Updates Screen on page 4-2

• Configuring Component Download Locations on page 4-5

• Configuring Notification Settings on page 4-5

• About the Account Management Screen on page 4-8

• Configuring Proxy Settings on page 4-11

• About the License Management Screen on page 4-12
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About the Component Updates Screen
To display the Component Updates screen, go to Administration > Components >
Updates in the navigation at the top of the web console.

This screen displays the list of components used by Safe Lock Intelligent Manager.

Perform the following tasks from this screen:

Function Description

Update Manually update the components you select.

Schedule Updates Configure the update schedule.

Enable or disable scheduled updates for each component.

Download Agent Installer
Package

Download an up-to-date agent installer package.

Manually Updating Components

Procedure

1. Go to Administration > Components > Updates in the navigation at the top of
the web console.

The Component Updates screen appears.

2. Click Update.

3. Select the components you want to update.

4. Click Update.

The Update Progress screen appears. Safe Lock Intelligent Manager updates
Current Version and Latest Update information after components update
successfully.
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Scheduling Component Updates

Procedure

1. Go to Administration > Components > Updates in the navigation at the top of
the web console.

The Component Updates screen appears.

2. Click Scheduled Updates.

3. Enable the components you want to update on a schedule.

4. In the Update Schedule section, select the schedule you want to use.

Important

If you select Monthly, on day and select a number higher than the actual number of
days in a given month, Safe Lock Intelligent Manager updates selected components
on the last day of that month instead.

Downloading an Up-to-Date Agent Installer Package

Procedure

1. Go to Administration > Components > Updates in the navigation at the top of
the web console.

The Component Updates screen appears.

2. Click Download Agent Installer Package.

3. Select the language the installation package.

Your browser downloads the most up-to-date agent installer package.
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Note

The agent installer package is considered up-to-date by Safe Lock Intelligent Manager
based on the component versions displayed on the Component Updates screen. If
the cached agent installer package is not up-to-date, Safe Lock Intelligent Manager
prepares and caches an up-to-date package before starting the download.

Preparing an up-to-date agent installer package is system-intensive. Depending on the
hardware running Safe Lock Intelligent Manager, preparing an up-to-date agent
installer package can take a while.

4. To use the downloaded agent installer package for remote installations using the
SLrst program at the command line interface (CLI), copy the downloaded agent
installer package to the path used by SLrst.

For example, if you installed Safe Lock Intelligent Manager to the default path on
the C drive, copy the downloaded agent installer package to the following path: c:
\Program Files\Trend Micro\Safe Lock Intelligent Manager
\CmdTools\RemoteAgentSetupTool\

Important

The package file name must follow the format:
TMSL2.0_<language_abbreviation>.zip

For example:

Valid Not Valid

TMSL2.0_EN.zip TMSL2.0_EN (1).zip

TMSL2.0_JA.zip TMSL2.0_EN_1.zip

About Modifying the Agent Installer Package
Safe Lock Intelligent Manager supports specific modifications to the agent installer
package. If you choose to modify the agent installer package, use caution and observe
the following requirements:

• Modify only the Setup.ini and trend.cer files.
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• Maintain the internal directory structure of the agent installer package.

• Modify the agent installer package at your own risk.

Configuring Component Download Locations

Procedure

1. Go to Administration > Components > Update Source in the navigation at the
top of the web console.

The Server Update Source screen appears.

2. Select the appropriate download location for your environment:

Option Description

Trend Micro ActiveUpdate
server

Use the Trend Micro-managed update server on
the Internet.

Internet or local server Specify an update server that does not require
authentication.

Local server requiring
authentication

Specify a local, private update server that
requires authentication.

Configuring Notification Settings
Safe Lock Intelligent Manager sends the following types of notifications based on
configured settings:



Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

4-6   

• General: Notification of information and warning messages sent to Safe Lock
Intelligent Manager by endpoints after blocking files

• Outbreak: Notification sent when the specified number of open warning messages
in the specified time period has passed the threshold

See Example Notification Messages on page 4-8.

Procedure

1. Go to Administration > Notification Settings in the navigation at the top of the
web console.

The Notification Settings screen appears, open to the General tab.

2. To send general notifications using email:
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a. Select Send notifications using email.

b. Specify the recipient email addresses.

c. Specify your SMTP server settings.

d. If your SMTP server requires authentication, select SMTP authentication
and specify credentials.

e. To send a test message using this configuration, click Send Test.

3. To send general notifications using SNMP:

a. Select Send notifications using SNMP.

b. Specify your SNMP server IPv4 address or Fully Qualified Domain Name
(FQDN).

c. Specify your SNMP Community string.

4. To send general notifications using third party applications:

a. Select Launch a third-party application.

b. Specify the full path to the third-party application.

c. Optionally, specify any run-time parameters for the application.

5. To send outbreak notifications:

a. Go to the Outbreak tab.

b. Select Send outbreak notifications.

c. Specify the threshold number of open warnings in a time period.

d. Specify the threshold time period of those warnings.

e. To display a Windows notification on the screen of the physical Safe Lock
Intelligent Manager server endpoint during outbreaks, select Display pop-up
outbreak notification balloon on the physical Trend Micro Safe Lock
Intelligent Manager server.
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Example Notification Messages

If you configure Safe Lock Intelligent Manager to send SMTP or SNMP notifications,
Safe Lock Intelligent Manager sends the notifications for all types of events.

Table 4-1. Example Notifications

Event Type Cause Example Notification Message

Outbreak Outbreak Safe Lock: Outbreak notification

Action
Required

Blocked file Safe Lock: [Action required] File access blocked on
<computer_name> (<file_name>)

Scan Result Malware
detection

Safe Lock: [Scan Result] Malware detected on
<computer_name> (<file_name>)

Warning Unauthorized
change

Safe Lock: [Warning] Unauthorized change of File/
Folder allowed on <computer_name>

Warning Application
Lockdown
status change

Safe Lock: [Warning] Application Lockdown Turned
Off on <computer_name>

Warning Device access
blocked

Safe Lock: [Warning] Device access blocked on
<computer_name>

About the Account Management Screen
To display the Account Management screen, go to Administration > Account
Management in the navigation at the top of the web console.

Use this screen to manage Safe Lock Intelligent Manager web console accounts.
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Trend Micro Safe Lock Intelligent Manager web console accounts have the following
privileges:

ACCOUNT TYPE PRIVILEGES

Administrator • Add, edit, enable, disable, or delete Safe Lock
Intelligent Manager web console accounts from the
Account Management screen.

• Modify their own account description, email address,
and password

• Specify actions to take on files blocked by agents

• View the Safe Lock Intelligent Manager web console
Logs > Server Events screen

• Allow or block storage device access on managed
endpoints.

Full Control • Modify their own account description, email address,
and password

• Specify actions to take on files blocked by agents

• View the Safe Lock Intelligent Manager web console
Logs > Server Events screen

• Allow or block storage device access on managed
endpoints.

Storage Device Control • Modify their own account description, email address,
and password

• Allow or block storage device access on managed
endpoints.

Read Only • Modify their own account description, email address,
and password

Note
The default account created during installation is named “admin” and is the only account
that has Administrator privileges.
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Adding Accounts

Procedure

1. Log on the web console using the “admin” account.

2. Go to Administration > Account Management in the navigation at the top of
the web console.

The Account Management screen appears.

3. Click Add.

The Add User screen appears.

4. Specify the privileges for the account.

See About the Account Management Screen on page 4-8.

5. Specify the account name.

Note

Only lowercase a to z, 0 to 9, - and _ are supported.

6. Specify whether the account should be Enabled or Disabled upon creation.

7. Optionally, type an account description.

Note

The following characters are not supported:

> < & " '

8. Optionally, specify an email address for this account.

9. Specify the password.
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Note

The password must be 8 to 64 alphanumeric characters. The following characters are
not supported:

| > " : < \ spaces

Editing Accounts
Only an account with Administrator privileges is able to add, enable or disable, or delete
accounts. All other accounts are only able to edit their own account description, email
address, and password.

Procedure

1. Go to Administration > Account Management in the navigation at the top of
the web console.

The Account Management screen appears.

2. Click the user name of the account.

The Edit User screen appears.

3. Modify settings.

Configuring Proxy Settings

Procedure

1. Go to Administration > Proxy Settings in the navigation at the top of the web
console.

The Proxy Settings screen appears.

2. To configure proxy settings for updates:
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a. Select Use a proxy server for pattern and engine updates.

b. Specify the IPv4 address or FQDN of the proxy server.

c. Specify the port.

d. If your proxy server requires authentication, select Proxy server
authentication and specify credentials.

3. To configure proxy settings used by Safe Lock Intelligent Manager when sending
messages to Safe Lock agents:

a. Select Use a proxy server when Safe Lock Intelligent Manager
communicates to Safe Lock agents.

b. Specify the IPv4 address or FQDN of the proxy server.

c. Specify the port.

d. If your proxy server requires authentication, select Proxy server
authentication and specify credentials.

Tip

To configure proxy settings used by Safe Lock agents when sending messages to Safe
Lock Intelligent Manager:

• Before remote installation: Add the proxy information to the configuration file
used by the agent installer package.

• After remote installation: Use the SLCmd.exe Command Line Interface tool on
the local Safe Lock agent.

About the License Management Screen
To display the License Management screen, go to Administration > License
Management in the navigation at the top of the web console.

The following details appear on this screen:
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Item Description

Activation Code Displays the Activation Code

License Displays “Full” or “Trial”

Status Displays “Activated”, “Not Activated” or
“Expired”

Expiration date Displays the date when features and
support end

Changing Activation Codes

Procedure

1. Go to Administration > License Management in the navigation at the top of
the web console.

The License Management screen appears.

2. Click Change Activation Code.

3. Type your new Trend Micro Safe Lock Intelligent Manager Activation Code.

To remotely renew agent licenses, see Renewing Agent Licenses on page 7-26.
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Chapter 5

Using the Agent Console
This chapter describes how to configure Trend Micro Safe Lock using the agent console
on the endpoint.

Topics in this chapter include:

• Setting Up the Approved List on page 5-2

• About the Agent Console on page 5-6

• About the Approved List on page 5-10

• Account Types on page 5-17

• About Feature Settings on page 5-19
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Setting Up the Approved List
Before Trend Micro Safe Lock can protect the endpoint, it must check the endpoint for
existing applications and installers necessary for the system to run correctly.

Procedure

1. Open the Safe Lock console.

The Safe Lock log on screen appears.

2. Provide the password and click Login.

Safe Lock asks if you want to set up the Approved List now.
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3. At the notification window, select Yes. Set up the Approved List now and click
OK.

Safe Lock scans the endpoint and adds all applications to the Approved List.
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Safe Lock displays the Approved List Configuration Results.

Note
When Trend Micro Safe Lock Application Lockdown is on, only applications that are
in the Approved List will be able to run.

4. Click Close.
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Configuring Pop-up Notifications for Blocked
Files

The administrator can set up a notification that displays on managed endpoints when
Safe Lock blocks and prevents unapproved files from running or making changes to
managed endpoints. This notification alerts the administrator of any blocking event and
provides details about the blocked file.

Note

• This feature is disabled by default.

• Safe Lock only supports feature customization using the agent Setup.ini file and
requires re-deployment to apply the customization.
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Table 5-1. Configuring Pop-up Notifications for Blocked Files

Setting Default
Where to Access the Setting

Before Agent
Deployment

After Agent
Deployment

Enable the
notification

Disabled Customize the
BlockNotificatio
n section of the
agent Setup.ini file.

Use agent Command
Line Interface to
issue a
blockedfilenotifi
cation command.

Request for
administrator
password when
closing the
notification

Enabled (if the
notification feature is
enabled)

Not supported

Display event
details (file
name, file path,
and event time)

Not supported

Customize the
notification title
and message

• Title: Application
Blocked

• Message: A
program has been
blocked by Trend
Micro Safe Lock.
Please contact your
help desk or
administrator.

Not supported

About the Agent Console
The agent console provides easy access to commonly used features in Trend Micro Safe
Lock.
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Figure 5-1. The Safe Lock console

The following table describes the features available on the console:

Table 5-2. Console Feature Descriptions

# Item Description

1 Overview Display the software status

Approved List Display applications allowed to run and let users
manage the list

Password Change the Safe Lock administrator or Restricted
User passwords (only available to administrators)

Settings Enable or disable vulnerability protection settings
and export or import the system configuration

About Display the product and component version
numbers
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# Item Description

2 Status information The current status of the software

3 Turn Application
Lockdown On

Lock down the system, blocking applications not on
the Approved List from running

Turn Application
Lockdown Off

Release the system from lock down, allowing
applications not on the Approved List to run

Note
After disabling Lockdown mode, Safe Lock
Intelligent Manager switches to a “monitor”
mode. Safe Lock Intelligent Manager does not
block any applications from running, but logs
when applications that are not in the
Approved List run. You can use these logs to
assess if the Approved List contains all the
applications required on the endpoint.

4 Application Lockdown
on since

The date and time that Application Lockdown was
last turned on

Application Lockdown
off since

The date and time that Application Lockdown was
last turned off

5 Exploit Prevention Enabled: All Exploit Prevention features are
enabled

Click the status to open the settings screen.

Enabled (Partly): Some Exploit Prevention features
are enabled

Click the status to open the settings screen.

Disabled: No Exploit Prevention features are
enabled

Click the status to open the settings screen.
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# Item Description

6 Approved List status Click the number of Approved List items or last
updated date to open the Approved List.

Click the last application blocked date to open the
Blocked Application Event Log.

7 License expires on The time and date that the software expires

Click the date to provide a new Activation Code.

Viewing Safe Lock Statuses
You can view your Safe Lock statuses as indicated by the system tray icons.

Note

System Tray icons display if they were enabled during installation. To enable this feature
after agent installation, use the SLCmd.exe program from the Intelligent Manager to
remotely enable the feature.

Table 5-3. Status Icon Descriptions

Console
Icon

System Tray
Icon Status Description

Locked The Approved List is being
enforced. Unauthorized
applications cannot be run.

Unlocked The Approved List is not being
enforced. Unauthorized
applications can be run.
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Console
Icon

System Tray
Icon Status Description

N/A Expired The Safe Lock license has
expired, and the system cannot
be locked. Update the Activation
Code by clicking on the expiration
date.

N/A Blocked The Safe Lock has blocked and
prevented an unapproved
application not from running or
making changes to the managed
endpoint.

About the Approved List
Use the Approved List to display the files that Safe Lock allows to run or make changes
to the endpoint.
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Figure 5-2. The Safe Lock Approved List

The following table describes the features available on the Approved List.

Table 5-4. Approved List Item Descriptions

# Item Description

1 Add Item/Delete Item Adds or removes selected items to or from the
Approved List.

2 Search bar Searches the Application and File Path columns.

3 Check Hash/Update
Hash

Checks or updates the hash values for applications in
the Approved List.

4 Export/Import Exports or imports the Approved List using a SQL
database (.db) file.

5 Copy to Clipboard Copies the Approved List to the clipboard in the comma
separated values (CSV) format for easy review or
reporting.
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About Hashes
Safe Lock calculates a unique hash value for each file in the Approved List. This value
can be used to detect any changes made to a file, since any change results in a different
hash value. Comparing current hash values to previous values can help detect file
changes.

The following table describes the hash check status icons.

Table 5-5. Hash Check Status Icons

Icon Description

The calculated hash value matches the stored value.

The calculated hash value does not match the stored value.

There was an error calculating the hash value.

Moving or overwriting files manually (without using the Trusted Updater) can result in
the hash values not matching, but the mismatch could result from other applications
(including malware) altering or overwriting existing files. If unsure why a hash value
mismatch has occurred, scan the endpoint for threats with Trend Micro Portable
Security.

Checking or Updating Hashes

Checking the hash value of files in the Approved List can help verify the integrity of files
currently permitted to run.

Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the password and click Login.

3. Click the Approved List menu item to open the list.
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To check the file hash values:

a. Select the files to check. To check all files, select the check box at the top of
the Approved List.

b. Click Check Hash.

To update the file hash values:

a. Select the files to update.

b. Click Update Hash.

Important
If unsure why a hash value mismatch has occurred, scan the endpoint for threats.

Configuring the Approved List
After setting up the Approved List, users can add new programs by clicking Add Item,
which displays the options in the following table.

Table 5-6. Methods for Adding Applications to the Approved List

Option When to Use

Manually browse and
select files

Choose this option when the software already exists on the
endpoint and is up-to-date. Adding a file grants permission to
run the file, but does not alter the file or the system.

For example, if Windows Media Player (wmplayer.exe) is not
in the Approved List after initial setup, users can add it to the
list using the console.
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Option When to Use

Automatically add files
created or modified by
the selected
application installer
(Trusted Updater)

Choose this option when you need to update or install new
applications to your managed endpoint without having to
unlock Trend Micro Safe Lock. Trend Micro Safe Lock will
add any new or modified files to the Approved List.

For example, if Mozilla Firefox needs to be installed or
updated, select this option to allow the installation or update,
and also add any files created or modified in the process to
the Approved List.

Adding or Removing Files

Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the password and click Login.

3. Click the Approved List menu item to open the list.

To add an item:

a. Click Add Item, select Manually browse and select files, and click Next.

b. In the window that opens, choose Specific applications, All applications in
selected folders, or All applications in a specified path from the drop-
down list.

A selection window appears.

c. Select the desired application or folder to add, and click Open or OK.

d. Click OK. Confirm the items to be added, and click Approve.

e. After adding the desired items to the Approved List, click Close.

To remove an item:

a. Search the Approved List for the application to remove.
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b. Select the check box next to the file name to be removed, and click Delete
Item.

c. When asked to remove the item, click OK.

d. Click OK again to close the confirmation window.

Updating or Installing Using the Trusted Updater
Trend Micro Safe Lock automatically adds applications to the Approved List after the
Trusted Updater adds or modifies the program files.

Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the password and click Login.

3. Click the Approved List menu item to open the list.

4. To install or update an application, select the installer that the Trusted Updater
should temporarily allow to run:

a. Click Add Item, select Automatically add files created or modified by the
selected application installer, and click Next.

b. In the window that opens, choose Specific installers, All installers in
folders and subfolders, or All installers in a folder from the drop-down
list.

c. Select the desired installation package or folder to add, and click Open.

Note
Only existing EXE, MSI, BAT, and CMD files can be added to the Trusted
Updater.

d. Check that the correct items appear on the list, and click Start.

The Safe Lock Trusted Updater window displays.
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Figure 5-3. The Safe Lock Trusted Updater

5. Install or update the program as usual. When finished, click Stop on the Trusted
Updater.

6. Check that the correct items appear on the Approved List, and click Approve, and
then click Close.

Exporting or Importing the Approved List

Users can export or import the as a database (.db) file for reuse in mass deployment
situations. Copy to Clipboard creates a CSV version of the list on the Windows
clipboard.

WARNING!

The operating system files used by the exporting and importing endpoints must match
exactly. Any difference between the operating system files on the endpoints can lead to
operating system malfunctions or system lock-out after importing.
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Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the password and click Login.

3. Click the Approved List menu item to open the list.

To export the Approved List:

a. Click Export, and choose where to save the file.

b. Provide a filename, and click Save.

To import an Approved List:

a. Click Import, and locate the database file.

b. Select the file, and click Open.

Account Types
Trend Micro Safe Lock Intelligent Manager provides role-based administration, allowing
administrators to grant users access to certain features on the main console. Through
the configuration file, Safe Lock administrators can specify the features available to the
Restricted Users account.

Table 5-7. Safe Lock Accounts

Account Details

Administrator • Default account

• Full access to Safe Lock functions

• Can use both the console and command line interface
(CLI)



Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

5-18   

Account Details

Restricted User • Secondary maintenance account

• Limited access to Safe Lock functions

• Can only use the console

To enable the Restricted User account, see Configuring Passwords on page 5-18. To sign in
with a specific account, specify the password for that account.

Configuring Passwords
While the Safe Lock administrator and Restricted User passwords can be changed from
the console, only the administrator can change passwords. To log on the console as the
administrator account, provide the administrator password when launching the console.

Important

The Safe Lock administrator and Restricted User passwords cannot be the same.

Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the Safe Lock administrator password and click Login.

3. Click the Password menu item to display the administrator password page.

To change the Safe Lock administrator password:

a. Provide the current password, specify and confirm the new password, and
click Save.

WARNING!

The only way to recover after losing the Safe Lock administrator password is by
reinstalling the operating system.
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To create a Restricted User password:

a. Click Restricted User at the top of the console.

b. Select the Use Restricted User check box.

c. Specify and confirm the password, and click Save.

To change an existing Restricted User password:

a. Specify and confirm the new password, and click Save.

About Feature Settings
Safe Lock offers the following protection features.

Figure 5-4. Safe Lock settings screen
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Table 5-8. Intrusion Prevention

Setting Description

USB Malware Protection USB Malware Protection prevents automated threats on USB
or remote drives from infecting the endpoint. Just viewing the
contents of the drive may be enough to pass along an
infection.

Enable this feature to prevent files on USB devices from
automatically infecting the endpoint.

Network Virus Protection Network Virus Protection scans incoming and outgoing
network traffic, blocking threats from infected computers or
other devices on the network.

Enable this feature to prevent threats on the network from
infecting the endpoint.

Table 5-9. Execution Prevention

Setting Description

Memory Randomization Address Space Layout Randomization helps prevent
shellcode injection by randomly assigning memory locations
for important functions, forcing an attacker to guess the
memory location of specific processes.

Enable this feature on older operating systems such as
Windows XP or Windows Server 2003, which may lack or
offer limited Address Space Layout Randomization (ASLR)
support.

Note
The endpoint must be restarted to enable or disable
Memory Randomization.

DLL Injection Prevention DLL Injection Prevention detects and blocks API call
behaviors used by malicious software. Blocking these threats
helps prevent malicious processes from running.

Never disable this feature except in troubleshooting situations
since it protects the system from a wide variety of serious
threats.
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Setting Description

API Hooking Prevention API Hooking Prevention detects and blocks malicious
software that tries to intercept and alter messages used in
critical processes within the operating system.

Never disable this feature except in troubleshooting situations
since it protects the system from a wide variety of serious
threats.

Table 5-10. Application Lockdown

Setting Description  

DLL/Driver Lockdown DLL/Driver Lockdown prevents
unapproved DLLs or drivers
from being loaded into the
memory of protected endpoints.

Important
To enable DLL/Driver
Lockdown, Script
Lockdown, or Write
Protection, make sure
that Application
Lockdown is also
enabled on the
managed endpoint.

Script Lockdown Script Lockdown prevents
unapproved script files from
being run on protected
endpoints.

Write Protection Write Protection prevents write
access to objects (files, folders,
and registry entries) in the Write
Protection List and optionally
prevents write access to files in
the Approved List.

Table 5-11. Device Control

Setting Description

Storage Device Blocking Blocks storage devices, including USB drives, CD/DVD
drives, floppy disks, and network drives from accessing the
managed endpoint.
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Table 5-12. Other

Setting Description

Integrity Monitoring Integrity Monitoring logs events related to changes for files,
folders, and the registry on the managed endpoint.

Note
To view Integrity Monitoring logs on the managed
endpoint, go to Start > Control Panel >
Administrative Tools and access Event Viewer.

Enabling or Disabling Feature Settings

Note
By default, Trend Micro Safe Lock enables the DLL/Driver Lockdown and Script
Lockdown features of the Exploit Prevention settings. If Network Virus Protection was
not included in the initial installation, it cannot be selected. Reinstall Trend Micro Safe
Lock if Network Virus Protection is not available.Trend Micro

Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the password and click Login.

3. Click the Settings menu item to configure Exploit Prevention settings.

4. Enable or disable the desired features.

5. Click Save.
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Chapter 6

Using the Agent Command Line
Interface (CLI)

This chapter describes how to configure and use Trend Micro Safe Lock using the
command line interface (CLI).

Topics in this chapter include:

• Using SLCmd at the Command Line Interface (CLI) on page 6-2
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Using SLCmd at the Command Line Interface
(CLI)

Administrators can work with Trend Micro Safe Lock directly from the command line
interface (CLI) using the SLCmd.exe program.

Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock installation folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Trend Micro Safe Lock\"

3. Type SLCmd.exe.

SLCmd Program and Console Function Comparison
The following table lists the Trend Micro Safe Lock features available in SLCmd
program and the Safe Lock console program..

Table 6-1. SLCmd Program at the Command Line Interface (CLI) and Console
Function Comparison

Function
SLCmd Program at the

Command Line
Interface (CLI)

Console

Account Management Yes Yes

Approved List Management Yes Yes

Decrypt/Encrypt configuration file Yes No

Display the blocked log Yes Yes

Export/Import Approved List Yes Yes
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Function
SLCmd Program at the

Command Line
Interface (CLI)

Console

Export/Import configuration Yes Yes

Install Yes Yes

Windows Update Support Yes No

Application Lockdown Yes Yes

Write Protection Yes Yes

Write Protection Exceptions Yes No

Integrity Monitoring Yes Yes

Exception Paths Yes No

License Management Yes Yes

Administrator password Yes Yes

Turn on/off Application Lockdown Yes Yes

Enable/disable pop-up notifications for
blocked files

Yes No

Start/Stop Trusted Updater Yes Yes

Trusted Hash List Yes No

Start/Stop the service Yes No

Uninstall No No

Not all settings are available through the command line interface (CLI) or console. See
Working with the Agent Configuration File on page 9-2 for information about modifying the
system configuration.
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SLCmd Program Commands

The following tables list a summary commands available using the SLCmd program at
the command line interface (CLI). To use the program, type SLCmd and the desired
command. Type SLCmd and press ENTER to display the list of available commands.

Note

Only a Safe Lock administrator with Windows administrator privileges can use SLCmd at
the command line interface (CLI). SLCmd will prompt for the administrator password
before running certain commands.

The following is a full list of commands available using the SLCmd program.

General Commands

Perform general actions using the Command Line Interface.

The following table lists the available abbreviated forms of parameters.

Table 6-2. Abbreviations and Uses

Parameter Abbreviation Use

adminpassword ap Manage the Safe Lock admistrator
password

lock lo Manage Application Lockdown status

blockedlog bl Manage the applications blocked by
Safe Lock

license lc Manage the Safe Lock license

settings set Manage the Safe Lock settings

service srv Manage the Safe Lock service

The following table lists the commands, parameters, and values available.
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Table 6-3. General Commands

Command Parameter Value Description

help   Display a list of Safe Lock
commands

For example, type:

SLCmd.exe help

activate  <activation
_code>

Activate the Safe Lock program
using the specified Activation
Code

For example, type:

SLCmd.exe activate XX-XXXX-
XXXXX-XXXXX-XXXXX-XXXXX-
XXXXX

set adminpassword <new_pass
word>

Change the currently logged on
administrator password to the
newly specified password

For example, type:

SLCmd.exe -p
<admin_password> set
adminpassword P@ssW0Rd

 Prompt the currently logged on
administrator to specify a new
password

For example, type:

SLCmd.exe -p
<admin_password> set
adminpassword

set lock enable Turn on Application Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set lock
enable



Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

6-6   

Command Parameter Value Description

disable Turn off Application Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set lock
disable

 Display the current Safe Lock
Application Lockdown status

For example, type:

SLCmd.exe -p
<admin_password> set lock

set blockedfilenotifi
cation

enable Display a notification on the
managed endpoint when Safe
Lock blocks a file.

For example, type:

SLCmd.exe -p
<admin_password> set
blockedfilenotification
enable

Disable Do not display any notification
when Safe Lock blocks a file.

For example, type:

SLCmd.exe -p
<admin_password> set
blockedfilenotification
disable

 Display the current notification
setting

For example, type:

SLCmd.exe -p
<admin_password> set
blockedfilenotification
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Command Parameter Value Description

show blockedlog  Display a list of applications
blocked by Safe Lock

For example, type:

SLCmd.exe -p
<admin_password> show
blockedlog

show license  Display the current Safe Lock
license information

For example, type:

SLCmd.exe show license

show settings  Display the current status of the
vulnerability attack prevention
features

For example, type:

SLCmd.exe -p
<admin_password> show
settings

start service  Start the Safe Lock service

For example, type:

SLCmd.exe start service

status   Display the current status of
Application Lockdown and the
auto update function of the
Approved List

For example, type:

SLCmd.exe -p
<admin_password> status

stop service  Stop the Safe Lock service

For example, type:
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Command Parameter Value Description
SLCmd.exe -p
<admin_password> stop
service

version   Display the current versions of
Safe Lock components

For example, type:

SLCmd.exe -p
<admin_password> version

Central Management Commands
Configure central management features using the Command Line Interface by typing
your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-4. Abbreviations and Uses

Parameter Abbreviation Use

managedmodeconfiguration mmc Manage the configuration file

servercertification sc Manage server certificate files

managedmode mm Manage agent “Managed
Mode”

The following table lists the commands, parameters, and values available.

Table 6-5. Central Management Commands

Command Parameter Value Description

decrypt managedmodeconfigu
ration

<path_of_encrypted_fil
e>
<path_of_decrypted_o
utput_file>

Decrypt the
configuration file used
by Managed Mode
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Command Parameter Value Description

encrypt managedmodeconfigu
ration

<path_of_file>
<path_of_encrypted_o
utput_file>

Encrypt the
configuration file used
by Managed Mode

export managedmodeconfigu
ration

<path_of_encrypted_o
utput>

Export the encrypted
configuration file used
by Managed Mode

servercertificatio
n

<path_of_certification_f
ile>

Export the encrypted
Safe Lock Intelligent
Manager SSL
communication
certificate file

import managedmodeconfigu
ration

<path_of_encrypted_in
put>

Import the encrypted
configuration file used
by Managed Mode

servercertificatio
n

<path_of_certification_f
ile>

Import the encrypted
Safe Lock Intelligent
Manager SSL
communication
certificate file

set managedmode enable [-cfg
<path_of_encrypted_fil
e>] [-sc
<path_of_certification_f
ile>]

Enable Managed Mode

Note
Using the
optional -cfg
value specifies
the path of the
configuration file.

Using the
optional -sc
value specifies
the path of the
certificate file.

set managedmode  Display the current
Managed Mode status
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Command Parameter Value Description

show managedmodeconfigu
ration

 Display the
configuration used by
Managed Mode

test managedmode  Connect a test
Managed Mode session
with Safe Lock
Intelligent Manager

Optional Feature Commands

Configure optional security features using the Command Line Interface by typing your
command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-6. Abbreviations and Uses

Parameter Abbreviation Use

apihookingprevention api Manage API Hooking
Prevention

customaction ca Manage actions taken when
Safe Lock blocks specific types
of events

dlldriverlockdown dd Manage DLL/Driver Lockdown

dllinjectionprevention dll Manage DLL Injection
Prevention

exceptionpath ep Manage exceptions to
Application Lockdown

integritymonitoring in Manage Integrity Monitoring

memoryrandomization mr Manage Memory
Randomization
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Parameter Abbreviation Use

networkvirusprotection net Manage Network Virus
Protection

script scr Manage Script Lockdown

storagedeviceblocking sto Allows or blocks storage
devices (CD/DVD drives, floppy
disks, and network drives) from
accessing the managed
endpoint.

usbmalwareprotection usb Manage USB Malware
Protection

writeprotection wp Manage Write Protection

writeprotection-
includes-approvedlist

wpal Manage Write Protection
includes Approved List

The following table lists the commands, parameters, and values available.

Table 6-7. Optional Feature Commands

Command Parameter Value Description

set usbmalwareprote
ction

enable Enable USB Malware
Protection

For example, type:

SLCmd.exe -p
<admin_password> set
usbmalwareprotection
enable

disable Disable USB Malware
Protection

For example, type:

SLCmd.exe -p
<admin_password> set
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Command Parameter Value Description
usbmalwareprotection
disable

 Display the current status of
USB Malware Protection

For example, type:

SLCmd.exe -p
<admin_password> set
usbmalwareprotection

set networkviruspro
tection

enable Enable Network Virus
Protection

For example, type:

SLCmd.exe -p
<admin_password> set
networkvirusprotection
enable

disable Disable Network Virus
Protection

For example, type:

SLCmd.exe -p
<admin_password> set
networkvirusprotection
disable

 Display the current status of
Network Virus Protection

For example, type:

SLCmd.exe -p
<admin_password> set
networkvirusprotection

set memoryrandomiza
tion

enable Enable Memory
Randomization

For example, type:
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Command Parameter Value Description
SLCmd.exe -p
<admin_password> set
memoryrandomization
enable

disable Disable Memory
Randomization

For example, type:

SLCmd.exe -p
<admin_password> set
memoryrandomization
disable

 Display the current status of
Memory Randomization

For example, type:

SLCmd.exe -p
<admin_password> set
memoryrandomization

set dllinjectionpre
vention

enable Enable DLL Injection
Prevention

For example, type:

SLCmd.exe -p
<admin_password> set
dllinjectionprevention
enable

disable Disable DLL Injection
Prevention

For example, type:

SLCmd.exe -p
<admin_password> set
dllinjectionprevention
disable
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Command Parameter Value Description

 Display the current status of
DLL Injection Prevention

For example, type:

SLCmd.exe -p
<admin_password> set
dllinjectionprevention

set apihookingpreve
ntion

enable Enable API Hooking
Prevention

For example, type:

SLCmd.exe -p
<admin_password> set
apihookingprevention
enable

disable Disable API Hooking
Prevention

For example, type:

SLCmd.exe -p
<admin_password> set
apihookingprevention
disable

 Display the current status of
API Hooking Prevention

For example, type:

SLCmd.exe -p
<admin_password> set
apihookingprevention

set dlldriverlockdo
wn

enable Enable DLL/Driver
Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
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Command Parameter Value Description
dlldriverlockdown
enable

disable Disable DLL/Driver
Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
dlldriverlockdown
disable

 Display the current status of
DLL/Driver Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
dlldriverlockdown

set script enable Enable Script Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
script enable

disable Disable Script Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
script disable

 Display the current status of
Script Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
script
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Command Parameter Value Description

set writeprotection enable Enable Write Protection

For example, type:

SLCmd.exe -p
<admin_password> set
writeprotection enable

disable Disable Write Protection

For example, type:

SLCmd.exe -p
<admin_password> set
writeprotection
disable

 Display the current status of
Write Protection

For example, type:

SLCmd.exe -p
<admin_password> set
writeprotection

set writeprotection
-includes-
approvedlist

enable Enable protection of the
Approved List (in addition to
the Write Protection List)
when Write Protection is
enabled

For example, type:

SLCmd.exe -p
<admin_password> set
writeprotection-
includes-approvedlist
enable

disable Disable protection of the
Approved List (in addition to
the Write Protection List)
when Write Protection is
enabled
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Command Parameter Value Description
For example, type:

SLCmd.exe -p
<admin_password> set
writeprotection-
includes-approvedlist
disable

 Display the current status of
Write Protection includes
Approved List

For example, type:

SLCmd.exe -p
<admin_password> set
writeprotection-
includes-approvedlist

set integritymonito
ring

enable Enable Integrity Monitoring

For example, type:

SLCmd.exe -p
<admin_password> set
integritymonitoring
enable

disable Disable Integrity Monitoring

For example, type:

SLCmd.exe -p
<admin_password> set
integritymonitoring
disable

 Display the current status of
Integrity Monitoring

For example, type:

SLCmd.exe -p
<admin_password> set
integritymonitoring
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Command Parameter Value Description

set customaction ignore Ignore blocked files or
processes when Application
Lockdown blocks any of the
following events:

• Process launch

• DLL loading

• Script file access

For example, type:

SLCmd.exe -p
<admin_password> set
customaction ignore

quarantine Quarantine blocked files or
processes when Application
Lockdown blocks any of the
following events:

• Process launch

• DLL loading

• Script file access

For example, type:

SLCmd.exe -p
<admin_password> set
customaction qurantine

Note
Safe Lock does not
support a custom
action of “quarantine”
on Windows XP or
Windows 2003.

ask Ask what to do for blocked
files or processes when
Application Lockdown
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Command Parameter Value Description
blocks any of the following
events:

• Process launch

• DLL loading

• Script file access

For example, type:

SLCmd.exe -p
<admin_password> set
customaction ask

 Display the current setting
for actions taken when Safe
Lock blocks specific types
of events

set exceptionpath enable Enable exceptions to
Application Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
customaction enable

disable Disable exceptions to
Application Lockdown

For example, type:

SLCmd.exe -p
<admin_password> set
customaction disable

 Display current setting for
using exceptions to
Application Lockdown

For example, type:
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Command Parameter Value Description
SLCmd.exe -p
<admin_password> set
customaction

Restricted User Account Commands

Configure the Restricted User Account using the Command Line Interface by typing
your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-8. Abbreviations and Uses

Parameter Abbreviation Use

user us Manage the Restricted User account

userpassword up Manage the Restricted User
password

The following table lists the commands, parameters, and values available.

Table 6-9. Restricted User Account Commands

Command Parameter Value Description

set user enable Enable the Restricted User
account

For example, type:

SLCmd.exe -p
<admin_password> set user
enable

disable Disable the Restricted User
account

For example, type:
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Command Parameter Value Description
SLCmd.exe -p
<admin_password> set user
disable

 Display the the Restricted User
account status

For example, type:

SLCmd.exe -p
<admin_password> set user

set userpassword <new_passwor
d>

Change the Restricted User
account password to the newly
specified password

For example, type:

SLCmd.exe -p
<admin_password> set
userpassword P@ssW0Rd

 Prompt the currently logged on
administrator to specify a new
Restricted User account
password

For example, type:

SLCmd.exe -p
<admin_password> set
userpassword

Script Commands
Deploy scripts using the Command Line Interface by typing your command in the
following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.
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Table 6-10. Abbreviations and Uses

Parameter Abbreviation Use

script scr Manage script commands

The following table lists the commands, parameters, and values available.

Table 6-11. Script Commands

Command Parameter Value Description

add script <extension>
<interpreter1
>
[interpreter2]
...

Add the specified script
extension and the interpreter(s)
required to execute the script

For example, to add the script
extension JSP with the interpreter
file jscript.js, type:

SLCmd.exe -p
<admin_password> add script
jsp C:\Scripts\jscript.js

remove script <extension>
[interpreter1]
[interpreter2]
...

Remove the specified script
extension and the interpreter(s)
required to execute the script

For example, to remove the
script extension JSP with the
interpreter file jscript.js, type:

SLCmd.exe -p
<admin_password> remove
script jsp C:\Scripts
\jscript.js
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Command Parameter Value Description

Note
If you do not specify any
interpreter, the command
removes all interpreters
related to the script
extension. If you specify
interpreters, the command
only removes the
interpreters specified from
the script extension rule.

show script  Display all script rules

For example, type:

SLCmd.exe -p
<admin_password> show
script

Approved List Commands
Configure the Approved List using the Command Line Interface by typing your
command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-12. Abbreviations and Uses

Parameter Abbreviation Use

approvedlist al Manage files in the Approved List

list li Manage the Approved List import
and export functions

The following table lists the commands, parameters, and values available.
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Table 6-13. Approved List Commands

Command Parameter Value Description

add approvedlist [-r]
<file_or_folde
r_path>

Add the specified file to the
Approved List

For example, to add all Microsoft
Office files to the Approved List,
type:

SLCmd.exe -p
<admin_password> add
approvedlist -r "C:\Program
Files\Microsoft Office"

Note
Using the optional -r value
includes the specified folder
and related subfolders.

remove approvedlist <file_path> Remove the specified file from the
Approved List

For example, to remove
notepad.exe from the Approved
List, type:

SLCmd.exe -p
<admin_password> remove
approvedlist C:\Windows
\notepad.exe

show approvedlist  Display the files in the Approved
List

For example, type:

SLCmd.exe -p
<admin_password> show
approvedlist

check approvedlist -f Update the hash values in the
Approved List and displays
detailed results
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Command Parameter Value Description
For example, type:

SLCmd.exe -p
<admin_password> check
approvedlist -f

-q Update the hash values in the
Approved List and displays
summarized results

For example, type:

SLCmd.exe -p
<admin_password> check
approvedlist -q

-v Compare the hash values in the
Approved List with the hash values
calculated from the actual files and
prompts the user after detecting
mismatched values

For example, type:

SLCmd.exe -p
<admin_password> check
approvedlist -v

export list <output_file> Export the Approved List to the file
path and file name specified

For example, type:

SLCmd.exe -p
<admin_password> export list
c:\approvedlist\ap.db

Note
The output file type must be
DB format.

import list [-o]
<input_file>

Import an Approved List from the
file path and file name specified
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Command Parameter Value Description
For example, type:

SLCmd.exe -p
<admin_password> import list
c:\approvedlist\ap.db

Note
The input file type must be
DB format.

Using the optional -o value
overwrites the existing list.

Application Lockdown Commands

Perform actions related to Application Lockdown using the Command Line Interface by
typing your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-14. Abbreviations and Uses

Parameter Abbreviation Use

quarantinedfile qf Manage quarantined files

exceptionpath ep Manage exceptions to Application
Lockdown

The following table lists the commands, parameters, and values available.

Table 6-15. Application Lockdown Commands

Command Parameter Value Description

show quarantinedfile  Display a list of quarantined
files
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Command Parameter Value Description

restore quarantinedfile <id> [-al] [-f] Restore the specified file from
quarantine

Using the optional -al value
also adds the restored file to
Approved List.

Using the optional -f value
forces the restore.

remove quarantinedfile <id> Delete the specified file

show exceptionpath  Display current exceptions to
Application Lockdown

add exceptionpath -e
<file_path>-t
file

Add an exception for the
specified file

-e
<folder_path>-
t folder

Add an exception for the
specified folder

-e
<folder_path>-
t
folderandsub

Add an exception for the
specified folder and related
subfolders

remove exceptionpath -e
<file_path>-t
file

Remove an exception for the
specified file

Note
Specify the exact
<file_path> originally
specified in the
corresponding add
command.

-e
<folder_path>-
t folder

Remove an exception for the
specified folder
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Command Parameter Value Description

Note
Specify the exact
<folder_path> originally
specified in the
corresponding add
command.

-e
<folder_path>-
t
folderandsub

Remove an exception for the
specified folder and related
subfolders

Note
Specify the exact
<folder_path> originally
specified in the
corresponding add
command.

Write Protection Commands
Configure Write Protection List and Write Protection Exception List using the
Command Line Interface by typing your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-16. Abbreviations and Uses

Parameter Abbreviation Use

writeprotection wp Manage the Write Protection
feature

writeprotection-
file

wpfi Manage files in the Write
Protection List
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Parameter Abbreviation Use

writeprotection-
folder

wpfo Manage folders in the Write
Protection List

writeprotection-
regvalue

wprv Manage registry values and
associated registry keys in the
Write Protection List

writeprotection-
regkey

wprk Manage registry keys in the Write
Protection List

writeprotection-
file-exception

wpfie Manage files in the Write
Protection Exception List

writeprotection-
folder-exception

wpfoe Manage folders in the Write
Protection Exception List

writeprotection-
regvalue-exception

wprve Manage registry values and
associated registry keys in the
Write Protection Exception List

writeprotection-
regkey-exception

wprke Manage registry keys in the Write
Protection Exception List

The following tables list the commands, parameters, and values available.

Table 6-17. Write Protection List “File” Commands

Command Parameter Value Description

show writeprotection  Display the entire Write
Protection List

writeprotection-
file

 Display the files in the
Write Protection List

For example, type:

SLCmd.exe -p
<admin_password> show
writeprotection-file
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Command Parameter Value Description

writeprotection-
file-exception

 Display the files in the
Write Protection Exception
List

For example, type:

SLCmd.exe -p
<admin_password> show
writeprotection-file-
exception

writeprotection-
folder

 Display the folders in the
Write Protection List

For example, type:

SLCmd.exe -p
<admin_password> show
writeprotection-folder

writeprotection-
folder-exception

 Display the folders in the
Write Protection Exception
List

For example, type:

SLCmd.exe -p
<admin_password> show
writeprotection-
folder-exception

add writeprotection-
file

<file_path> Add the specified file to the
Write Protection List

For example, type:

SLCmd.exe -p
<admin_password> add
writeprotection-file
archive.txt



  Using the Agent Command Line Interface (CLI)

  6-31

Command Parameter Value Description

Note
The <file_path>
value pattern
matches from the
end of the path
toward the beginning
of the path. For
example, specifying
userfile.txt
matches c:\Windows
\userfile.txt and
c:\Temp
\userfile.txt.

writeprotection-
file-exception

-t <file_path>
-p
<process_path
>

Add the specified file and a
specific process path for
that file to the Write
Protection Exception List

For example, to add write
access by a process
named notepad.exe to a
file named userfile.txt,
type:

SLCmd.exe -p
<admin_password> add
writeprotection-file-
exception -t
userfile.txt -p
notepad.exe
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Command Parameter Value Description

Note
The -p and -t
values pattern match
from the end of the
path toward the
beginning of the
path. For example,
specifying
userfile.txt
matches c:\Windows
\userfile.txt and
c:\Temp
\userfile.txt.

-t <file_path> Add the specified file to the
Write Protection Exception
List

For example, to add write
access by any process to a
file named userfile.txt,
type:

SLCmd.exe -p
<admin_password> add
writeprotection-file-
exception -t
userfile.txt
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Command Parameter Value Description

Note
The -t value pattern
matches from the
end of the path
toward the beginning
of the path. For
example, specifying
userfile.txt
matches c:\Windows
\userfile.txt and
c:\Temp
\userfile.txt.

-p
<process_path
>

Add the specified process
path to the Write Protection
Exception List

For example, to add write
access by a process
named notepad.exe to any
files, type:

SLCmd.exe -p
<admin_password> add
writeprotection-file-
exception -p
notepad.exe
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Command Parameter Value Description

Note
The -p value pattern
matches from the
end of the process
path toward the
beginning of the
path. For example,
specifying
notepad.exe
matches c:\Windows
\notepad.exe and
c:\Temp
\notepad.exe.

writeprotection-
folder

[-r]
<folder_path>

Add the specified folder(s)
to the Write Protection List

For example, type:

SLCmd.exe -p
<admin_password> add
writeprotection-folder
-r userfolder
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Command Parameter Value Description

Note
Using the optional -r
value includes the
specified folder and
related subfolders.

The <folder_path>
value pattern
matches from the
end of the path
toward the beginning
of the path. For
example, specifying
userfile.txt
matches c:\Windows
\userfolder and c:
\Temp\userfolder.

writeprotection-
folder-exception

[-r] -t
<folder_path>
-p
<process_path
>

Add the specified folder
and processes run from the
specified path to the Write
Protection Exception List

For example, to add write
access by a process
named notepad.exe to a
folder and related
subfolders at c:\Windows
\System32\Temp, type:

SLCmd.exe -p
<admin_password> add
writeprotection-
folder-exception -r -t
c:\Windows
\System32\Temp -p
notepad.exe
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Command Parameter Value Description

Note
Using the optional -r
value includes the
specified folder and
related subfolders.

The -p and -t
values pattern match
from the end of the
path toward the
beginning of the
path. For example,
specifying
userfile.txt
matches c:\Windows
\userfile.txt and
c:\Temp
\userfile.txt.

[-r] -t
<folder_path>

Add the specified folder(s)
to the Write Protection
Exception List

For example, to add write
access by any process to a
folder at userfolder, type:

SLCmd.exe -p
<admin_password> add
writeprotection-
folder-exception -r -t
userfolder
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Command Parameter Value Description

Note
Using the optional -r
value includes the
specified folder and
related subfolders.

The -t value pattern
matches from the
last part of the folder
path toward the
beginning of the
path. For example,
specifying
userfolder matches
c:\Windows
\userfolder and c:
\Temp\userfolder.

-p
<process_path
>

Add processes run from the
specified paths to the Write
Protection Exception List

For example, to add write
access by a process
named notepad.exe to any
folder, type:

SLCmd.exe -p
<admin_password> add
writeprotection-
folder-exception -p c:
\Windows\notepad.exe
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Command Parameter Value Description

Note
The -p value pattern
matches from the
end of the process
path toward the
beginning of the
path. For example,
specifying
notepad.exe
matches c:\Windows
\notepad.exe and
c:\Temp
\notepad.exe.

remove writeprotection-
file

<file_path> Remove the specified file
from the Write Protection
List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-file
archive.txt

Note
Specify the exact
<file_path> originally
specified in the
corresponding add
command.

writeprotection-
file-exception

-t <file_path>
-p
<process_path
>

Remove the specified file
and process path from the
Write Protection Exception
List

For example, type:
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Command Parameter Value Description
SLCmd.exe -p
<admin_password>
remove
writeprotection-file-
exception -t
userfile.txt -p
notepad.exe

Note
Specify the exact
<file_path> and
<process_path>
originally specified in
the corresponding
add command.

-t <file_path> Remove the specified file
from the Write Protection
Exception List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-file-
exception -t
userfile.txt
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Command Parameter Value Description

Note
The -t value pattern
matches from the
end of the path
toward the beginning
of the path. For
example, specifying
userfile.txt
matches c:\Windows
\userfile.txt and
c:\Temp
\userfile.txt.

-p
<process_path
>

Remove the specified
process path from the Write
Protection Exception List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-file-
exception -p
notepad.exe

Note
The -p value pattern
matches from the
end of the process
path toward the
beginning of the
path. For example,
specifying
notepad.exe
matches c:\Windows
\notepad.exe and
c:\Temp
\notepad.exe.
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Command Parameter Value Description

writeprotection-
folder

[-r]
<folder_path>

Remove the specified
folder(s) from the Write
Protection List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-folder
-r c:\Windows

Note
Using the optional -r
value includes the
specified folder and
related subfolders.

Specify the exact
<folder_path> and -
r value originally
specified in the
corresponding add
command.

writeprotection-
folder-exception

[-r] -t
<folder_path>
-p
<process_path
>

Remove the specified
folder and process path
from the Write Protection
Exception List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-
folder-exception -r -t
c:\Windows
\System32\Temp -p c:
\Windows\notepad.exe
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Command Parameter Value Description

Note
Using the optional -r
value includes the
specified folder and
related subfolders.

Specify the exact
<folder_path>,
<process_path>, and
-r value originally
specified in the
corresponding add
command.

[-r] -t
<folder_path>

Remove the specified
folder(s) from the Write
Protection Exception List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-
folder-exception -r -t
userfolder
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Command Parameter Value Description

Note
Using the optional -r
value includes the
specified folder and
related subfolders.

The -t value pattern
matches from the
last part of the folder
path toward the
beginning of the
path. For example,
specifying
userfolder matches
c:\Windows
\userfolder and c:
\Temp\userfolder.

-p
<process_path
>

Remove the specified
process path from the Write
Protection Exception List

For example, type:

SLCmd.exe -p
<admin_password>
remove
writeprotection-
folder-exception -p c:
\Windows\System32
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Command Parameter Value Description

Note
The -p value pattern
matches from the
end of the process
path toward the
beginning of the
path. For example,
specifying
notepad.exe
matches c:\Windows
\notepad.exe and
c:\Temp
\notepad.exe.

Table 6-18. Write Protection List “Registry” Commands

Command Parameter Value Description

show writeprotection  Display the entire Write
Protection List

writeprotection-
regvalue

 Display the registry values in the
Write Protection List

writeprotection-
regvalue-
exception

 Display the registry values in the
Write Protection Exception List

writeprotection-
regkey

 Display the registry keys in the
Write Protection List

writeprotection-
regkey-exception

 Display the registry keys in the
Write Protection Exception List

add writeprotection-
regvalue

<path_of
_registry
_key>
<registry
_value>

Add the specified registry value
and its related registry key to the
Write Protection List

For example, to add the registry
value of “testvalue” in the “HKEY
\test” registry key to the Write
Protection List, type:
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Command Parameter Value Description
SLCmd.exe -p
<admin_password> add
writeprotection-regvalue
HKEY\test testvalue

writeprotection-
regvalue-
exception

-t
<path_of
_registry
_key>
<registry
_value>
-p
<process
_path>

Add the specified registry value
and its related registry key and a
specific process path for that
value to the Write Protection
Exception List

Note
This command allows
write access by the
specified process to the
specified registry values.

The -p value pattern
matches from the end of
the path toward the
beginning of the path.

-t
<path_of
_registry
_key>
<registry
_value>

Add the specified registry value
and its related registry key to the
Write Protection Exception List

Note
This command allows
write access by any
process to the specified
registry value.

-p
<process
_path>

Add the specified process to the
Write Protection Exception List
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Command Parameter Value Description

Note
This command allows
write access by the
specified process to any
registry values.

The -p value pattern
matches from the end of
the process path toward
the beginning of the path.

writeprotection-
regkey

[-r]
<path_of
_registry
_key>

Add the specified registry key to
the Write Protection List

Note
Using the optional -r
value includes the
specified registry key and
related subkeys.

writeprotection-
regkey-exception

[-r] -t
<path_of
_registry
_key> -p
<process
_path>

Add the specified registry key
and processes run from the
specified path to the Write
Protection Exception List
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Command Parameter Value Description

Note
This command allows
write access by the
specified process to the
specified registry keys.

Using the optional -r
value includes the
specified registry key and
related subkeys.

The -p value pattern
matches from the end of
the process path toward
the beginning of the path.

[-r] -t
<path_of
_registry
_key>

Add the specified registry key to
the Write Protection Exception
List

Note
This command allows
write access by any
process to the specified
registry keys.

Using the optional -r
value includes the
specified registry key and
related subkeys.

-p
<process
_path>

Add processes run from the
specified paths to the Write
Protection Exception List
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Command Parameter Value Description

Note
This command allows
write access by the
specified process to any
registry keys.

The -p value pattern
matches from the end of
the process path toward
the beginning of the path.

remove writeprotection-
regvalue

<path_of
_registry
_key>
<registry
_value>

Remove the specified registry
value from the Write Protection
List

Note
Specify the exact
<path_of_registry_key>
and <registry_value>
originally specified in the
corresponding add
command.

writeprotection-
regvalue-
exception

-t
<path_of
_registry
_key>
<registry
_value>
-p
<process
_path>

Remove the specified registry
value and process path from the
Write Protection Exception List
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Command Parameter Value Description

Note
Specify the exact
<path_of_registry_key>,
<registry_value>, and
<process_path> originally
specified in the
corresponding add
command.

The -p value pattern
matches from the end of
the path toward the
beginning of the path.

-t
<path_of
_registry
_key>
<registry
_value>

Remove the specified registry
value from the Write Protection
Exception List

-p
<process
_path>

Remove the specified process
path from the Write Protection
Exception List

Note
The -p value pattern
matches from the end of
the path toward the
beginning of the path.

writeprotection-
regkey

[-r]
<path_of
_registry
_key>

Remove the specified registry
key from the Write Protection
List
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Command Parameter Value Description

Note
Specify the exact
<path_of_registry_key>
and -r value originally
specified in the
corresponding add
command.

Using the optional -r
value includes the
specified registry key and
related subkeys.

writeprotection-
regkey-exception

[-r] -t
<path_of
_registry
_key> -p
<process
_path>

Remove the specified registry
key and process path from the
Write Protection Exception List

Note
Specify the exact
<path_of_registry_key>,
<process_path>, and -r
value originally specified
in the corresponding add
command.

Using the optional -r
value includes the
specified registry key and
related subkeys.

The -p value pattern
matches from the end of
the path toward the
beginning of the path.

[-r] -t
<path_of
_registry
_key>

Remove the specified registry
key from the Write Protection
Exception List
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Command Parameter Value Description

Note
Using the optional -r
value includes the
specified registry key and
related subkeys.

-p
<process
_path>

Remove the specified process
path from the Write Protection
Exception List

Note
The -p value pattern
matches from the end of
the path toward the
beginning of the path.

Trusted Certification Commands
Configure Trusted Certificates using the Command Line Interface by typing your
command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-19. Abbreviations and Uses

Parameter Abbreviation Use

trustedcertification tc Manage Trusted Certifications

The following table lists the commands, parameters, and values available.
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Table 6-20. Trusted Certificate Commands

Command Parameter Value Description

set trustedcertifica
tion

enable Enable using Trusted
Certifications

disable Disable using Trusted
Certifications

 Display current setting for using
Trusted Certifications

show trustedcertifica
tion

[-v] Display the certificate files in the
Trusted Certifications List

Using the optional -v value
displays detailed information.

add trustedcertifica
tion

-c
<file_path>
[-l <label>]
[-u]

Add the specified certificate file to
the Trusted Certifications List

Using the optional -l value
specifies the unique label for this
certificate file.

Using the optional -u value treats
the file signed by this certificate
file as a Trusted Updater.

remove trustedcertifica
tion

-l <label> Remove a certificate file from the
Trusted Certifications List by
specifying its label

Trusted Hash List Commands
Configure trusted hash values using the Command Line Interface by typing your
command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.
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Table 6-21. Abbreviations and Uses

Parameter Abbreviation Use

trustedhash th Manage trusted hash values (files)
added by the Safe Lock Intelligent
Manager administrator.

The following table lists the commands, parameters, and values available.

Table 6-22. Trusted Hash List Commands

Command Parameter Value Description

set trustedhash enable Enable using Trusted Hash List

 disable Disable using Trusted Hash List

 Display current setting for using
Trusted Hash List

show trustedhash  Display the hash values in the
Trusted Hash List

For example, type:

SLCmd.exe -p
<admin_password> show
trustedhash

add trustedhash -v <hash>
[-l <label>]
[-u][-al][-
t<file_path>
][-n<note>]

Add the specified hash value to
the Trusted Hash List

For example, to add a trusted file
with a hash value xxx to the
Trusted Hash List, type:

SLCmd.exe -p
<admin_password> add
trustedhash -v xxx

Using the optional -l value
specifies the unique label for this
hash value.
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Command Parameter Value Description
Using the optional -u value treats
the file of the specified hash value
as a Trusted Updater.

Note
The -u value requires the
Predefined Trusted Updater
List enabled.

Using the optional -al value adds
the file of the specified hash value
to Approved List.

Using the optional -t value
specifies a file path to check for
the hash value

Note
The -t value pattern
matches from the end of the
path toward the beginning
of the path. For example,
specifying userfile.txt
matches c:\Windows
\userfile.txt and c:
\Temp\userfile.txt.

Using the optional -n value adds a
note for the file hash

remove trustedhash -l <label> Remove a file from the Trusted
Hash List by specifying its label

remove trustedhash -a Remove all the hash values in the
Trusted Hash List
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Trusted Updater Commands
To execute installers or files not specified in agent Approved Lists, configure Trusted
Updater by typing your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-23. Abbreviations and Uses

Parameter Abbreviation Use

trustedupdater tu Manage the Predefined Trusted
Updater tool process

The following table lists the commands, parameters, and values available.

Table 6-24. Trusted Updater Commands

Command Parameter Value Description

start trustedupdater [-r]
<path_of_in
staller>

Start Trusted Updater to add
installer files (EXE and MSI file
types) to the specified folder of the
Approved List.

Note
Using the optional -r value
includes the specified folder
and related subfolders.

For example, to include all
installation packages in the C:
\Installers folder and all sub-
folders, type:

SLCmd.exe -p <admin_password>
start trustedupdater -r C:
\Installers
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Command Parameter Value Description

stop trustedupdater [-f] Disable Trusted Updater to stop
adding new or updated files to the
Approved List.

Note
Using the optional -f value
specifies that the Trusted
Updater does not prompt the
administrator before
committing a file to the
Approved List.

For example, to stop the Trusted
Updater and commit all identified
installers (indentified before
receiving the stop command) to the
Approved List after receiving a
prompt, type:

SLCmd.exe -p <admin_password>
stop trustedupdater -f

Predefined Trusted Updater Commands

Important

The add command for adding files to the Predefined Trusted Updater List follows a
different format than the general commands specified in the Predefined Trusted Updater
Commands table. For details on adding files to the Predefined Trusted Updater List, see
Predefined Trusted Updater "Add" Command on page 6-61.

Configure Predefined Trusted Updaters using the Command Line Interface by typing
your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.
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Table 6-25. Abbreviations and Uses

Parameter Abbreviation Use

predefinedtrustedupdate
r

ptu Manage files in the Predefined
Trusted Updater Lists

The following table lists the commands, parameters, and values available.

Table 6-26. Predefined Trusted Updater Commands

Command Parameter Value Description

add predefinedtruste
dupdater

-e
<folder_or_file_exc
eption>

Add the specified file or
folder to the Predefined
Trusted Updater
Exception List

Important
The add command
for adding files to
the Predefined
Trusted Updater
List follows a
different format
than the other
commands
specified in the
this list. For details
on adding files to
the Predefined
Trusted Updater
List (not the
Predefined
Trusted Updater
Exception List),
see Predefined
Trusted Updater
"Add" Command
on page 6-61.

For example, to add
notepad.exe to the
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Command Parameter Value Description
Predefined Trusted
Updater Exception List,
type:

SLCmd.exe -p
<admin_password> add
predefinedtrustedupd
ater -e C:\Windows
\notepad.exe

decrypt predefinedtruste
dupdater

<path_of_encrypte
d_file>
<path_of_decrypte
d_output_file>

Decrypt a file to the
specified location

For example, to decrypt
C:\Notepad.xen to C:
\Editors\notepad.exe,
type:

SLCmd.exe -p
<admin_password>
decrypt
predefinedtrustedupd
ater C:\Notepad.xen
C:\Editors
\notepad.exe

encrypt predefinedtruste
dupdater

<path_of_file>
<path_of_encrypte
d_output_file>

Encrypt a file to the
specified location

For example, to encrypt
C:\notepad.exe to C:
\Editors\Notepad.xen,
type:

SLCmd.exe -p
<admin_password>
encrypt
predefinedtrustedupd
ater C:\Editors
\notepad.exe C:
\Notepad.xen
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Command Parameter Value Description

export predefinedtruste
dupdater

<path_of_encrypte
d_output>

Export the Predefined
Trusted Updater List to
the specified encrypted
file

For example, type:

SLCmd.exe -p
<admin_password>
export
predefinedtrustedupd
ater C:\Lists
\ptu_list.xen

import predefinedtruste
dupdater

<path_of_encrypte
d_input>

Import a Predefined
Trusted Updater List
from the specified
encrypted file

For example, type:

SLCmd.exe -p
<admin_password>
import
predefinedtrustedupd
ater C:\Lists
\ptu_list.xen

remove predefinedtruste
dupdater

-l <label_name> Remove the specified
labeled rule from the
Predefined Trusted
Updater List

For example, to remove
the “Notepad” rule, type:

SLCmd.exe -p
<admin_password>
remove
predefinedtrustedupd
ater -l Notepad



Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

6-60   

Command Parameter Value Description

-e
<folder_or_file_exc
eption>

Remove the specified
exception from the
Predefined Trusted
Updater Exception List

For example, to remove
the notepad.exe
exception, type:

SLCmd.exe -p
<admin_password>
remove
predefinedtrustedupd
ater -e C:\Windows
\notepad.exe

set predefinedtruste
dupdater

enable Enable the Predefined
Trusted Updater List

disable Disable the Predefined
Trusted Updater List

show predefinedtruste
dupdater

 Display the files in the
Predefined Trusted
Updater List

For example, type:

SLCmd.exe -p
<admin_password>
show
predefinedtrustedupd
ater

-e Display the files in the
Predefined Trusted
Updater Exception List

For example, type:

SLCmd.exe -p
<admin_password>
show
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Command Parameter Value Description
predefinedtrustedupd
ater -e

Predefined Trusted Updater "Add" Command

Add processes, files, or folders to the Predefined Trusted Updater List using the
Command Line Interface by typing your command in the following format:

SLCmd.exe -p <admin_password> add predefinedtrustedupdater -u
<folder_or_file> -t <type_of_object> [<optional_values>]

The following table lists the command, parameter, and base value.

Table 6-27. Predefined Trusted Updater “Add” Command

Command Parameter Value Description

add predefinedtruste
dupdater

<folder_or_fil
e

Add a specified file or folder
to the Predefined Trusted
Updater List

For example, to add
notepad.exe to the
Predefined Trusted Updater
List, type:

SLCmd.exe -p
<admin_password> add
predefinedtrustedupdater
C:\Windows\notepad.exe

Append the following additional values at the end of the command:

Table 6-28. Predefined Trusted Updater “Add” Additional Values

Value Required /
Optional Description Example

-u
<folder_or_file
>

Required Add the specified file or folder to
the Predefined Trusted Updater List

N/A
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Value Required /
Optional Description Example

Note
This
parameter
requires
the use of
the -t
<type_of_o
bject>
value.

-t
<type_of_obje
ct>

Required Specify the type of object to add to
the Predefined Trusted Updater List
located in -u <folder_or_file>

Available objects types are as
follows:

SLCmd.exe -p
<admin_password
> add
predefinedtrust
edupdater -u C:
\Windows
\notepad.exe -t
process

process Indicates only EXE
file types

file Indicates only MSI
and BAT file types

folder Indicates all EXE,
MSI, and BAT files in
the specified folder

folderandsub Indicates all EXE,
MSI, and BAT files in
the specified folder
and related
subfolders

-p
<parent_proc
ess>

Optional Add the full file path to the specified
parent process used to invoke the
file(s) specified in -u
<folder_or_file>

SLCmd.exe -p
<admin_password
> add
predefinedtrust
edupdater -u C:
\Windows
\notepad.exe -t
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Value Required /
Optional Description Example

process -p C:
\batch files
\note.bat

-l
<label_name>

Optional Specify a label name for the file(s)
specified in -u <folder_or_file>

Note

When left blank, Safe Lock
assigns an arbitrary label
name.

SLCmd.exe -p
<admin_password
> add
predefinedtrust
edupdater -u C:
\Windows
\notepad.exe -t
process -l
EDITOR

-al enable Optional Compare the hash values in the
Approved List with the hash values
calculated from the actual files

Note

Enabled by default even
when -al is not specified.

SLCmd.exe -p
<admin_password
> add
predefinedtrust
edupdater -u C:
\Windows
\notepad.exe -t
process -al
enable

-al disable Optional Do not compare the hash values in
the Approved List with the hash
values calculated from the actual
files

SLCmd.exe -p
<admin_password
> add
predefinedtrust
edupdater -u C:
\Windows
\notepad.exe -t
process -al
disable

Windows Update Support

Configure Windows Update Support using the Command Line Interface by typing your
command in the following format:
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SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-29. Abbreviations and Uses

Parameter Abbreviation Use

windowsupdatesuppo
rt

wus Allow Windows Update to run on the
agent with the Application Lockdown
on.

The following table lists the commands, parameters, and values available.

Table 6-30. Windows Update Support Commands

Command Parameter Value Description

set windowsupdatesup
port

enable Enable Windows Update
Support

disable Disable Windows Update
Support

 Display current setting for
Windows Update Support

Blocked File Notification Commands
Enable or disable notifications for file blocking using the Command Line Interface by
typing your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.
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Table 6-31. Abbreviations and Uses

Parameter Abbreviation Use

blockedfilenotifica
tion

bfn Display notifications on the
managed endpoint when Safe Lock
Intelligent Manager blocks and
prevents an application from running
or making changes to the endpoint.

The following table lists the commands, parameters, and values available.

Table 6-32. Blocked File Notification Commands

Command Parameter Value Description

set blockedfilenotif
ication

enable Enable pop-up notifications.

disable Disable pop-up notifications.

 Display the current setting.

Configuration File Commands
Perform actions on the configuration file using the Command Line Interface by typing
your command in the following format:

SLCmd.exe -p <admin_password> <command> <parameter> <value>

The following table lists the available abbreviated forms of parameters.

Table 6-33. Abbreviations and Uses

Parameter Abbreviation Use

configuration con Manage the configuration file

The following table lists the commands, parameters, and values available.
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Table 6-34. Configuration File Commands

Command Parameter Value Description

decrypt configuration <path_of_encrypted
_file>
<path_of_decrypted
_output_file>

Decrypts a configuration file to
the specified location

For example, to decrypt C:
\config.xen to C:
\config.xml, type:

SLCmd.exe -p
<admin_password> decrypt
configuration C:
\config.xen C:\config.xml

encrypt configuration <path_of_file>
<path_of_encrypted
_output_file>

Encrypts a configuration file to
the specified location

For example, to encrypt C:
\config.xml to C:
\config.xen, type:

SLCmd.exe -p
<admin_password> encrypt
configuration C:
\config.xml C:\config.xen

export configuration <path_of_encrypted
_output>

Export the configuration file to
the specified location

For example, type:

SLCmd.exe -p
<admin_password> export
configuration C:
\config.xen

import configuration <path_of_encrypted
_input>

Import a configuration file from
the specified location

For example, type:

SLCmd.exe -p
<admin_password> import
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Command Parameter Value Description
configuration C:
\config.xen
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Chapter 7

Managing Agents Remotely
This chapter describes remote Trend Micro Safe Lock agent management.

Topics in this chapter include:

• The Remote Setup Tool (SLrst) on page 7-2

• The Remote Tasks Tool (SLtasks) on page 7-21



Trend Micro Safe Lock™ Intelligent Manager Administrator's Guide   

7-2   

The Remote Setup Tool (SLrst)
You can use the Remote Setup Tool to perform silent installations, patching, and
uninstallations of the Safe Lock agent program using a command line interface (CLI).

SLrst.exe remotely performs operations on target endpoints while target endpoints
directly access the Safe Lock Intelligent Manager server.

By default, Safe Lock Intelligent Manager stores the SLrst.exe file in the following
location:

<Safe_Lock_Intelligent_Manager_installation_folder>\CmdTools
\RemoteAgentSetupTool\

The Remote Setup Tool uses the following syntax for all CLI functions:

SLrst <targets CSV file> <parameter>

Type SLrst at the command prompt and press ENTER to view an example of the
Remote Setup Tool syntax.

Important

Only a Safe Lock Intelligent Manager administrator with Windows administrator privileges
can use SLrst at the command line interface (CLI).

Tip

Optionally, copy the entire RemoteAgentSetupTool folder containing SLrst.exe
from the Program Files folder to other locations to run the program. SLrst.exe is
designed to run from within the RemoteAgentSetupTool folder on any endpoint in
your network with .NET Framework 2.0 or 3.5 installed, with SLrst.exe added to the
Safe Lock Approved List or with Application Lockdown turned off, and with access to the
Safe Lock Intelligent Manager server.

The following table lists the functions available using the SLrst program.
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Table 7-1. SLrst Remote Agent Setup Parameters

Parameter Function

--install Deploys and installs the Safe Lock agent on the endpoint

See Remote Installation Considerations on page 7-3.

--patch Patches the Safe Lock agent

--reboot Restarts the endpoint (required if you want to reinstall the
Safe Lock agent)

Restarting Agents Remotely on page 7-20

Note
The reboot function is not compatible on systems
running Windows 2000 platforms. Manually restart
endpoints running Windows 2000 platforms if you
want to reinstall the Safe Lock agent.

--uninstall Uninstalls the Safe Lock agent from the endpoint

Uninstalling Agents Remotely on page 7-19

Remote Installation Considerations
Before you remotely install Safe Lock agents, ensure the following:

• Safe Lock Intelligent Manager is installed on the server endpoint.

• Safe Lock agent versions earlier than 1.1 are not installed on target endpoints.

See Agent Upgrade Preparation on page 1-17.

• Network, target endpoints, and the server endpoint firewall settings allow for the
following:

• Safe Lock Intelligent Manager ports (by default 8000, 8001, and 14336)

• File sharing services

• WMI services
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• IPC services

• Target endpoints have the following settings:

• Simple File Sharing is disabled. (Windows XP)

• File sharing is enabled.

• A local account has access to the default share admin$.

• Windows Management Instrumentation (WMI) service is enabled.

• Windows Interprocess Communications (IPC) service is enabled.

Note

To keep firewall settings enabled on Windows-based endpoints, use the Remote
Task Tool command --applyupdate. For details, see Initializing Agent
Approved Lists on page 7-22.

• Target endpoints are not running Windows Installer sessions. Specifically, confirm
that Windows Update is not updating the endpoint in the background.

Preparing Windows Server 2003 for Remote Installations

Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows Server 2003

• Windows Server 2003 R2

Procedure

1. Turn off Windows Firewall.

2. Turn on File and Printer Sharing for Microsoft Networks.

a. Go to Start > Control Panel > Network Connections.

b. Right-click Local Area Connection and then select Properties.
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c. Select File and Printer Sharing for Microsoft Networks.

Preparing Windows Server 2008 for Remote Installations

Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows Server 2008

• Windows Server 2008 R2

Procedure

1. Turn off Windows Firewall.

2. Turn off User Account Control by editing the registry.

a. Open Registry Editor (regedit.exe).

For example, go to Start > Run..., type regedit, and then press ENTER.

b. Locate and click the following registry subkey: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies
\System.

c. On the right, locate the following entry:
LocalAccountTokenFilterPolicy.

If the entry does not exist, do the following to create it:

i. Go to Edit > New.

ii. Select DWORD Value.

iii. Type LocalAccountTokenFilterPolicy and then press ENTER.

d. Right-click LocalAccountTokenFilterPolicy and then select Modify.

e. In the Value field, type 1.

f. Click OK.
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g. Close Registry Editor.

3. Turn on Network Discovery for each user account that will log on the endpoint.

a. Go to Start > Control Panel > Network and Sharing Center.

b. Right-click Local Area Connection and then select Properties.

c. Select File and Printer Sharing for Microsoft Networks.

Preparing Windows Server 2012 for Remote Installations

Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows Server 2012

• Windows Server 2012 R2

Procedure

1. Turn off Windows Firewall.

2. Turn off User Account Control by editing the registry.

a. Open Registry Editor (regedit.exe).

For example, go to Start > Run..., type regedit, and then press ENTER.

b. Locate and click the following registry subkey: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies
\System.

c. On the right, locate the following entry:
LocalAccountTokenFilterPolicy.

If the entry does not exist, do the following to create it:

i. Go to Edit > New.

ii. Select DWORD Value.
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iii. Type LocalAccountTokenFilterPolicy and then press ENTER.

d. Right-click LocalAccountTokenFilterPolicy and then select Modify.

e. In the Value field, type 1.

f. Click OK.

g. Close Registry Editor.

3. Turn on Network Discovery for each user account that will log on the endpoint.

a. Go to Start > Control Panel > All Control Panel Items > Network and
Sharing Center.

b. From the left panel, click Change advanced sharing settings and click
Domain (current profile) drop-down list.

c. Select Turn on network discovery.

Preparing Windows XP for Remote Installations
Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows XP

Procedure

1. Turn off Windows Firewall.

See http://support.microsoft.com/kb/283673/en.

2. Turn on File and Printer Sharing for Microsoft Networks.

a. Go to Start > Control Panel > Network Connections.

b. Right-click Local Area Connection and then select Properties.

c. Select File and Printer Sharing for Microsoft Networks.

3. Disable Simple File Sharing.

http://support.microsoft.com/kb/283673/en
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See http://support.microsoft.com/kb/307874/en.

Preparing Windows 7 for Remote Installations

Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows 7

Procedure

1. Turn off Windows Firewall.

See http://windows.microsoft.com/en-us/windows/turn-windows-firewall-on-
off#turn-windows-firewall-on-off=windows-7.

2. Turn off User Account Control by editing the registry.

a. Open Registry Editor (regedit.exe).

For example, go to Start > Run..., type regedit, and then press ENTER.

b. Locate and click the following registry subkey: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies
\System.

c. On the right, locate the following entry:
LocalAccountTokenFilterPolicy.

If the entry does not exist, do the following to create it:

i. Go to Edit > New.

ii. Select DWORD Value.

iii. Type LocalAccountTokenFilterPolicy and then press ENTER.

d. Right-click LocalAccountTokenFilterPolicy and then select Modify.

e. In the Value field, type 1.

http://support.microsoft.com/kb/307874/en
http://windows.microsoft.com/en-us/windows/turn-windows-firewall-on-off#turn-windows-firewall-on-off=windows-7
http://windows.microsoft.com/en-us/windows/turn-windows-firewall-on-off#turn-windows-firewall-on-off=windows-7
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f. Click OK.

g. Close Registry Editor.

3. Turn on Network Discovery for each user account that will log on the endpoint.

See http://windows.microsoft.com/en-us/windows/enable-disable-network-
discovery#1TC=windows-7.

Preparing Windows 8 for Remote Installations

Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows 8

• Windows 8.1

Procedure

1. Turn off Windows Firewall.

See https://support.microsoft.com/en-us/products/windows?os=windows-8.1.

2. Turn off User Account Control by editing the registry.

a. Open Registry Editor (regedit.exe).

For example, go to Start > Run..., type regedit, and then press ENTER.

b. Locate and click the following registry subkey: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies
\System.

c. On the right, locate the following entry:
LocalAccountTokenFilterPolicy.

If the entry does not exist, do the following to create it:

i. Go to Edit > New.

http://windows.microsoft.com/en-us/windows/enable-disable-network-discovery#1TC=windows-7
http://windows.microsoft.com/en-us/windows/enable-disable-network-discovery#1TC=windows-7
https://support.microsoft.com/en-us/products/windows?os=windows-8.1
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ii. Select DWORD Value.

iii. Type LocalAccountTokenFilterPolicy and then press ENTER.

d. Right-click LocalAccountTokenFilterPolicy and then select Modify.

e. In the Value field, type 1.

f. Click OK.

g. Close Registry Editor.

3. Turn on Network Discovery for each user account that will log on the endpoint.

a. Go to Start > Control Panel > Network and Sharing Center.

b. Right-click Local Area Connection and then select Properties.

c. Select File and Printer Sharing for Microsoft Networks.

Preparing Windows 10 for Remote Installations

Before running Safe Lock remote installations, follow this procedure to prepare
components for the following Windows versions:

• Windows 10 Enterprise

• Windows 10 IoT Enterprise

Procedure

1. Turn off Windows Firewall.

See https://support.microsoft.com/en-us/products/windows?os=windows-10.

2. Turn off User Account Control by editing the registry.

a. Open Registry Editor (regedit.exe).

For example, go to Start > Run..., type regedit, and then press ENTER.

https://support.microsoft.com/en-us/products/windows?os=windows-10
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b. Locate and click the following registry subkey: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies
\System.

c. On the right, locate the following entry:
LocalAccountTokenFilterPolicy.

If the entry does not exist, do the following to create it:

i. Go to Edit > New.

ii. Select DWORD Value.

iii. Type LocalAccountTokenFilterPolicy and then press ENTER.

d. Right-click LocalAccountTokenFilterPolicy and then select Modify.

e. In the Value field, type 1.

f. Click OK.

g. Close Registry Editor.

3. Turn on Network Discovery for each user account that will log on the endpoint.

a. Go to Start > Control Panel > All Control Panel Items > Network and
Sharing Center > Advanced sharing settings.

b. Select Turn on network discovery and Turn on automatic setup of
network connected devices.

Preparing the Agent Target Files

The Remote Setup Tool utilizes two files when processing commands.

• endpoint_info.csv: Stores relevant connection information for agent
endpoints

• targets.csv: Targets specific endpoints for the current deployment
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Important
To edit endpoint_info.csv or targets.csv files that are in the Program Files folder,
copy them to a path with file write priveleges, edit them, then copy them back to the
suggested path below.

Procedure

1. Prepare the “endpoint info” file and save it as endpoint_info.csv in the
following path:

<Safe_Lock_Intelligent_Manager_installation_folder>
\CmdTools\RemoteAgentSetupTool\

See Endpoint Info File Specifications on page 7-13.

2. Create the “targets” file or batches of files and save them in the following path:

<Safe_Lock_Intelligent_Manager_installation_folder>
\CmdTools\RemoteAgentSetupTool\

See Targets File Specifications on page 7-12.

Targets File Specifications
The “targets” file used during remote agent installation contains the IP address of target
endpoints. The targets file uses CSV format and has the file name targets.csv by
default.

Tip
Remote agent setup using the SLrst command line program can be done in batches using
more than one targets file and the same endpoint info file. The endpoint info file can
contain information for endpoints outside the scope of the target endpoints listed in the
targets file.

To create customized “targets” CSV files, specify the IP address of each target endpoint.
Use one line per record. Use of spaces, quotation marks, or other delimiters is not
supported.
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For example:

Valid

Targeted IP
10.1.199.199
10.1.199.201
192.168.1.20

Not Valid

10.1.199.199,10.1.199.201

"10.1.199.199"
"10.1.199.201"
"192.168.1.20"

Tip

The targets file can be reused. Therefore, you can use the same targets file to deploy, patch,
and uninstall a batch of target endpoints. Check the log information and make backups of
any critical information each time you run the SLrst program. SLrst ignores and
overwrites any log information in the file each time it is run.

Endpoint Info File Specifications

The “endpoint info” file used during remote agent installation contains the IP address,
user name, and password of a local account on each target endpoint with access to the
default share admin$.

Tip

Trend Micro recommends using the local administrator account on each target endpoint
for deployment.

The endpoint info file uses CSV format. The filename must be endpoint_info.csv.
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Note
To create the “endpoint info” CSV file, divide the records into fields for IP address, user
name, and password. Use one line per record. Separate these fields using a comma. Use of
spaces, quotation marks, or other delimiters is not supported.

For example:

Valid

IP,Username,Password
10.1.199.199,Administrator,password1
10.1.199.200,Administrator,password2
10.1.199.201,Administrator,password3
192.168.1.20,Daniel,his_pwd
192.168.1.21,Sophia,her_pwd

Not Valid

10.1.199.201,Administrator,password3,192.168.1.20,Daniel,his_pwd

"10.1.199.199","Administrator","password1"
"10.1.199.200""Administrator","password2"
"10.1.199.201","Administrator","password3"
"192.168.1.20","Daniel","his_pwd"
"192.168.1.21","Sophia","her_pwd"

Microsoft Excel will save a chart as a CSV using valid formatting.

Downloading an Up-to-Date Agent Installer Package

Procedure

1. Go to Administration > Components > Updates in the navigation at the top of
the web console.

The Component Updates screen appears.

2. Click Download Agent Installer Package.

3. Select the language the installation package.

Your browser downloads the most up-to-date agent installer package.
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Note
The agent installer package is considered up-to-date by Safe Lock Intelligent Manager
based on the component versions displayed on the Component Updates screen. If
the cached agent installer package is not up-to-date, Safe Lock Intelligent Manager
prepares and caches an up-to-date package before starting the download.

Preparing an up-to-date agent installer package is system-intensive. Depending on the
hardware running Safe Lock Intelligent Manager, preparing an up-to-date agent
installer package can take a while.

4. To use the downloaded agent installer package for remote installations using the
SLrst program at the command line interface (CLI), copy the downloaded agent
installer package to the path used by SLrst.

For example, if you installed Safe Lock Intelligent Manager to the default path on
the C drive, copy the downloaded agent installer package to the following path: c:
\Program Files\Trend Micro\Safe Lock Intelligent Manager
\CmdTools\RemoteAgentSetupTool\

Important
The package file name must follow the format:
TMSL2.0_<language_abbreviation>.zip

For example:

Valid Not Valid

TMSL2.0_EN.zip TMSL2.0_EN (1).zip

TMSL2.0_JA.zip TMSL2.0_EN_1.zip
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Installing Agents Remotely

Important

• Before remotely managing Safe Lock agents using the Remote Setup Tool, prepare the
“endpoint info” and “targets” files.

See Preparing the Agent Target Files on page 7-11.

• Before remotely installing Safe Lock agents, download an up-to-date agent installer
package.

See Downloading an Up-to-Date Agent Installer Package on page 4-3.

Use the SLrst.exe program at the command line interface (CLI) to install one or
more Safe Lock agents connected to the network.

Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Setup Tool” program folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentSetupTool\"

3. To remotely install agents using the default targets file targets.csv, type the
following at the command prompt:

SLrst.exe targets.csv --install

The remote setup tool looks for targets in the targets.csv file. For large
production environments, Trend Micro recommends that you install agents in
batches. Run the remote setup tool separately for each CSV batch file.

4. At the prompt, provide a password used to access the Safe Lock agent program
and then confirm the password.
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5. Select the target language.

6. Select to perform a prescan for malware on the target endpoints before installing
the Safe Lock agent.

7. Select to enable root cause analysis on the target endpoints.

8. Monitor the progress of the remote installation process. Safe Lock writes log
information directly in the CSV file (by default, targets.csv) specified in the
command line argument.

Customizing Agent Installation Remotely Using a
Setup.ini File

Procedure

1. Navigate to the “package” folder of the Trend Micro Safe Lock Intelligent Manager
installation folder.

For example, type the following to reach the default location:

"C:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentSetupTool\package"

2. Unzip the TMSL2.0_EN file.

3. In the unzipped file, open the Setup.ini file and make changes to installation
parameters as required. For details on installation parameters and their possible
values, see Setup.ini File Arguments on page 8-15.

4. Zip the TMSL2.0_EN file and make sure it is saved to the installed path.

5. Install agents remotely. For details, see Installing Agents Remotely on page 7-16.
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Applying Patches and Hotfixes to Agents Remotely

Important

• Before remotely managing Safe Lock agents using the Remote Setup Tool, prepare the
“endpoint info” and “targets” files.

See Preparing the Agent Target Files on page 7-11.

• Before remotely updating Safe Lock agents, download the latest agent patch or hotfix
file using the Trend Micro Technical Support Download Center website: http://
downloadcenter.trendmicro.com/

Use the SLrst.exe program at the command line interface (CLI) to install one or
more Safe Lock agents connected to the network.

Procedure

1. Copy the downloaded agent patch or hotfix to the path used by SLrst.

For example, if you installed Safe Lock Intelligent Manager to the default path on
the C drive, copy the downloaded agent installer patch or hotfix to the following
path: c:\Program Files\Trend Micro\Safe Lock Intelligent
Manager\CmdTools\RemoteAgentSetupTool\package\

Important

The patch or hot fix file name must follow the format:
TMSL2.0_Hotfix_<language_abbreviation>.zip

For example:

Valid Not Valid

TMSL2.0_Hotfix_EN.zip TMSL2.0_Hotfix_EN (1).zip

TMSL2.0_Hotfix_JA.zip TMSL2.0_Hotfix_EN_1.zip

2. Navigate to the Trend Micro Trend Micro “Safe Lock Remote Setup Tool” folder
inside the installation folder using the cd command.

http://downloadcenter.trendmicro.com/
http://downloadcenter.trendmicro.com/
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For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentSetupTool\"

3. To remotely patch or hotfix agents using the default targets file targets.csv,
type the following at the command prompt:

SLrst.exe targets.csv --patch

The remote setup tool looks for targets in the targets.csv file. For large
production environments, Trend Micro recommends that you patch or hotfix
agents in batches. Run the remote setup tool separately for each CSV batch file.

4. At the prompt, provide the password used to access the Safe Lock agent program.

5. Monitor the progress of the remote patch or hotfix. Safe Lock writes log
information directly in the CSV file (by default, targets.csv) specified in the
command line argument.

Uninstalling Agents Remotely

Important
Before remotely managing Safe Lock agents using the Remote Setup Tool, prepare the
“endpoint info” and “targets” files.

See Preparing the Agent Target Files on page 7-11.

Use the SLrst.exe program at the command line interface (CLI) to uninstall one or
more Safe Lock agents connected to the network.

Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Setup Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:
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cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentSetupTool\"

3. To remotely install agents using the default targets file targets.csv, type the
following at the command prompt:

SLrst.exe targets.csv --uninstall

The remote setup tool looks for targets in the targets.csv file. For large
production environments, Trend Micro recommends that you uninstall agents in
batches. Run the remote setup tool separately for each CSV batch file.

4. At the prompt, provide the password used to access the Safe Lock agent program.

5. Monitor the progress of the remote uninstallation process. Safe Lock writes log
information directly in the CSV file (by default, targets.csv) specified in the
command line argument.

6. Restart endpoints to complete the uninstallation process.

Restarting Agents Remotely

Important
Before remotely managing Safe Lock agents using the Remote Setup Tool, prepare the
“endpoint info” and “targets” files.

See Preparing the Agent Target Files on page 7-11.

Use the SLrst.exe program at the command line interface (CLI) to restart one or
more Safe Lock agents connected to the network.

Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Setup Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:
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cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentSetupTool\"

3. To remotely install agents using the default targets file targets.csv, type the
following at the command prompt:

SLrst.exe targets.csv --reboot

The remote setup tool looks for targets in the targets.csv file. For large
production environments, Trend Micro recommends that you restart agents in
batches. Run the remote setup tool separately for each CSV batch file.

4. Monitor the progress of the remote restart process. Safe Lock writes log
information directly in the CSV file (by default, targets.csv) specified in the
command line argument.

Endpoints restart automatically after receiving the command.

The Remote Tasks Tool (SLtasks)
You can use the Remote Tasks Tool to initialize agent Approved Lists, lockdown agents,
match licenses, deploy patch or hotfixes without disabling firewall settings on agents,
and query the status of agents using a command line interface (CLI).

By default, Safe Lock Intelligent Manager stores the SLtasks.exe file is the following
location:

<Safe_Lock_Intelligent_Manager_installation_folder>\CmdTools
\RemoteAgentTasksTool\

Important
Only a Safe Lock Intelligent Manager administrator with Windows administrator privileges
can use SLtasks at the command line interface (CLI).
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Initializing Agent Approved Lists

Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Tasks Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentTasksTool\"

3. Log on the Safe Lock Intelligent Manager server by typing the following command:

SLtasks.exe --logon

4. Type your Safe Lock Intelligent Manager credentials.

The CLI confirms a successful log on to the server.

Important

• The logged on account must have “admin” or “Full Control” privilege to send
tasks to agents.

• To reduce network and endpoint impact, Safe Lock Intelligent Manager queries
target agents for their configurations and then sends only tasks it determines are
needed.

5. Generate a list of target agents. To limit the query to agents before or after a
specific version, append --minversion and --maxversion to the command
and type the agent version.

• SLtasks.exe --query --minversion <agent_version>

• SLtasks.exe --query --maxversion <agent_version>

Important
The <agent_version> must be in the form of x.x.xxxx. For example,
2.0.5000.
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The results of the query are saved in query_results.csv.

Tip

Trend Micro recommends querying agent statuses before deploying any tasks. A
warning message appears if the query results are out-of-date when attempting to
deploy tasks.

6. Perform the necessary tasks using the following syntax:

SLtasks.exe <task_parameter>

Table 7-2. SLtasks Task Parameters

Parameter Task

--init Initialize the Approved List.

--lockdown Turn Application Lockdown on.

Tip

• To send tasks to a specific agent, append --targetPC to the command and
type the computer name.

For example:

SLtasks.exe <task_parameter> --targetPC <computer_name>

• To ensure efficiency when updating multiple agents, append --
concurrentdownload to limit the number of agents allowed for downloading
the patch or hotfix at the same time.

For example:

SLtasks.exe --applyupdate <update_files> --concurrentdownload
2

7. Log off the Safe Lock Intelligent Manager server by typing the following
command:

SLtasks.exe --logoff
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The CLI confirms a successful log off from the server.

Removing Files from Agent Approved Lists

Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Tasks Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentTasksTool\"

3. Log on the Safe Lock Intelligent Manager server by typing the following command:

SLtasks.exe --logon

4. Type your Safe Lock Intelligent Manager credentials.

The CLI confirms a successful log on to the server.

Important

• The logged on account must have “admin” or “Full Control” privilege to send
tasks to agents.

• To reduce network and endpoint impact, Safe Lock Intelligent Manager queries
target agents for their configurations and then sends only tasks it determines are
needed.

5. Generate a list of target agents. To limit the query to agents before or after a
specific version, append --minversion and --maxversion to the command
and type the agent version.

• SLtasks.exe --query --minversion <agent_version>
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• SLtasks.exe --query --maxversion <agent_version>

Important
The <agent_version> must be in the form of x.x.xxxx. For example,
2.0.5000.

The results of the query are saved in query_results.csv.

Tip
Trend Micro recommends querying agent statuses before deploying any tasks. A
warning message appears if the query results are out-of-date when attempting to
deploy tasks.

6. List the target files in a CSV file of UTF-8 format without byte order mark (BOM).
List the files in any of the following variations.

• File name

• File path with file name

• File path with SHA-1 hash

• File name and SHA-1 hash

• SHA-1 hash

For example, the following are all valid ways of listing the files:

• cal.exe,

• C:\Windows\system32\calc.exe,

• C:\Windows\system32\
9018A7D6CDBE859A430E794E73381F77C840BE0,

• cal.exe, 9018A7D6CDBE859A430E794E73381F77C840BE0

• 9018A7D6CDBE859A430E794E73381F77C840BE0,

7. Type the following syntax to remove items from all agent Approved Lists:

SLtasks.exe --removeitems<target_list_file_name>
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Tip

• To only remove approved items from a specific agent, append --targetPC to
the command and type the computer name.

For example:

SLtasks.exe <task_parameter> --targetPC <computer_name>

8. Log off the Safe Lock Intelligent Manager server by typing the following
command:

SLtasks.exe --logoff

The CLI confirms a successful log off from the server.

Renewing Agent Licenses

Procedure

1. Update the Intelligent Manager license.

2. Open a command prompt window with Windows administrator privileges.

3. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Tasks Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentTasksTool\"

4. Log on the Safe Lock Intelligent Manager server by typing the following command:

SLtasks.exe --logon

5. Type your Safe Lock Intelligent Manager credentials.

The CLI confirms a successful log on to the server.
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Important

• The logged on account must have “admin” or “Full Control” privilege to send
tasks to agents.

• To reduce network and endpoint impact, Safe Lock Intelligent Manager queries
target agents for their configurations and then sends only tasks it determines are
needed.

6. Generate a list of target agents. To limit the query to agents before or after a
specific version, append --minversion and --maxversion to the command
and type the agent version.

• SLtasks.exe --query --minversion <agent_version>

• SLtasks.exe --query --maxversion <agent_version>

Important

The <agent_version> must be in the form of x.x.xxxx. For example,
2.0.5000.

The results of the query are saved in query_results.csv.

Tip

Trend Micro recommends querying agent statuses before deploying any tasks. A
warning message appears if the query results are out-of-date when attempting to
deploy tasks.

7. Type the following command.

SLtasks.exe --match

The license of the target agents are immediately updated to match the Safe Lock
Intelligent Manager's license.

8. Log off the Safe Lock Intelligent Manager server by typing the following
command:

SLtasks.exe --logoff
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The CLI confirms a successful log off from the server.

Deploying Patches and Hotfixes to Agents Remotely

Procedure

1. Download an agent patch or hotfix using the Trend Micro Technical Support
Download Center website:

http://downloadcenter.trendmicro.com/

2. Copy the downloaded agent patch or hotfix to the patch used by SLtasks.

For example, if you installed Safe Lock Intelligent Manager to the default path on
the C drive, copy the downloaded agent installer patch or hotfix to the following
path: c:\Program Files\Trend Micro\Safe Lock Intelligent
Manager\CmdTools\RemoteAgentTasksTool\patch\

3. Open a command prompt window with Windows administrator privileges.

4. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Tasks Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentTasksTool\"

5. Log on the Safe Lock Intelligent Manager server by typing the following command:

SLtasks.exe --logon

6. Query agent statuses. To limit the query to agents before or after a specific version,
append --minversion and --maxversion to the command and type the agent
version.

• SLtasks.exe --query --minversion <agent_version>

• SLtasks.exe --query --maxversion <agent_version>

http://downloadcenter.trendmicro.com/
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Important
The <agent_version> must be in the form of x.x.xxxx. For example,
2.0.5000.

7. Apply the hotfix by typing the following command and specify the file name:

SLtasks.exe --applyupdate <hotfix_file_name_with_extension>

Applying Message Time Groups
Message time groups use message-sending cycles to add additional bandwidth control to
automated messages sent from Safe Lock agents to the Safe Lock Intelligent Manager.

During a message-sending cycle, agents in the active group send automated messages,
which include log and status as well as quarantined files to be scanned, to Safe Lock
Intelligent Manager. When a message-sending cycle ends, the next group of agents
becomes active and sends automated messages.

Agents outside the active group do not send automated messages. However, agents in all
groups respond as soon as possible to direct requests from Safe Lock Intelligent
Manager. For example, a request to send logs and status from the web console will be
replied to by the target agent as soon as network connectivity allows.

Note
The following conditions apply to automated messages:

By default, Safe Lock Intelligent Manager puts all agents into one "always on" group.

During a message-sending cycle, messages are sent in the following order:

• Higher priority first

• Oldest (least recent) first

Applying Message Time Groups Using the Remote Tasks
Tool
Use SLtasks.exe to apply message time groups to agents.
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Procedure

1. Open a command prompt window with Windows administrator privileges.

2. Navigate to the Trend Micro Safe Lock Intelligent Manager “Safe Lock Remote
Tasks Tool” folder inside the installation folder using the cd command.

For example, type the following command to reach the default location:

cd /d "c:\Program Files\Trend Micro\Safe Lock Intelligent Manager\CmdTools
\RemoteAgentTasksTool\"

3. Log on the Safe Lock Intelligent Manager server by typing the following command:

SLtasks.exe --logon

4. Type your Safe Lock Intelligent Manager credentials.

The CLI confirms a successful log on to the server.

5. Query message time groups by typing the following command:

SLtasks.exe --querygroup

The results of the query are saved in group_info.csv.

Important
Applying message time groups requires querying message time groups, editing the
results as needed, and then applying the configured message time groups to agents. A
warning message appears if the query results are out-of-date when attempting to
apply message time groups to agents.

6. Edit the group_info.csv to configure the following message time group
controls:
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Column Name Control Description

TotalGroupNum Divide agents into any number of groups.

Tip
Set this value to 1 to turn the feature off.

OwnGroupIndex Set the message group ID number for the Safe Lock agent.

TimePeriod Set a duration for how long each group is allowed to send
messages to Safe Lock Intelligent Manager when that group's
message-sending cycle is active.

7. Apply message time groups to agents using the configured group_info.csv file
by typing the following command:

SLtasks.exe --applygroups

Important

• The logged on account must have “admin” or “Full Control” privilege to apply
message time groups to agents.

• Only agents listed in group_info.csv receive the command.

8. Log off the Safe Lock Intelligent Manager server by typing the following
command:

SLtasks.exe --logoff

The CLI confirms a successful log off from the server.

Applying Message Time Groups Using the Configuration
File

Procedure

1. Access the Export/Import Configuration section from the Trend Micro Safe
Lock console.
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a. Open the Trend Micro Safe Lock console using the desktop icon (if available)
or the Start menu by clicking All Programs > Trend Micro Safe Lock.

b. Provide the password and click Login.

c. Click the Settings menu item.

2. Export the configuration file as a database .xen file.

a. Click Export, and choose the location to save the file.

b. Provide a filename, and click Save.

3. Decrypt the configuration file.

4. From Windows Notepad or another text editor, edit the
MessageRandomization parameter in the ManagedMode section:

Column Name Control Description

TotalGroupNum Divide agents into any number of groups.

OwnGroupIndex Set the message group ID number for the Safe Lock agent.

TimePeriod Set a duration for how long each group is allowed to send
messages to Safe Lock Intelligent Manager when that group's
message-sending cycle is active.

5. From the Export/Import Configuration section of the Trend Micro Safe Lock
console, import the configuration file as a database () file.

a. Click Import, and locate the database file.

b. Select the file, and click Open.

Trend Micro Safe Lock overwrites the existing configuration settings with the new
settings in the database file.
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Applying Message Time Groups Using the Setup.ini File

Procedure

1. Edit the MESSAGERANDOMIZATION arguments in the Setup.ini file.

a. From the Trend Micro Safe Lock Intelligent Manager folder, double-click
Setup.ini.

b. Edit the following arguments in the MESSAGERANDOMIZATION section:

Column Name Control Description

TOTAL_GROUP_NU
M

Divide agents into any number of groups.

OWN_GROUP_INDE
X

Set the message group ID number for the Safe Lock
agent.

TIME_PERIOD Set a duration for how long each group is allowed to send
messages to Safe Lock Intelligent Manager when that
group's message-sending cycle is active.

2. Install the Safe Lock Intelligent Manager using Windows Installer or the command
line interface (CLI) installer. For details, see Installing from Windows and Installation
Using the Command Line from the Trend Micro Safe Lock Intelligent Manager™
Installation Guide.
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Chapter 8

Local Agent Installation
This chapter describes local Trend Micro Safe Lock agent installation and setup
procedures.

Topics in this chapter include:

• Local Installation Overview on page 8-2

• Installing from Windows on page 8-2

• Setting Up the Approved List on page 5-2

• Installation Using the Command Line on page 8-11

• Customizing Installation Parameters on page 8-14
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Local Installation Overview
Trend Micro Safe Lock can be installed using either the Windows Installer or the
command line interface (CLI) installer.

Table 8-1. Safe Lock Local Installation Methods

Installation Method Benefits

Windows Installer The Windows Installer provides simplified step-by-step
installation wizard for first-time or single installation and is
also suitable for preparing for mass deployment for cloned
computer systems.

Command line interface
installer

The command line interface (CLI) installer provides silent
installation and can be integrated into a batch file for mass
deployment.

WARNING!
Depending on the installation method you select, Safe Lock versions require different
preparation before upgrading. See Agent Upgrade Preparation on page 1-17 for more
information.

To customize installations using either the Windows Installer or the command line
interface (CLI) installer, modify the Setup.ini file. See Customizing Installation Parameters on
page 8-14.

Installing from Windows
To install Trend Micro Safe Lock, you must log on using an account with administrator
privileges.

Procedure

1. Double-click SL_Install.exe.

If a User Account Control warning from Windows appears, click Yes.
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2. When the installation wizard opens, click Next.

Note
If there is another version of Safe Lock on the endpoint, the installer will remove it
before installing the latest version.

3. Read the license agreement, select I accept the terms in the License
Agreement, and click Next.

4. Make any necessary changes to the installation options, and click Next.

Important
Network Virus Protection can only be installed during the initial program installation,
but it can be disabled after installation, if necessary. See Exploit Prevention Settings in
the Administrator's Guide for more information.
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5. Provide the Activation Code and specify an administrator password for Trend
Micro Safe Lock.

Note
The password must be 8 to 64 alphanumeric characters. The following characters are
not supported: | > < \ " spaces. The Safe Lock administrator password is unrelated
to the Windows administrator password.
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WARNING!
Do not forget the Safe Lock administrator password. The only way to recover after
losing the Safe Lock administrator password is by reinstalling the operating system.

6. Click Next.
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A message appears asking if you would like to scan the endpoint for threats before
continuing with the installation.

7. Optionally, scan the endpoint for threats before continuing with the installation.
Trend Micro recommends you perform this scan.

• To scan the endpoint for threats, click Scan.

a. The Endpoint Prescan window appears.

b. To customize the scan settings, click Edit Scan Settings.

c. Click Scan Now.

If Endpoint Prescan detects security risks, Trend Micro recommends
canceling the installation. Remove threats from the endpoint and try
again. If critical programs are detected as threats, confirm that the
endpoint is secure and that the versions of the programs installed do not
contain threats. Ignore detected threats only if you are absolutely certain
that they are false positives.
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Tip
Trend Micro provides solutions for detecting and removing threats. For
endpoints with limited or no network access, Trend Micro recommends
using Trend Micro Portable Security. See Trend Micro Portable Security
Compatible on page 1-10. For more information about this and other
solutions from Trend Micro, go to http://trendmicro.com/.

• To skip scanning, click Do Not Scan.

8. When the Installation Complete window displays, click Finish.

Note
Optionally enable memory randomization on older operating systems such as
Windows XP or Windows Server 2003, which may lack or offer limited Address
Space Layout Randomization (ASLR) support. See Exploit Prevention Settings in the
Administrator's Guide for more information.

http://trendmicro.com/
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Setting Up the Approved List
Before Trend Micro Safe Lock can protect the endpoint, it must check the endpoint for
existing applications and installers necessary for the system to run correctly.

Procedure

1. Open the Safe Lock console.

The Safe Lock log on screen appears.

2. Provide the password and click Login.

Safe Lock asks if you want to set up the Approved List now.
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3. At the notification window, select Yes. Set up the Approved List now and click
OK.

Safe Lock scans the endpoint and adds all applications to the Approved List.
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Safe Lock displays the Approved List Configuration Results.

Note
When Trend Micro Safe Lock Application Lockdown is on, only applications that are
in the Approved List will be able to run.

4. Click Close.

Installation Using the Command Line
Administrators can install Safe Lock from the command line interface (CLI) or using a
batch file, allowing for silent installation and mass deployment. For mass deployment,
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Trend Micro recommends first installing Safe Lock on a test computer since a
customized installation may require a valid configuration file and Approved List. See the
Trend Micro Safe Lock Administrator's Guide for more information about the
Approved List and configuration file.

WARNING!

• Do not forget the Safe Lock administrator password. The only way to recover after
losing the Safe Lock administrator password is by reinstalling the operating system.

• Make sure to enable memory randomization on older operating systems such as
Windows XP or Windows Server 2003, which may lack or offer limited Address Space
Layout Randomization (ASLR) support. See Exploit Prevention Settings in the
Administrator's Guide for more information.

Important

Network Virus Protection can only be installed during the initial program installation, but it
can be disabled after installation, if necessary. See Exploit Prevention Settings in the
Administrator's Guide for more information.

Note

The password must be 8 to 64 alphanumeric characters. The following characters are not
supported: | > < \ " spaces. The Safe Lock administrator password is unrelated to the
Windows administrator password.

Installer Command Line Interface Parameters
The following table lists the commands available for SL_Install.exe.

Table 8-2. Safe Lock Intelligent Manager Installer Command Line Options

Parameter Value Description

-q Run the installer silently

-p <administrator_
password>

Specify the administrator password
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Parameter Value Description

-d <path> Specify the installation path

-ac <activation_cod
e>

Specify the activation code

-nd Do not create a desktop shortcut

-fw  Enable Network Virus Protection

-ns Do not add a shortcut to the Start menu

-ni Hide the task tray icon

-cp <path> Specify the Safe Lock configuration file

Note
The Safe Lock configuration file can be
exported after installing Safe Lock.

-lp <path> Specify the Approved List

Note
After installing Safe Lock and creating the
Approved List, the list can be exported.

-qp <path> Specify the folder path for quarantined files when
custom action is set to “quarantine” mode.

-nrca  Disable the Root Cause Analysis (RCA) report

-nps Do not execute Prescan

-ips Do not cancel installation when Prescan detects
threats

An example command line interface (CLI) install would look like this:

SL_Install.exe -q -ac XX-XXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX -p
P@ssW0Rd -nd
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Important

An administrator password and Activation Code must be specified for the installation to
continue.

Customizing Installation Parameters

Note

Arguments specified at the command line interface (CLI) take higher priority than the
setup file, which takes higher priority over the default values. For example, if the switch -
nd is added to SL_Install.exe, and setup.ini contains NO_DESKTOP=0, the switch
will take precedence, and a Safe Lock Intelligent Manager desktop shortcut will not be
created.

To change the default installation parameters using a Setup.ini file, follow the steps
below.

Procedure

1. Locate the Setup.ini file in the installation folder.

2. Customize the installation parameters as required.

For information on installation parameters and their possible values, see Setup.ini
File Arguments on page 8-15.

3. Optionally encrypt the Setup.ini file to prevent unauthorized access to important
settings.

a. From the installation folder, copy the Setup.ini file and the
WKSupportTool.exe file to your desktop.

b. Run a command prompt window as administrator.

c. Navigate to the desktop and type WKSupportTool.exe
encryptsetupini Setup.ini Setup.bin to encrypt the Setup.ini file
and name the encrypted file as "Setup.bin".
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d. Save the Setup.bin file in the installation folder and remove the Setup.ini file.

Setup.ini File Arguments

Note

Arguments specified at the command line interface (CLI) take higher priority than the
setup file, which takes higher priority over the default values. For example, if the switch -
nd is added to SL_Install.exe, and setup.ini contains NO_DESKTOP=0, the switch
will take precedence, and a Safe Lock Intelligent Manager desktop shortcut will not be
created.

The following tables list the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Property Section

The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-3. Setup.ini File [PROPERTY] Section Arguments

Key Description Possible Values Default
Value Encrypted

ACTIVATION_
CODE

Activation Code <activation_code> <empty> No

NO_DESKTOP Create a
shortcut on
desktop

• 0: Create
shortcut

• 1: Do not create
shortcut

0 No

NO_STARTMEN
U

Create a
shortcut in the
Start menu

• 0: Create
shortcut

• 1: Do not create
shortcut

0 No
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Key Description Possible Values Default
Value Encrypted

NO_SYSTRAY Display the
system tray
icon and
Windows
notifications

• 0: Create
system tray icon

• 1: Do not create
system tray icon

0 No

TITLE Title content for
pop-up
notifications

Text up to 64
characters

Application
Blocked

No

MESSAGE Message
content for pop-
up notifications

Text up to 200
characters

A program
has been
blocked by
Trend Micro
Safe Lock.
Please
contact your
help desk or
administrator.

No

FILEINFO Display the
name and path
of a blocked file
in the pop-up
notification

• 0: Disable

• 1: Enable

0 No

PASSWORD Authenticate
user identity by
requesting for
the
administrator
password
before closing a
pop-up
notification

• 0: Disable

• 1: Enable

0 No

NO_NSC Install firewall • 0: Create firewall

• 1: Do not create
firewall

0 No
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Key Description Possible Values Default
Value Encrypted

CONFIG_PATH Configuration
file path

<path> <empty> No

LIST_PATH Approved List
path for import

<path> <empty> No

APPLICATION
FOLDER

Installation path
for agent
program

<path> <empty> No

MANAGED_MOD
E

Specify if Safe
Lock is
managed by
the Safe Lock
Intelligent
Manager server

• 0: Standalone
mode

• 1: Managed
mode

0 No

PASSWORD Password
which is used
for SLCmd.exe
and Safe Lock
console

<password> <empty> No

CUSTOM_ACTI
ON

Custom action
for blocked
events

• 0: Ignore

• 1: Quarantine

• 2: Ask server

0 No

QUARANTINE_
FOLDER_PATH

Quarantine
path for agent
program

<path> <empty> No

ROOT_CAUSE_
ANALYSIS

Enable root
cause analysis
reporting

• 0: Disable

• Other value:
Enable

1 No

INTEGRITY_M
ONITOR

Enable Integrity
Monitor

• 0: Disable

• 1: Enable

0 No
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Key Description Possible Values Default
Value Encrypted

PREDEFINED_
TRUSTED_UPD
ATER

Enable
Predefined
Trusted
Updater

• 0: Disable

• 1: Enable

0 No

WINDOWS_UPD
ATE_SUPPORT

Enable Window
Update Support

• 0: Disable

• 1: Enable

0 No

PRESCAN Prescan the
endpoint before
installing Safe
Lock

• 0: Do not
prescan the
endpoint

• 1: Prescan the
endpoint

1 No

MAX_EVENT_D
B_SIZE

Maximum
database file
size (MB)

Positive integer 1024 No

WEL_SIZE Windows Event
Log size (KB)

Positive integer 1024 No

WEL_RETENTI
ON

Windows Event
Log option
when maximum
event log size
is reached on
Windows Event
Log.

For Windows XP or
earlier platforms:

• 0: Overwrite
events as
needed

• 1 - 365:
Overwrite events
older than
(1-365) days

• -1: Do not
overwrite events
(Clear logs
manually)

For Windows Vista or
later platforms:

0 No
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Key Description Possible Values Default
Value Encrypted

• 0: Overwrite
events as
needed (oldest
events first)

• 1: Archive the
log when full, do
not overwrite
events

• -1: Do not
overwrite events
(Clear logs
manually)

WEL_IN_SIZE Windows Event
Log size for
Integrity
Monitor events
(KB)

Positive integer 1024 No

WEL_IN_RETE
NTION

Windows Event
Log option
when maximum
event log size
for Integrity
Monitor events
is reached on
Windows Event
Log.

For Windows XP or
earlier platforms:

• 0: Overwrite
events as
needed

• 1 - 365:
Overwrite events
older than
(1-365) days

• -1: Do not
overwrite events
(Clear logs
manually)

For Windows Vista or
later platforms:

• 0: Overwrite
events as

0 No
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Key Description Possible Values Default
Value Encrypted

needed (oldest
events first)

• 1: Archive the
log when full, do
not overwrite
events

• -1: Do not
overwrite events
(Clear logs
manually)

USR_DEBUGLO
G_ENABLE

Enable debug
logging for user
sessions

• 0: Log

• 1: Do not log

0 No

USR_DEBUGLO
GLEVEL

The number of
debug log
entries allowed
for user
sessions

• 273 273 No

SRV_DEBUGLO
G_ENABLE

Enable debug
logging for
service
sessions.

• 0: Log

• 1: Do not log

0 No

SRV_DEBUGLO
GLEVEL

The number of
debug log
entries allowed
for service
sessions

• 273 273 No

SILENT_INST
ALL

Execute
installation in
silent mode

• 0: Do not use
silent mode

• 1: Use silent
mode

0 No
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Key Description Possible Values Default
Value Encrypted

Important
To use silent mode, you must
also specify the
ACTIVATION_CODE and
PASSWORD keys and values.
For example:

[PROPERTY]
ACTIVATION_CODE=XX-XXXX-XXX
XX-XXXXX-XXXXX-XXXXX-XXXXX
PASSWORD=P@ssW0Rd
SILENT_INSTALL=1

STORAGE_DEV
ICE_BLOCKIN
G

Blocks storage
devices,
including
CD/DVD drives,
floppy disks,
and network
drives, from
accessing
managed
endpoints.

• 0: Allow access
from storage
devices

• 1: Block access
from storage
devices

0 No

EventLog Section
The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-4. Setup.ini File [EVENTLOG] Section Arguments

Key Description Possible Values Default
Value Encrypted

ENABLE Log events
related to Safe
Lock

• 1: Log

• 0: Do not log

1 No
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Key Description Possible Values Default
Value Encrypted

LEVEL_WARNI
NGLOG

Log “Warning”
level events
related to Safe
Lock

• 1: Log

• 0: Do not log

1 No

LEVEL_INFOR
MATIONLOG

Log
“Information”
level events
related to Safe
Lock

• 1: Log

• 0: Do not log

0 No

BLOCKEDACCE
SSLOG

Log files
blocked by
Safe Lock

• 1: Log

• 0: Do not log

1 No

APPROVEDACC
ESSLOG

Log files
approved by
Safe Lock

• 1: Log

• 0: Do not log

1 No

APPROVEDACC
ESSLOG_TRUS
TEDUPDATER

Log Trusted
Updater
approved
access

• 1: Log

• 0: Do not log

1 No

APPROVEDACC
ESSLOG_DLLD
RIVER

Log DLL/Driver
approved
access

• 1: Log

• 0: Do not log

0 No

APPROVEDACC
ESSLOG_EXCE
PTIONPATH

Log Application
Lockdown
exception path
approved
access

• 1: Log

• 0: Do not log

1 No

APPROVEDACC
ESSLOG_TRUS
TEDCERT

Log Trusted
Certifications
approved
access

• 1: Log

• 0: Do not log

1 No
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Key Description Possible Values Default
Value Encrypted

APPROVEDACC
ESSLOG_WRIT
EPROTECTION

Log Write
Protection
approved
access

• 1: Log

• 0: Do not log

1 No

SYSTEMEVENT
LOG

Log events
related to the
system

• 1: Log

• 0: Do not log

1 No

SYSTEMEVENT
LOG_EXCEPTI
ONPATH

Log exceptions
to Application
Lockdown

• 1: Log

• 0: Do not log

1 No

SYSTEMEVENT
LOG_WRITEPR
OTECTION

Log Write
Protection
events

• 1: Log

• 0: Do not log

1 No

LISTLOG Log events
related to the
Approved list

• 1: Log

• 0: Do not log

1 No

USBMALWAREP
ROTECTIONLO
G

Log events that
trigger USB
Malware
Protection

• 1: Log

• 0: Do not log

1 No

EXECUTIONPR
EVENTIONLOG

Log events that
trigger
Execution
Prevention

• 1: Log

• 0: Do not log

1 No

NETWORKVIRU
SPROTECTION
LOG

Log events that
trigger Network
Virus Protection

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_FILECREATE
D

Log file and
folder created
events

• 1: Log

• 0: Do not log

1 No
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Key Description Possible Values Default
Value Encrypted

INTEGRITYMO
NITORINGLOG
_FILEMODIFI
ED

Log file
modified events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_FILEDELETE
D

Log file and
folder deleted
events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_FILERENAME
D

Log file and
folder renamed
events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_REGVALUEMO
DIFIED

Log registry
value modified
events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_REGVALUEDE
LETED

Log registry
value deleted
events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_REGKEYCREA
TED

Log registry key
created events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_REGKEYDELE
TED

Log registry key
deleted events

• 1: Log

• 0: Do not log

1 No

INTEGRITYMO
NITORINGLOG
_REGKEYRENA
MED

Log registry key
renamed
events

• 1: Log

• 0: Do not log

1 No
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Server Section
The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-5. Setup.ini File [SERVER] Section Arguments

Key Description Possible Values Default
Value Encrypted

HOSTNAME Server host
name

<host_name> <empty> No

PORT_FAST Server listen
port for fast
lane

1 - 65535 <empty> No

PORT_SLOW Server listen
port for slow
lane

1 - 65535 <empty> No

CERT Certificate file
name

<certificate_file_na
me>

<empty> No

API_KEY API key <API_key> <empty> No

Agent Section
The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-6. Setup.ini File [AGENT] Section Arguments

Key Description Possible Values Default
Value Encrypted

PORT Agent listening
port

1 - 65535 <empty> No

SSL_ALLOW_BE
AST

Handles
possible
security flaws
in SSL3 and

• 0: Protect
against BEAST
attacks

1 No
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Key Description Possible Values Default
Value Encrypted

TLS 1.0
protocols for
BEAST attacks

• 1: Do not
implement any
security
workarounds for
BEAST
vulnerabilities

POLL_SERVER Identify the
agent as an
NAT agent

• 0: Non-NAT
agent

• 1: NAT agent

0 No

POLL_SERVER_
INTERVAL

Set the NAT
connection
frequency

• 1 - 64800:
Connect to the
Safe Lock
Intelligent
Manager server
every (1 -
64800) minutes

10 No

Message Section
The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-7. Setup.ini File [MESSAGE] Section Arguments

Key Description Possible Values Default
Value Encrypted

REGISTER_TRI
GGER

Register
message
trigger

• 1: Immediately

• 2: On demand

1 No

UNREGISTER_T
RIGGER

Unregister
message
trigger

• 1: Immediately

• 2: On demand

1 No
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Key Description Possible Values Default
Value Encrypted

UPDATESTATUS
_TRIGGER

Update status
message
trigger

• 1: Immediately

• 2: On demand

1 No

UPLOADBLOCKE
DEVENT_TRIGG
ER

Upload blocked
event message
trigger

• 1: Immediately

• 2: On demand

1 No

CHECKFILEHAS
H_TRIGGER

Check file hash
message
trigger

• 1: Immediately

• 2: On demand

1 No

QUICKSCANFIL
E_TRIGGER

Quick scan file
message
trigger

• 1: Immediately

• 2: On demand

1 No

MessageRandomization Section

Note

Safe Lock agents respond as soon as possible to direct requests from Safe Lock Intelligent
Manager. For details, refer to Applying Message Time Groups in the Safe Lock Intelligent
Manager Administrator's Guide.

The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-8. Setup.ini File [MESSAGERANDOMIZATION] Section Arguments

Key Description Possible Values Default
Value Encrypted

TOTAL_GROUP_
NUM

Number of
groups
controlled by
the server

0 - 2147483647 0 No
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Key Description Possible Values Default
Value Encrypted

OWN_GROUP_IN
DEX

Index of group
which this
agent belongs
to

0 - 2147483647 0 No

TIME_PERIOD Maximum
amount of time
agents have to
upload data (in
seconds)

0 - 2147483647 0 No

Proxy Section

The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-9. Setup.ini File [PROXY] Section Arguments

Key Description Possible Values Default
Value Encrypted

MODE Proxy mode • 0: No proxy
used

• 1: Proxy used
with manual
settings

• 2: Proxy used
with settings
retrieved from
Internet
Explorer
automatically

0 No

HOSTNAME Proxy host name <host_name> <empty> No

PORT Proxy port 1 - 65535 <empty> No

USERNAME Proxy user name <user_name> <empty> No
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Key Description Possible Values Default
Value Encrypted

PASSWORD Proxy password <password> <empty> No

Prescan Section
The following table lists the commands available for setup.ini. If no value is
specified in the setup file, the default value will be used.

Table 8-10. Setup.ini File [PRESCAN] Section Arguments

Key Description Possible Values Default
Value Encrypted

IGNORE_THREA
T

Cancel
installation
after detecting
malware threat
during prescan

Note
Only
valid
during
silent
installati
ons.

• 0: Cancel

• 1: Continue
installation after
detecting
malware threat
during prescan

0 No

REPORT_FOLDE
R

An absolute
folder path
where prescan
result reports
are saved.

• <folder_path>

• <empty>:
Defaults to
%windir%\temp
\prescan\log

<empty> No

SCAN_TYPE The type of
scan executed
during silent
installation

• Full: Scan all
folders on the
endpoint.

Full No
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Key Description Possible Values Default
Value Encrypted

Note
The
selected
value is
used as
the
default
value for
a UI
installati
on.

• Quick: Scans
the following
folders:

• Fixed root
drives

For
example:

c:\

d:\

• System
root folder

For
example,
c:
\Windows

• System
folder

For
example,
c:
\Windows
\System

• System32
folder

For
example,
c:
\Windows
\System32

• Driver
folder

For
example,
c:
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Key Description Possible Values Default
Value Encrypted

\Windows
\System32
\Drivers

• Temp folder

For
example,
c:\Users
\Trend
\AppData
\Local
\Temp

• Desktop
folder
including
sub folders
and files

For
example,
c:\Users
\Trend
\Desktop

• Specific: Scan
folders specified
with
SPECIFIC_FOLD
ER entries

COMPRESS_LAY
ER

The number of
compressed
layers to scan
when a
compressed
file is scanned.

• 0: Do not scan
compressed
files

• 1 - 20: Scan up
to the specified
number of
layers of a
compressed file

2 No
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Key Description Possible Values Default
Value Encrypted

MAX_FILE_SIZ
E

The largest file
allowed for
scan

• 0: Scan files of
any sizes

• 1 - 9999: Only
scan files equal
to or smaller
than the
specified size
(MB)

0 No

SCAN_REMOVAB
LE_DRIVE

Scan
removable
drives

• 0: Do not scan
removable
drives

• 1: Scan
removable
drives

0 No

SPECIFIC_FOL
DER

An absolute
folder path to
scan when the
scan type is
[Specific]

<folder_path>

Multiple folders can
be specified by
creating new entries
whose name starting
with
SPECIFIC_FOLDER.
Every entry name
needs to be unique.

For example:

SPECIFIC_FOLDER=c
:\folder1

SPECIFIC_FOLDER2=
c:\folder2

SPECIFIC_FOLDER3=
c:\folder3

<empty> No

EXCLUDED_FIL
E

An absolute file
path to exclude
from scanning

<file_path>

Multiple files can be
specified by creating

<empty> No
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Key Description Possible Values Default
Value Encrypted

new entries whose
name starting with
EXCLUDED_FILE.
Every entry name
needs to be unique.

For example:

EXCLUDED_FILE=c:
\file1.exe

EXCLUDED_FILE2=c:
\file2.exe

EXCLUDED_FILE3=c:
\file3.exe

EXCLUDED_FOL
DER

An absolute
folder path to
exclude from
scanning

<folder_path>

Multiple folders can
be specified by
creating new entries
whose name starting
with
EXCLUDED_FOLDER.
Every entry name
needs to be unique.

For example:

EXCLUDED_FOLDER=c
:\file1.exe

EXCLUDED_FOLDER2=
c:\file2.exe

EXCLUDED_FOLDER3=
c:\file3.exe

<empty> No

EXCLUDED_EXT
ENSION

A file extension
to exclude from
scanning

<file_extension>

Multiple extensions
can be specified by
creating new entries
whose name starting

<empty> No
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Key Description Possible Values Default
Value Encrypted

with
EXCLUDED_EXTENSIO
N. Every entry name
needs to be unique.

For example:

EXCLUDED_EXTENSIO
N=bmp

EXCLUDED_EXTENSIO
N2=png

BlockNotification Section

The following table lists the notification commands available for setup.ini. If no
value is specified in the setup file, the default value will be used.

Important

To enable the feature, make sure to also enable the display for system tray icons and
notifications. See NO_SYSTRAY in this table for details.

Table 8-11. Setup.ini File [PRESCAN] Section Arguments

Key Description Possible
Values

Default
Value Encrypted

ENABLE Display notifications
on managed
endpoints when Safe
Lock Intelligent
Manager blocks an
unapproved file.

• 0: Disable

• 1: Enable

0 No

ALWAYS_ON_TO
P

Display the file
blocking notification
on top of other
screens.

• 0: Disable

• 1: Enable

1 No
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Key Description Possible
Values

Default
Value Encrypted

SHOW_DETAILS Display file name, file
path, and event time
in the notification.

• 0: Disable

• 1: Enable

1 No

AUTHENTICATE Authenticate the user
by requesting the
administrator
password when
closing the
notification.

• 0: Disable

• 1: Enable

1 No

TITLE Notification title <notification_titl
e>

<empty> No

MESSAGE Notification content <notification_co
ntent>

<empty> No
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Chapter 9

Working with the Agent Configuration
File

This chapter describes how to configure Trend Micro Safe Lock using the configuration
file.

Topics in this chapter include:

• Working with the Agent Configuration File on page 9-2
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Working with the Agent Configuration File
The configuration file allows administrators to create and deploy a single configuration
across multiple machines. See Exporting or Importing a Configuration File on page 9-2 for
more information.

Changing Advanced Settings
Some settings can only be changed though the configuration file using the command
line interface (CLI). See Using SLCmd at the Command Line Interface (CLI) on page 6-2 for
more information.

Procedure

1. Export the configuration file.

2. Decrypt the configuration file.

3. Edit the configuration file with Windows Notepad or another text editor.

Important
Safe Lock only supports configuration files in the UTF-8 file format.

Tip
To update multiple agents with shared settings, you may choose to only import the
modified settings.

4. Encrypt the edited configuration file.

5. Import the edited configuration file.

Exporting or Importing a Configuration File
Trend Micro Safe Lock encrypts the configuration file before export. Users must
decrypt the configuration file before modifying the contents.
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Procedure

1. Open the Trend Micro Safe Lock console using the desktop icon (if available) or
the Start menu by clicking All Programs > Trend Micro Safe Lock.

2. Provide the password and click Login.

3. Click the Settings menu item to access the Export/Import Configuration
section.

To export the configuration file as a database (.xen) file:

a. Click Export, and choose the location to save the file.

b. Provide a filename, and click Save.

To import the configuration file as a database (.xen) file:

a. Click Import, and locate the database file.

b. Select the file, and click Open.

Trend Micro Safe Lock overwrites the existing configuration settings with the
settings in the database file.

Configuration File Syntax
The configuration file uses the XML format to specify parameters used by Safe Lock.

Important

The configuration file only supports UTF-8 encoding.

Refer to the following example of the configuration file:

<?xml version="1.0" encoding="UTF-8"?>
<Configurations version="1.00.000" 
    xmlns:xsi="http://www.w3.org/2001/
    XMLSchema-instance" 
    xsi:noNamespaceSchemaLocation="WKConfig.xsd">
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    <Configuration>
        <AccountGroup>
            <Account 
                ID="{24335D7C-1204-43d1-9CBB-332D688C85B6}"
                Enable="no">
                <Password/>
            </Account>
        </AccountGroup>
        <UI>
            <SystemTaskTrayIcon Enable="yes"/>
        </UI>
        <Feature>
            <ApplicationLockDown LockDownMode="2">
                <WhiteList 
                RecentHistoryUnapprovedFilesLimit="50"/>
                <ScriptLockdown Enable="yes">
                    <Extension ID="bat">
                        <Interpreter>cmd.exe</Interpreter>
                    </Extension>
                    <Extension ID="cmd">
                        <Interpreter>cmd.exe</Interpreter>
                    </Extension>
                    <Extension ID="com">
                        <Interpreter>ntvdm.exe</Interpreter>
                    </Extension>
                    <Extension ID="dll">
                        <Interpreter>ntvdm.exe</Interpreter>
                    </Extension>
                    <Extension ID="drv">
                        <Interpreter>ntvdm.exe</Interpreter>
                    </Extension>
                    <Extension ID="exe">
                        <Interpreter>ntvdm.exe</Interpreter>
                    </Extension>
                    <Extension ID="js">
                        <Interpreter>cscript.exe</Interpreter>
                        <Interpreter>wscript.exe</Interpreter>
                    </Extension>
                    <Extension ID="msi">
                        <Interpreter>msiexec.exe</Interpreter>
                    </Extension>
                    <Extension ID="pif">
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                        <Interpreter>ntvdm.exe</Interpreter>
                    </Extension>
                    <Extension ID="ps1">
                        <Interpreter>powershell.exe
                        </Interpreter>
                    </Extension>
                    <Extension ID="sys">
                        <Interpreter>ntvdm.exe</Interpreter>
                    </Extension>
                    <Extension ID="vbe">
                        <Interpreter>cscript.exe</Interpreter>
                        <Interpreter>wscript.exe</Interpreter>
                    </Extension>
                    <Extension ID="vbs">
                        <Interpreter>cscript.exe</Interpreter>
                        <Interpreter>wscript.exe</Interpreter>
                    </Extension>
                </ScriptLockdown>
                <TrustedUpdater>
                    <PredefinedTrustedUpdater Enable="no">
                        <RuleSet/>
                    </PredefinedTrustedUpdater>
                    <WindowsUpdateSupport Enable="yes"/>
                </TrustedUpdater>
                <DllDriverLockDown Enable="yes"/>
                <ExceptionPath Enable="no">
                    <ExceptionPathList/>
                </ExceptionPath>
                <TrustedCertification Enable="yes"/>
                <TrustedHash Enable="no"/>
                <WriteProtection Enable="yes" ActionMode="1"
                ProtectApprovedList=”yes”/>
                <CustomAction ActionMode="0"/>
            </ApplicationLockDown>
            <UsbMalwareProtection Enable="yes" ActionMode="1"/>
            <DllInjectionPrevention Enable="yes" 
            ActionMode="1"/>
            <ApiHookingPrevention Enable="yes" ActionMode="1"/>
            <MemoryRandomization Enable="yes"/>
            <NetworkVirusProtection Enable="yes" 
            ActionMode="1"/>
            <IntegrityMonitoring Enable="yes"/>
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            <Log>
                <EventLog Enable="yes">
                    <Level>
                        <WarningLog Enable="yes" /> 
                        <InformationLog Enable="yes" /> 
                    </Level>
                    <BlockedAccessLog Enable="yes"/>
                    <ApprovedAccessLog Enable="yes">
                        <TrustedUpdaterLog Enable="yes"/>
                        <DllDriverLog Enable="yes"/>
                        <ExceptionPathLog Enable="yes"/>
                        <TrustedCertLog Enable="yes"/>
                        <TrustedHashLog Enable="yes"/>                
                        <WriteProtectionLog Enable="yes"/>
                    </ApprovedAccessLog>
                    <SystemEventLog Enable="yes">
                        <ExceptionPathLog Enable="yes"/>
                        <WriteProtectionLog Enable="yes"/>
                    </SystemEventLog>
                    <ListLog Enable="yes"/>
                    <UsbMalwareProtectionLog Enable="yes"/>
                    <ExecutionPreventionLog Enable="yes"/>
                    <NetworkVirusProtectionLog Enable="yes"/>
                    <IntegrityMonitoringLog>
                        <FileCreatedLog Enable="yes"/>
                        <FileModifiedLog Enable="yes"/>
                        <FileDeletedLog Enable="yes"/>
                        <FileRenamedLog Enable="yes"/>
                        <RegValueModifiedLog Enable="yes"/>
                        <RegValueDeletedLog Enable="yes"/>
                        <RegKeyCreatedLog Enable="yes"/>
                        <RegKeyDeletedLog Enable="yes"/>
                        <RegKeyRenamedLog Enable="yes"/>
                    </IntegrityMonitoringLog>
                </EventLog>
                <DebugLog Enable="no"/>
            </Log>
        </Feature>
        <ManagedMode Enable="yes">
            <Agent>
                <Port/>
                <SslAllowBeast>1</SslAllowBeast>
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            </Agent>
            <Server>
                <HostName/>
                <FastPort/>
                <SlowPort/>
                <ApiKey/>
            </Server>
            <Message>
                <Register Trigger="1"/>
                <Unregister Trigger="1"/>
                <UpdateStatus Trigger="1"/>
                <UploadBlockedEvent Trigger="1"/>
                <CheckFileHash Trigger="1"/>
                <QuickScanFile Trigger="1"/>
            </Message>
            <MessageRandomization TotalGroupNum="1" 
            OwnGroupIndex="0"
                TimePeriod="0"/>
            <Proxy Mode="0">
                <HostName/>
                <Port/>
                <UserName/>
                <Password/>
            </Proxy>
        </ManagedMode>
    </Configuration>
    <Permission>
        <AccountRef 
        ID="{24335D7C-1204-43d1-9CBB-332D688C85B6}">
            <UIControl ID="DetailSetting" State="no"/>
            <UIControl ID="LockUnlock" State="yes"/>
            <UIControl ID="LaunchUpdater" State="yes"/>
            <UIControl ID="RecentHistoryUnapprovedFiles"
                 State="yes"/>
            <UIControl ID="ImportExportList" State="yes"/>
            <UIControl ID="ListManagement" State="yes"/>
        </AccountRef>
    </Permission>
</Configurations>
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Configuration File Parameters
The configuration file contains sections that specify parameters used by Safe Lock.

Table 9-1. Configuration File Sections and Descriptions

Section Description Additional
Information

Configuration Container for the
Configuration section

 AccountGroup Parameters to
configure the
Restricted User
account

See AccountGroup
Section on page 9-10.

See Account Types on
page 5-17.

 UI Parameters to
configure the display of
the system tray icon

See UI Section on
page 9-10.

 Feature Container for the
Feature section
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Section Description Additional
Information

  ApplicationLockDown Parameters to
configure Safe Lock
features and functions

See Feature Section on
page 9-13.

  UsbMalwareProtectio
n

  DllInjectionPrevent
ion

  ApiHookingPreventio
n

  MemoryRandomization

  NetworkVirusProtect
ion

  IntegrityMonitoring

  StorageDeviceBlocki
ng

A parameter to control
storage device access
to managed endpoints

  Log Parameters to
configure individual log
types

See Log Section on
page 9-24.

See Agent Event Log
Descriptions on page
13-4.

 ManagedMode Parameters to
configure Centralized
Management functions

See ManagedMode
Section on page 9-28.

Permission Container for the
Permission section

 

 AccountRef Parameters to
configure the Safe Lock
console controls
available to the
Restricted User
account

See AccountRef
Section on page 9-32.

See Account Types on
page 5-17.
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AccountGroup Section
Parameters to configure the Restricted User account

See Account Types on page 5-17.

Table 9-2. Configuration File AccountGroup Section Parameters

Parameter Setting Value Description

Configuration   Container for the Configuration
section

 AccountGroup   Container for the AccountGroup
section

 Account ID <GUID> Restricted User account GUID

Enable yes Enable the Restricted User account

no Disable the Restricted User
account

Password <Safe_Lock
_password>

Password for the Restricted User
account to access the Safe Lock
console

Note
The Safe Lock administrator
and Restricted User
passwords cannot be the
same.

UI Section
Parameters to configure the display of the system tray icon
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Table 9-3. Configuration File UI Section Parameters

Parameter Setting Value Description

Configuration   Container for the
Configuration section
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Parameter Setting Value Description

 UI   Container for the UI section

 SystemTrayIcon Enable yes Display the system tray icon
and Windows notifications

no Hide the system tray icon and
Windows notifications

 BlockNotifi
cation

Enable yes Display a notification on the
managed endpoint when a file
not specified in the agent
Approved List is blocked.

no Do not display any
notifications on the managed
endpoint when files not
specified in the agent
Approved List are blocked.

Authenti
cate

yes Prompt for the administrator
password when the user
attempts to close the
notification.

no Password is not required to
close the notification.

ShowDeta
ils

yes Show file path of the blocked
file and the event time.

no Do not show event details.

AlwaysOn
Top

yes Keep the notification on top of
any other screen.

no Allow other screens to cover
the notification.

Title <Title> Specify the title for the
notification.

Message <Messag
e>

Specify the message for the
notification.
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Feature Section

Parameters to configure Safe Lock features and functions

See About Feature Settings on page 5-19.

Table 9-4. Configuration File Feature Section Parameters

Parameter Setting Value Description

Configuration   Container for the
Configuration section

 Feature   Container for the Feature
section

 ApplicationLockDown LockDown
Mode

1 Turn on Application
Lockdown

2 Turn off Application
Lockdown

 WhiteList RecentHi
storyUna
pprovedF
ilesLimi
t

0 - 65535 Maximum number of entries
in the Blocked Files log

ScriptLockDown Enable yes Enable Script Lockdown

no Disable Script Lockdown

 Extension ID <file_exte
nsion>

File extension for Script
Lockdown to block

For example, specify a
value of MSI to block .msi
files.

 Interpreter  <file_nam
e>

Interpreter for the specified
file extension

For example, specify
msiexec.exe as the
interpreter for .msi files.
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Parameter Setting Value Description

TrustedUpdater   Container for the
TrustedUpdater section

 PredefinedTrustedU
pdater

Enable yes Enable Trusted Updater

no Disable Trusted Updater

 RuleSet   Container for RuleSet
conditions

 Condition ID <unique_
ruleset_n
ame>

Unique name for the set of
rules

 ApprovedLi
stCheck

Enable yes Enable hash checks for
Trusted Updaters

no Disable hash checks for
Trusted Updaters

ParentProc
ess

Path <process
_path>

Path of the parent process
to add to the Trusted
Updater List

Exception Path <process
_path>

Path to exclude from the
Trusted Updater List

Rule Label <unique_
rule_nam
e>

Unique name for this rule

 Updater Type process Use the specified EXE file

file Use the specified MSI or
BAT file

folder Use the EXE, MSI or BAT
files in the specified folder

folderan
dsub

Use the EXE, MSI or BAT
files in the specified folder
and its subfolders
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Parameter Setting Value Description

Path <updater
_path>

Updater path

Conditio
nRef

<conditio
n_ID>

Condition ID to provide a
more detailed rule for the
updater

WindowsUpdateSu
pport

Enable yes Allow Windows Update to
run on the managed
endpoint when it is locked
down.

no Block Windows Update on
the managed endpoint
when it is locked down.

DLLDriverLockdown Enable yes Enable DLL/Driver
Lockdown

no Disable DLL/Driver
Lockdown

ExceptionPath Enable yes Enable exception paths

no Disable exception paths

 ExceptionPathList   Container for the Exception
List

 ExceptionPath Path <exceptio
n_path>

Exception path

Type file Use only the specified file

folder Use the files in the specified
folder

folderan
dsub

Use the files in the specified
folder and its subfolders

TrustedCertification Enable yes Enable using Trusted
Certifications
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Parameter Setting Value Description

no Disable using Trusted
Certifications

 PredefinedTrustedC
ertification

Type updater File signed by this
certificate is treated as a
Trusted Updater

lockdown File signed by this
certificate is not treated as
a Trusted Updater

Hash <SHA-1_
hash_val
ue>

SHA1-hash value of this
certificate

Label <label> Description of this
certificate

Subject <subject> Subject of this certificate

Issuer <issuer> Issuer of this certificate

TrustedHash Enable yes Enable using the Trusted
Hash List

no Disable using the Trusted
Hash List

 PredefinedTrustedH
ash

Type updater File matched by this hash
value is treated as a
Trusted Updater

lockdown File matched by this hash
value is not treated as a
Trusted Updater

Hash <SHA-1_
hash_val
ue>

SHA-1 hash value of this
file

Label <label> Description of this file
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Parameter Setting Value Description

AddToApp
rovedLis
t

yes Add the file matched by this
hash value to the Approved
List when it is accessed for
the first time

no Do not add the file matched
by this hash value to the
Approved List

Path <file_path
>

File path

Note <note> Add a note for the file
matched by this hash value

WriteProtection Enable yes Enable Write Protection

no Disable Write Protection

ActionMo
de

0 Allow actions such as edit,
rename, and delete

1 Block actions such as edit,
rename, and delete

ProtectA
pprovedL
ist

yes Enable protection of the
Approved List (in addition to
the Write Protection List)
when Write Protection is
enabled

no Disable protection of the
Approved List (in addition to
the Write Protection List)
when Write Protection is
enabled

 List   Container for the Write
Protection List

 File Path <file_path
>

File path
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Parameter Setting Value Description

Folder Path <folder_p
ath>

Folder path

IncludeS
ubfolder

yes Use the files in the specified
folder and its subfolders

no Use the files in the specified
folder

RegistryKey Key <reg_key
>

Registry key

<reg_key> can be
abbreviated or expanded as
shown below:

• HKEY_LOCAL_MACHI
NE\test

HKLM\test

• HKEY_CURRENT_CO
NFIG\test

HKCC\test

• HKEY_CLASSES_RO
OT\test

HKCR\test

• HKEY_CURRENT_US
ER\test

HKCU\test

• HKEY_USERS\test

HKU\test

IncludeS
ubkey

yes Include any subkeys

no Do not include any subkeys

RegistryValue Key <reg_key
>

Registry key
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Parameter Setting Value Description
<reg_key> can be
abbreviated or expanded as
shown below:

• HKEY_LOCAL_MACHI
NE\test

HKLM\test

• HKEY_CURRENT_CO
NFIG\test

HKCC\test

• HKEY_CLASSES_RO
OT\test

HKCR\test

• HKEY_CURRENT_US
ER\test

HKCU\test

• HKEY_USERS\test

HKU\test

Name <reg_val
ue_name
>

Registry value name

ExceptionList   Container for the Write
Protection Exception List

 Process Path <process
_path>

Path of the process

File Path <file_path
>

File path

Folder Path <folder_p
ath>

Folder path

IncludeS
ubfolder

yes Use the files in the specified
folder and its subfolders
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Parameter Setting Value Description

no Use the files in the specified
folder

RegistryKey Key <reg_key
>

Registry key

<reg_key> can be
abbreviated or expanded as
shown below:

• HKEY_LOCAL_MACHI
NE\test

HKLM\test

• HKEY_CURRENT_CO
NFIG\test

HKCC\test

• HKEY_CLASSES_RO
OT\test

HKCR\test

• HKEY_CURRENT_US
ER\test

HKCU\test

• HKEY_USERS\test

HKU\test

IncludeS
ubkey

yes Include any subkeys

no Do not include any subkeys

RegistryValue Key <reg_key
>

Registry key

<reg_key> can be
abbreviated or expanded as
shown below:

• HKEY_LOCAL_MACHI
NE\test

HKLM\test
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Parameter Setting Value Description
• HKEY_CURRENT_CO

NFIG\test

HKCC\test

• HKEY_CLASSES_RO
OT\test

HKCR\test

• HKEY_CURRENT_US
ER\test

HKCU\test

• HKEY_USERS\test

HKU\test

Name <reg_val
ue_name
>

Registry value name

CustomAction ActionMo
de

0 Ignore blocked files or
processes when Application
Lockdown blocks any of the
following events:

• Process launch

• DLL loading

• Script file access

1 Quarantine blocked files or
processes when Application
Lockdown blocks any of the
following events:

• Process launch

• DLL loading

• Script file access

2 Ask what to do for blocked
files or processes when
Application Lockdown
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Parameter Setting Value Description
blocks any of the following
events:

• Process launch

• DLL loading

• Script file access

UsbMalwareProtection Enable yes Enable USB Malware
Protection

no Disable USB Malware
Protection

ActionMo
de

0 Allow action by detected
malware

1 Block action by detected
malware

DllInjectionPrevention Enable yes Enable DLL Injection
Prevention

no Disable DLL Injection
Prevention

ActionMo
de

0 Allows DLL injections

1 Blocks DLL injections

ApiHookingPrevention Enable yes Enable API Hooking
Prevention

no Disable API Hooking
Prevention

ActionMo
de

0 Allow API hooking

1 Block API hooking

MemoryRandomization Enable yes Enable Memory
Randomization
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Parameter Setting Value Description

no Disable Memory
Randomization

NetworkVirusProtection Enable yes Enable Network Virus
Protection

no Disable Network Virus
Protection

ActionMo
de

0 Allow action by detected
network viruses

1 Block action by detected
network viruses

IntegrityMonitoring Enable yes Enable Integrity Monitoring

no Disable Integrity Monitoring

StorageDeviceBlocking Enable yes Blocks access of storage
devices (CD/DVD drives,
floppy disks, and network
drives) to managed
endpoints

Disable no Allows access of storage
devices (CD/DVD drives,
floppy disks, and network
drives) to managed
endpoints

ActionMo
de

0 Allow actions such as edit,
rename, and delete

 1 Block actions such as edit,
rename, and delete

Log  Container for configuring
logs

See Log Section on page
9-24.
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Log Section

Parameters to configure individual log types

See Agent Event Log Descriptions on page 13-4.

Table 9-5. Configuration File Log Section Parameters

Parameter Setting Value Description

Configuration   Container for the Configuration
section

 Feature   Container for the Feature
section

 Log   Container for configuring logs

 EventLog Enable yes Log the Safe Lock events
specified in the following
elements

no Do not log the Safe Lock
events specified in the
following elements

 Level   Container for configuring log
levels

 WarningLo
g

Enable yes Log “Warning” level events
related to Safe Lock

no Do not log “Warning” level
events related to Safe Lock

Informati
onLog

Enable yes Log “Information” level events
related to Safe Lock

no Do not log “Information” level
events related to Safe Lock

BlockedAcces
sLog

Enable yes Log files blocked by Safe Lock

no Do not log files blocked by
Safe Lock
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Parameter Setting Value Description

ApprovedAcce
ssLog

Enable yes Log files approved by Safe
Lock

no Do not log files approved by
Safe Lock

 TrustedUp
daterLog

Enable yes Log Trusted Updater approved
access

no Do not log Trusted Updater
approved access

DLLDriver
Log

Enable yes Log DLL/Driver approved
access

no Do not log DLL/Driver
approved access

Exception
PathLog

Enable yes Log Application Lockdown
exception path approved
access

no Do not log Application
Lockdown exception path
approved access

TrustedCe
rtLog

Enable yes Log Trusted Certifications
approved access

no Do not log Trusted
Certifications approved access

WriteProt
ectionLog

Enable yes Log Write Protection approved
access

no Do not log Write Protection
approved access

SystemEventL
og

Enable yes Log events related to the
system

no Do not log events related to the
system
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Parameter Setting Value Description

 Exception
PathLog

Enable yes Log exceptions to Application
Lockdown

no Do not log exceptions to
Application Lockdown

WriteProt
ectionLog

Enable yes Log Write Protection events

no Do not log Write Protection
events

ListLog Enable yes Log events related to the
Approved list

no Do not log events related to the
Approved list

USBMalwarePr
otectionLog

Enable yes Log events that trigger USB
Malware Protection

no Do not log events that trigger
USB Malware Protection

ExecutionPre
ventionLog

Enable yes Log events that trigger
Execution Prevention

no Do not log events that trigger
Execution Prevention

NetworkVirus
ProtectionLo
g

Enable yes Log events that trigger Network
Virus Protection

no Do not log events that trigger
Network Virus Protection

IntegrityMon
itoringLog

  Container for configuring
Integrity Monitoring logs

 FileCreat
edLog

Enable yes Log file and folder created
events

no Do not log file and folder
created events
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Parameter Setting Value Description

FileModif
iedLog

Enable yes Log file modified events

no Do not log file modified events

FileDelet
edLog

Enable yes Log file and folder deleted
events

no Do not log file and folder
deleted events

FileRenam
edLog

Enable yes Log file and folder renamed
events

no Do not log file and folder
renamed events

RegValueM
odifiedLo
g

Enable yes Log registry value modified
events

no Do not log registry value
modified events

RegValueD
eletedLog

Enable yes Log registry value deleted
events

no Do not log registry value
deleted events

RegKeyCre
atedLog

Enable yes Log registry key created events

no Do not log registry key created
events

RegKeyDel
etedLog

Enable yes Log registry key deleted events

no Do not log registry key deleted
events

RegKeyRen
amedLog

Enable yes Log registry key renamed
events

no Do not log registry key
renamed events
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Parameter Setting Value Description

DeviceControlL
og

Enable yes Log storage device control
events.

no Do not log storage device
control events.

DebugLog Enable yes Log debugging information

no Do not log debugging
information

ManagedMode Section

Parameters to configure Centralized Management functions

Table 9-6. Configuration File ManagedMode Section Parameters

Parameter Setting Value Description

Configuration   Container for the
Configuration section

 ManagedMode Enable yes Enable managed mode

no Disable managed mode

 Agent   Container for configuring
Safe Lock agents

 Port  <server_mess
ages_port>

Specify the secure port
for server
communications
(formerly the agent
listening port)

SslAllowBeast  0 Allow upload of large
files (>10MB) on
Windows Server 2008
platforms

1 Prevent the
unsuccessful upload of
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Parameter Setting Value Description
large files (>10MB) on
Windows Server 2008
platforms (default value)

Server   Container for configuring
Safe Lock Intelligent
Manager

 HostName  <hostname> Specify the host name of
the Intelligent Manager
server

FastPort  <logs_port> Specify secure port for
collecting logs and
status (formerly Fast
Lane)

SlowPort  <files_port> Specify secure port for
collecting files for
scanning (formerly Slow
Lane)

ApiKey  <API_key> Specify API key

Message   Container for configuring
automated messages to
Safe Lock Intelligent
Manager

 Register Trigger 1 Send as soon as
possible after the event
occurs

2 Do not send unless
requested to by
Intelligent Manager

Unregister Trigger 1 Send as soon as
possible after the event
occurs
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Parameter Setting Value Description

2 Do not send unless
requested to by
Intelligent Manager

UpdateStatus Trigger 1 Send as soon as
possible after the event
occurs

2 Do not send unless
requested to by
Intelligent Manager

UploadBlockedEve
nt

Trigger 1 Send as soon as
possible after the event
occurs

2 Do not send unless
requested to by
Intelligent Manager

CheckFileHash Trigger 1 Send as soon as
possible after the event
occurs

2 Do not send unless
requested to by
Intelligent Manager

QuickScanFile Trigger 1 Send as soon as
possible after the event
occurs

2 Do not send unless
requested to by
Intelligent Manager

MessageRandomization
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Parameter Setting Value Description

Note
Safe Lock agents respond as soon as possible to direct requests from Safe
Lock Intelligent Manager. For details, refer to Applying Message Time
Groups in the Safe Lock Intelligent Manager Administrator's Guide.

 TotalGroup
Num

Positive
Integer (>= 1)

Specify the total number
of message time groups

OwnGroupIn
dex

Zero or
Positive
Integer, <
TotalGroupNu
m

Specify the message
time group ID number of
this Safe Lock agent

TimePeriod Zero or
Positive
Integer

Specify the duration of
time in whole seconds
that this message time
group ID number will
send automated
messages to Intelligent
Manager when this
group's message-
sending cycle is active

Note
Message time
groups do not
become active if
their duration is
set to zero (0).

Proxy Mode 0 Do not use a proxy
(direct access)

1 Use a proxy (manual
setting)

2 Synchronize proxy
settings with Internet
Explorer
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Parameter Setting Value Description

 HostName  <proxy_hostna
me>

Specify the proxy host
name

Port  <proxy_port> Specify the proxy port
number

UserName  <proxy_user_
name>

Specify the proxy user
name

Password  <proxy_passw
ord>

Specify the proxy
password

AccountRef Section
Parameters to configure the Safe Lock console controls available to the Restricted User
account

See Account Types on page 5-17.

Table 9-7. Configuration File AccountRef Section Parameters

Parameter Setting Value Description

Configuration   Container for the Configuration
section

 Permission   Container for the Permission
section

 AccountRef   Container for the AccountRef
section

 UIControl ID DetailSett
ing

Access the features and functions
on the Safe Lock console
Settings page
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Parameter Setting Value Description

Note
The Password page is not
available to the Restricted
User account.

LockUnlock Access the Application Lockdown
setting on the Overview screen

LaunchUpda
ter

Access the Automatically add
files created or modified by the
selected application installer
option when a Restricted User
clicks Add Item on the Approved
List screen

RecentHist
oryUnappro
vedFIles

Access the Block logs if a
Restricted User clicks Last
application blocked on the
Overviewscreen

ImportExpo
rtList

Access the Import List and
Export List buttons

ListManage
ment

Access the following items on the
Approved List screen:

• The Delete Item button

• The Update Hash button

• The Add Item > Add Files/
Folders menu

State yes Enable the permission specified
by ID

no Disable the permission specified
by ID
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Chapter 10

Local Agent Uninstallation
This chapter describes Trend Micro Safe Lock agent uninstallation procedures.

Topics in this chapter include:

• Uninstalling Agents from Windows on page 10-2
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Uninstalling Agents from Windows

Note

The Safe Lock administrator password is required to uninstall the software from the
endpoint.

Procedure

1. On an endpoint with the Safe Lock agent installed, launch Trend Micro Safe Lock
Setup.

Depending on your operating system, do one of the following:

Option Description

If you use one of the following operating
systems:

• Windows Server 2012

• Windows Server 2008

• Windows 10 Enterprise

• Windows 10 IoT Enterprise

• Windows 8

• Windows 7

• Windows Vista

a. Go to Start > Control Panel >
Prorgrams and Features.

b. In the list, double-click Trend Micro
Safe Lock.

If you use one of the following operating
systems:

• Windows Server 2003

• Windows XP

• Windows 2000

a. Go to Start > Control Panel > Add
or Remove Programs.

b. In the list, select Trend Micro Safe
Lock.

c. Click Remove.

Safe Lock Setup opens in uninstaller mode.

2. After Safe Lock Setup opens, click Next.
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3. Provide the Safe Lock administrator password, and click Next.

4. After the software is finished uninstalling, click Finish.
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Chapter 11

Troubleshooting & FAQs
This chapter provides a list of resources you can use to troubleshoot Trend MicroSafe
Lock Intelligent Manager issues.

Topics in this chapter include:

• Troubleshooting Remote Agent Installations on page 11-2
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Troubleshooting Remote Agent Installations
Remote installations performed using the SLrst command line interface (CLI) program
may result in the following messages:

Unable to Run: The network or firewall is not correctly configured or a version of Safe
Lock earlier than 1.1 is installed. Check configurations and remove older versions of
Safe Lock from the target endpoint, then run Setup again.

Went Offline: The endpoint went offline while Setup was running. The tool is unable to
determine if the installation completed successfully. If the endpoint appears in the
Intelligent Manager web console, the installation was completed successfully. If the
endpoint does not appear, then check the endpoint locally.

Frequently Asked Questions

Is a reboot required after installation or uninstallation?
Safe Lock agents do not required reboot after installation except for the following
scenarios.

Scenario Type Scenario

Setting Changes When the Memory Randomization setting is configured and
changed, the managed endpoints require a reboot to apply the
change.

Installation When Safe Lock detects a third-party program during its
installation and then uninstalls the program, a reboot is required
before continuing with the installation.

Installation When a firewall module requests for a reboot during Safe Lock
installation, a reboot is required before continuing with the
installation.

Uninstallation When Safe Lock agents are uninstalled using the Diagnostic
Toolkit, a reboot is required before re-installing Safe Lock agents.
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How to migrate Safe Lock agents to another Intelligent
Manager?

Procedure

1. Collect the agent configuration file by exporting and importing from an existing
agent.

For detailed steps, see Exporting or Importing a Configuration File on page 9-2.

2. In the exported configuration file, specify the target Intelligent Manager by
configuring the <Server> parameters under ManagedMode.

3. Encrypt the configuration file with the following command:

<TMSL>\SLCmd.exe encrypt managedmodeconfigurationtest.xml
test.xen

4. Import the encrypted configuration file and the certificate to Intelligent Manager
with the following command:

<TMSL>\SLCmd.exe set managedmode enable -cfg test.xen -sc
trend.cer
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Chapter 12

Technical Support
Learn about the following topics:

• Troubleshooting Resources on page 12-2

• Contacting Trend Micro on page 12-3

• Sending Suspicious Content to Trend Micro on page 12-4

• Other Resources on page 12-5
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Troubleshooting Resources
Before contacting technical support, consider visiting the following Trend Micro online
resources.

Using the Support Portal
The Trend Micro Support Portal is a 24x7 online resource that contains the most up-to-
date information about both common and unusual problems.

Procedure

1. Go to http://esupport.trendmicro.com.

2. Select from the available products or click the appropriate button to search for
solutions.

3. Use the Search Support box to search for available solutions.

4. If no solution is found, click Contact Support and select the type of support
needed.

Tip

To submit a support case online, visit the following URL:

http://esupport.trendmicro.com/srf/SRFMain.aspx

A Trend Micro support engineer investigates the case and responds in 24 hours or
less.

Threat Encyclopedia
Most malware today consists of blended threats, which combine two or more
technologies, to bypass computer security protocols. Trend Micro combats this complex
malware with products that create a custom defense strategy. The Threat Encyclopedia

http://esupport.trendmicro.com
http://esupport.trendmicro.com/srf/SRFMain.aspx
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provides a comprehensive list of names and symptoms for various blended threats,
including known malware, spam, malicious URLs, and known vulnerabilities.

Go to http://about-threats.trendmicro.com/us/threatencyclopedia#malware to learn
more about:

• Malware and malicious mobile code currently active or "in the wild"

• Correlated threat information pages to form a complete web attack story

• Internet threat advisories about targeted attacks and security threats

• Web attack and online trend information

• Weekly malware reports

Contacting Trend Micro
In the United States, Trend Micro representatives are available by phone or email:

Address Trend Micro, Incorporated

225 E. John Carpenter Freeway, Suite 1500

Irving, Texas 75062 U.S.A.

Phone Phone: +1 (817) 569-8900

Toll-free: (888) 762-8736

Website http://www.trendmicro.com

Email address support@trendmicro.com

• Worldwide support offices:

http://www.trendmicro.com/us/about-us/contact/index.html

• Trend Micro product documentation:

http://docs.trendmicro.com

http://about-threats.trendmicro.com/us/threatencyclopedia#malware
http://www.trendmicro.com
mailto:support@trendmicro.com
http://www.trendmicro.com/us/about-us/contact/index.html
http://docs.trendmicro.com
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Speeding Up the Support Call

To improve problem resolution, have the following information available:

• Steps to reproduce the problem

• Appliance or network information

• Computer brand, model, and any additional connected hardware or devices

• Amount of memory and free hard disk space

• Operating system and service pack version

• Version of the installed agent

• Serial number or Activation Code

• Detailed description of install environment

• Exact text of any error message received

Sending Suspicious Content to Trend Micro
Several options are available for sending suspicious content to Trend Micro for further
analysis.

Email Reputation Services

Query the reputation of a specific IP address and nominate a message transfer agent for
inclusion in the global approved list:

https://ers.trendmicro.com/

Refer to the following Knowledge Base entry to send message samples to Trend Micro:

http://esupport.trendmicro.com/solution/en-US/1112106.aspx

https://ers.trendmicro.com/
http://esupport.trendmicro.com/solution/en-US/1112106.aspx
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File Reputation Services

Gather system information and submit suspicious file content to Trend Micro:

http://esupport.trendmicro.com/solution/en-us/1059565.aspx

Record the case number for tracking purposes.

Web Reputation Services

Query the safety rating and content type of a URL suspected of being a phishing site, or
other so-called "disease vector" (the intentional source of Internet threats such as
spyware and malware):

http://global.sitesafety.trendmicro.com/

If the assigned rating is incorrect, send a re-classification request to Trend Micro.

Other Resources
In addition to solutions and support, there are many other helpful resources available
online to stay up to date, learn about innovations, and be aware of the latest security
trends.

Download Center

From time to time, Trend Micro may release a patch for a reported known issue or an
upgrade that applies to a specific product or service. To find out whether any patches
are available, go to:

http://www.trendmicro.com/download/

If a patch has not been applied (patches are dated), open the Readme file to determine
whether it is relevant to your environment. The Readme file also contains installation
instructions.

http://esupport.trendmicro.com/solution/en-us/1059565.aspx
http://global.sitesafety.trendmicro.com/
http://www.trendmicro.com/download/
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Documentation Feedback
Trend Micro always seeks to improve its documentation. If you have questions,
comments, or suggestions about this or any Trend Micro document, please go to the
following site:

http://www.trendmicro.com/download/documentation/rating.asp

http://www.trendmicro.com/download/documentation/rating.asp
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Chapter 13

Appendix: Reference
This Installation Guide introduces Trend Micro Safe Lock Intelligent Manager and
guides administrators through installation and deployment.

Topics in this chapter include:

• Enabling Local Administrator Accounts on page 13-2

• Enabling Local Accounts for Default Shares on page 13-3

• Agent Event Log Descriptions on page 13-4

• Agent Error Code Descriptions on page 13-26
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Enabling Local Administrator Accounts
Windows NT Version 6.x (Windows Vista, Windows 7, Windows 8, Windows 8.1,
Windows Server 2008 and Windows Server 2012) requires special steps to allow you to
use local Windows administrator accounts.

Procedure

1. Open Computer Management.

a. Open the Start menu.

b. Right-click Computer.

c. Go to Manage.

The Computer Management window appears.

2. In the list on the left, go to Computer Management > System Tools > Local
Users and Groups > Users.

The list of local Windows user accounts displays.

3. In the list of user accounts, right-click Administrator, then go to Properties.

The Administrator Properties window appears.

4. In the General tab, clear Account is disabled.

5. Click OK.

The Computer Management window reappears, displaying the list of local
Windows user accounts.

6. Right-click Administrator, then go to Set Password....

A message displays instructions for setting the password.

7. Set the password.

8. Exit Computer Management.
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Enabling Local Accounts for Default Shares
Windows NT Version 6.x, Windows Vista, Windows 7, Windows 8, Windows 8.1,
Windows 10, Windows Server 2008, and Windows Server 2012 require special steps to
allow local Windows administrator accounts to access default shares, for example the
default share admin$.

Tip

Steps vary depending on your Windows version. For specific instructions and help for your
Windows version, refer to the Microsoft Knowledgebase at http://msdn.microsoft.com.

Procedure

1. Open Registry Editor (regedit.exe).

a. Go to Start > Run

b. Type regedit, then press ENTER.

2. Locate and click the following registry subkey:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
\CurrentVersion\Policies\System

3. Locate the LocalAccountTokenFilterPolicy registry entry.

If the registry entry does not exist, follow these steps:

a. Go to Edit > New.

b. Select DWORD Value.

c. Type LocalAccountTokenFilterPolicy, then press ENTER.

4. Right-click LocalAccountTokenFilterPolicy, then go to Modify.

5. In the Valuefield, type 1.

6. Click OK.

http://msdn.microsoft.com
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7. Exit Registry Editor.

Agent Event Log Descriptions
Trend Micro Safe Lock Intelligent Manager leverages the Windows™ Event Viewer to
display the Safe Lock Intelligent Manager event log. Access the Event Viewer at Start >
Control Panel > Administrative Tools.

Tip

Safe Lock event logging can be customized by doing the following:

• Before installation, modify the Setup.ini file. See Setup.ini File Arguments > EventLog
Section in the Safe Lock Installation Guide.

• After installation, modify the configuration file. See Configuration File Parameters > Log
Section on page 9-24.

Table 13-1. Windows Event Log Descriptions

Event ID Task
Category Level Description

1000 System Information Service started.

1001 System Warning Service stopped.

1002 System Information Application Lockdown Turned On.

1003 System Warning Application Lockdown Turned Off.

1004 System Information Disabled.

1005 System Information Administrator password changed.

1006 System Information Restricted User password changed.

1007 System Information Restricted User account enabled.

1008 System Information Restricted User account disabled.
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Event ID Task
Category Level Description

1009 System Information Product activated.

1010 System Information Product deactivated.

1011 System Warning License Expired. Grace period enabled.

1012 System Warning License Expired. Grace period ended.

1013 System Information Product configuration import started:
<full_path>

1014 System Information Product configuration import complete:
<full_path>

1015 System Information Product configuration exported to:
<full_path>

1016 System Information USB Malware Protection set to Allow.

1017 System Information USB Malware Protection set to Block.

1018 System Information USB Malware Protection enabled.

1019 System Warning USB Malware Protection disabled.

1020 System Information Network Virus Protection set to Allow.

1021 System Information Network Virus Protection set to Block.

1022 System Information Network Virus Protection enabled.

1023 System Warning Network Virus Protection disabled.

1025 System Information Memory Randomization enabled.

1026 System Warning Memory Randomization disabled.

1027 System Information API Hooking Prevention set to Allow.

1028 System Information API Hooking Prevention set to Block.

1029 System Information API Hooking Prevention enabled.

1030 System Warning API Hooking Prevention disabled.
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Event ID Task
Category Level Description

1031 System Information DLL Injection Prevention set to Allow.

1032 System Information DLL Injection Prevention set to Block.

1033 System Information DLL Injection Prevention enabled.

1034 System Warning DLL Injection Prevention disabled.

1035 System Information Predefined Trusted Updater enabled.

1036 System Information Predefined Trusted Updater disabled.

1037 System Information DLL/Driver Lockdown enabled.

1038 System Warning DLL/Driver Lockdown disabled.

1039 System Information Script Lockdown enabled.

1040 System Warning Script Lockdown disabled.

1041 System Information Script added.

[Details]

File extension: <extension>

Interpreter: <interpreter>

1042 System Information Script removed.

[Details]

File extension: <extension>

Interpreter: <interpreter>

1044 System Information Exception path enabled.

1045 System Information Exception path disabled.
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Event ID Task
Category Level Description

1046 System Information Event Log settings changed.

[Details]

Windows Event Log: <ON|off>

System Log: <on|OFF>

Exception Path Log: <ON|off>

Write Protection Log: <ON|off>

List Log: <ON|off>

Approved Access Log: <ON|off>

DLL Driver Log: <on|OFF>

Trusted Updater Log: <ON|off>

Exception Path Log: <ON|off>

Trusted Certification Log: <ON|off>

Write Protection Log: <ON|off>

Blocked Access Log: <ON|off>

USB Malware Protection Log: <on|OFF>

Execution Prevention Log: <on|OFF>

Network Virus Protection Log: <on|OFF>

Integrity Monitoring Log File Created Log:
<ON|off>

File Modified Log: <ON|off>

File Deleted Log: <ON|off>

File Renamed Log: <ON|off>

RegValue Modified Log: <ON|off>

RegValue Deleted Log: <ON|off>

RegKey Created Log: <ON|off>

RegKey Deleted Log: <ON|off>

RegKey Renamed Log: <ON|off>

Debug Log: <on|OFF>
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Event ID Task
Category Level Description

1047 System Information Trusted certificate enabled.

1048 System Information Trusted certificate disabled.

1049 System Information Write Protection enabled.

1050 System Warning Write Protection disabled.

1051 System Information Write Protection set to Allow.

1052 System Information Write Protection set to Block.

1055 System Information Added file to Write Protection List.

Path: <full_path>

1056 System Information Removed file from Write Protection List.

Path: <full_path>

1057 System Information Added file to Write Protection Exception
List

Path: <full_path>

Process: <process>

1058 System Information Removed file from Write Protection
Exception List.

Path: <full_path>

Process: <process>

1059 System Information Added folder to Write Protection List.

Path: <full_path>

Scope: Folder

1060 System Information Removed folder from Write Protection
List.

Path: <full_path>

Scope: Folder
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Event ID Task
Category Level Description

1061 System Information Added folder to Write Protection
Exception List.

Path: <full_path>

Scope: Folder

Process: <process>

1062 System Information Removed folder from Write Protection
Exception List.

Path: <full_path>

Scope: Folder

Process: <process>

1063 System Information Added registry value to Write Protection
List.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

1064 System Information Removed registry value from Write
Protection List.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

1065 System Information Added registry value to Write Protection
Exception List.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

Process: <process>
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Event ID Task
Category Level Description

1066 System Information Removed registry value from Write
Protection Exception List.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

Process: <process>

1067 System Information Added registry key to Write Protection
List.

Registry Key: <reg_key>

Scope: Registry Key

1068 System Information Removed registry key from Write
Protection List.

Registry Key: <reg_key>

Scope: Registry Key

1069 System Information Added registry key to Write Protection
Exception List.

Registry Key: <reg_key>

Scope: Registry Key

Process: <process>

1070 System Information Removed registry key from Write
Protection Exception List.

Registry Key: <reg_key>

Scope: Registry Key

Process: <process>

1071 System Information Custom Action set to Ignore.

1072 System Information Custom Action set to Quarantine.
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Event ID Task
Category Level Description

1073 System Information Custom Action set to Ask Intelligent
Manager.

1074 System Information Quarantined file is restored.

[Details]

Original Location: <full_path>

Source: <source>

1075 System Information Quarantined file is deleted.

[Details]

Original Location: <full_path>

Source: <source>

1076 System Information Integrity Monitoring enabled.

1077 System Information Integrity Monitoring disabled.

1078 System Information Root cause analysis report failed.

[Details]

Access Image Path: <full_path>

1079 System Information Server certificate imported: <full_path>

1080 System Information Server certificate exported to: <full_path>

1081 System Information Managed mode configuration imported:
<full_path>

1082 System Information Managed mode configuration exported to:
<full_path>

1083 System Information Managed mode enabled.

1084 System Information Managed mode disabled.
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Event ID Task
Category Level Description

1085 System Information When Write Protection is enabled, it
includes the Write Protection List and the
Approved List.

1086 System Warning When Write Protection is enabled, it
includes the Write Protection List only.

1087 System Information Event log settings changed.

1088 System Information Windows Update Support enabled.

1089 System Information Windows Update Support disabled.

1094 System Information Trend Micro Safe Lock updated.

File applied: <file_name>

1096 System Information Trusted Hash List enabled.

1097 System Information Trusted Hash List disabled.

1098 System Information Event log settings changed.

1099 System Information Storage device access set to Allow.

1100 System Information Storage device access set to Block.

1101 System Information Storage device control enabled.

1102 System System Storage device control disabled.

1103 System System Event Log settings changed.

1500 List Information Trusted Updater started.

1501 List Information Trusted Updater stopped.

1502 List Information Approved List import started: <full_path>

1503 List Information Approved List import complete:
<full_path>

1504 List Information Approved List exported to: <full_path>
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Event ID Task
Category Level Description

1505 List Information Added to Approved List: <full_path>

1506 List Information Added to Trusted Updater List:
<full_path>

1507 List Information Removed from Approved List: <full_path>

1508 List Information Removed from Trusted Updater List:
<full_path>

1509 List Information Approved List updated: <full_path>

1510 List Information Trusted Updater List updated: <full_path>

1511 List Warning Unable to add to or update Approved List:
<full_path>

1512 List Warning Unable to add to or update Trusted
Updater List: <full_path>

1513 List Information Added to Exception Path List.

[Details]

Type: <exception_path_type>

Path: <exception_path>

1514 List Information Removed from Exception Path List.

[Details]

Type: <exception_path_type>

Path: <exception_path>
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Event ID Task
Category Level Description

1515 List Information Added to Trusted Certificate List.

[Details]

Label: <label>

Hash: <hash_value>

Type: <type>

Subject: <subject>

Issuer: <issuer>

1516 List Information Removed from Trusted Certificate List.

[Details]

Label: <label>

Hash: <hash_value>

Type: <type>

Subject: <subject>

Issuer: <issuer>

1517 System Information Hash value added to the Trusted Hash
List.

[Details]

Label: <label>

Hash: <hash_value>

Type: <type>

Add to Approved List: <yes|no>

Path: <file_path>

Note: <note>
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Event ID Task
Category Level Description

1518 System Information Hash value removed from the Trusted
Hash List.

[Details]

Label: <label>

Hash: <hash_value>

Type: <type>

Add to Approved List: <yes|no>

Path: <file_path>

Note: <note>

2000 Access
Approved

Information File access allowed: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

List: <list>

2001 Access
Approved

Warning File access allowed: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>
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Event ID Task
Category Level Description

2002 Access
Approved

Warning File access allowed: <full_path>

Unable to get the file path while checking
the Approved List.

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2003 Access
Approved

Warning File access allowed: <full_path>

Unable to calculate hash while checking
the Approved List.

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2004 Access
Approved

Warning File access allowed: <full_path>

Unable to get notifications to monitor
process.

2005 Access
Approved

Warning File access allowed: <full_path>

Unable to add process to non exception
list.

2006 Access
Approved

Information File access allowed: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>
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Event ID Task
Category Level Description

2007 Access
Approved

Warning File access allowed: <full_path>

An error occurred while checking the
Exception Path List.

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2008 Access
Approved

Warning File access allowed: <full_path>

An error occurred while checking the
Trusted Certificate List.

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2011 Access
Approved

Information Trusted registry value access allowed.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>
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Event ID Task
Category Level Description

2012 Access
Approved

Information Trusted registry key access allowed.

Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2013 Access
Approved

Information Change of File/Folder allowed by
Exception List: <full_path>

[Details]

Access Image Path: Access User:
<user_name>

Mode: <mode>

2015 Access
Approved

Information Change of Registry Value allowed by
Exception List.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>
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Event ID Task
Category Level Description

2016 Access
Approved

Information Change of Registry Key allowed by
Exception List.

Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2017 Access
Approved

Warning Change of File/Folder allowed:
<full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name> Mode:
<mode>

2019 Access
Approved

Warning Change of Registry Value allowed.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2020 Access
Approved

Warning Change of Registry Key allowed.

Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>
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Event ID Task
Category Level Description

2021 Access
Approved

Warning File access allowed: <full_path>

An error occurred while checking the
Trusted Hash List.

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2503 Access
Blocked

Warning Change of File/Folder blocked:
<full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2505 Access
Blocked

Warning Change of Registry Value blocked.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>
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Event ID Task
Category Level Description

2506 Access
Blocked

Warning Change of Registry Key blocked.

Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

2507 Access
Blocked

Information Specified action is taken: <full_path>

[Details]

Action: <action>

Source: <source>

2508 Access
Blocked

Warning Failed to take specified action: <full_path>

[Details]

Action: <action>

Source: <source>

2509 Access
Blocked

Warning File access blocked: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

Reason: Not in Approved List
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Event ID Task
Category Level Description

2510 Access
Blocked

Warning File access blocked: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

Reason: Hash does not match expected
value

2511 Access
Blocked

Information Change of File/Folder blocked:
<full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Mode: <mode>

3000 USB Malware
Protection

Warning Device access allowed: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Device Type: <type>

3001 USB Malware
Protection

Warning Device access blocked: <full_path>

[Details]

Access Image Path: <full_path>

Access User: <user_name>

Device Type: <type>
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Event ID Task
Category Level Description

3500 Network Virus
Protection

Warning Network virus allowed: <name>

[Details]

Protocol: TCP

Source IP Address: <ip_address>

Source Port: <port>

Destination IP Address: <ip_address>

Destination Port: <port>

3501 Network Virus
Protection

Warning Network virus blocked: <name>

[Details]

Protocol: TCP

Source IP Address: <ip_address>

Source Port: <port>

Destination IP Address: <ip_address>

Destination Port: <port>

4002 Process
Protection
Event

Warning API Hooking allowed: <full_path>

[Details]

Threat Image Path: <full_path>

Threat User: <user_name>

4003 Process
Protection
Event

Warning API Hooking blocked: <full_path>

[Details]

Threat Image Path: <full_path>

Threat User: <user_name>
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Event ID Task
Category Level Description

4004 Process
Protection
Event

Warning DLL Injection allowed: <full_path>

[Details]

Threat Image Path: <full_path>

Threat User: <user_name>

4005 Process
Protection
Event

Warning DLL Injection blocked: <full_path>

[Details]

Threat Image Path: <full_path>

Threat User: <user_name>

4500 Changes in
System

Information File/Folder created: <full_path>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

4501 Changes in
System

Information File modified: <full_path>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

4502 Changes in
System

Information File/Folder deleted: <full_path>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>
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Event ID Task
Category Level Description

4503 Changes in
System

Information File/Folder renamed: <full_path>

New path: <full_path>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

4504 Changes in
System

Information Registry Value modified.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

Registry Value Type: <reg_value_type>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

4505 Changes in
System

Information Registry Value deleted.

Registry Key: <reg_key>

Registry Value Name: <reg_value>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>
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Event ID Task
Category Level Description

4506 Changes in
System

Information Registry Key created.

Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

4507 Changes in
System

Information Registry Key deleted.

Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

4508 Changes in
System

Information Registry Key renamed.

Registry Key: <reg_key>

New Registry Key: <reg_key>

[Details]

Access Image Path: <full_path>

Access Process ID: <proc_id>

Access User: <user_name>

Agent Error Code Descriptions
This list describes the various error codes used in Trend Micro Safe Lock Intelligent
Manager.
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Table 13-2. Trend Micro Safe Lock Intelligent Manager Error Code Descriptions

Code Description

0x00040200 Operation successful.

0x80040201 Operation unsuccessful.

0x80040202 Operation unsuccessful.

0x00040202 Operation partially successful.

0x00040203 Requested function not installed.

0x80040203 Requested function not supported.

0x80040204 Invalid argument.

0x80040205 Invalid status.

0x80040206 Out of memory.

0x80040207 Busy. Request ignored.

0x00040208 Retry. (Usually the result of a task taking too long)

0x80040208 System Reserved. (Not used)

0x80040209 The file path is too long.

0x0004020a System Reserved. (Not used)

0x8004020b System Reserved. (Not used)

0x0004020c System Reserved. (Not used)

0x0004020d System Reserved. (Not used)

0x8004020d System Reserved. (Not used)

0x0004020e Reboot required.

0x8004020e Reboot required for unexpected reason.

0x0004020f Allowed to perform task.

0x8004020f Permission denied.
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Code Description

0x00040210 System Reserved. (Not used)

0x80040210 Invalid or unexpected service mode.

0x00040211 System Reserved. (Not used)

0x80040211 Requested task not permitted in current status. Check license.

0x00040212 System Reserved. (Not used)

0x00040213 System Reserved. (Not used)

0x80040213 Passwords do not match.

0x00040214 System Reserved. (Not used)

0x80040214 System Reserved. (Not used)

0x00040215 Not found.

0x80040215 "Expected, but not found."

0x80040216 Authentication is locked.

0x80040217 Invalid password length.

0x80040218 Invalid characters in password.

0x00040219 Duplicate password. Administrator and Restricted User passwords
cannot match.

0x80040220 System Reserved. (Not used)

0x80040221 System Reserved. (Not used)

0x80040222 System Reserved. (Not used)

0x80040223 File not found (as expected, and not an error).

0x80040224 System Reserved. (Not used)

0x80040225 System Reserved. (Not used)

0x80040240 Library not found.
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Code Description

0x80040241 Invalid library status or unexpected error in library function.

0x80040260 System Reserved. (Not used)

0x80040261 System Reserved. (Not used)

0x80040262 System Reserved. (Not used)

0x80040263 System Reserved. (Not used)

0x80040264 System Reserved. (Not used)

0x00040265 System Reserved. (Not used)

0x80040265 System Reserved. (Not used)

0x80040270 System Reserved. (Not used)

0x80040271 System Reserved. (Not used)

0x80040272 System Reserved. (Not used)

0x80040273 System Reserved. (Not used)

0x80040274 System Reserved. (Not used)

0x80040275 System Reserved. (Not used)

0x80040280 Invalid Activation Code.

0x80040281 Incorrect Activation Code format.
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A
accounts. See web console accounts
agent configuration file, 9-2, 9-8

editing, 9-2
exporting or importing, 9-2
syntax, 9-3

agent endpoint preparation
Windows 10, 7-10
Windows 10 Enterprise, 7-10
Windows 10 IoT Enterprise, 7-10
Windows 7, 7-8
Windows 8, 7-9
Windows 8.1, 7-9
Windows Server 2003, 7-4
Windows Server 2003 R2, 7-4
Windows Server 2008, 7-5
Windows Server 2008 R2, 7-5
Windows Server 2012, 7-6
Windows Server 2012 R2, 7-6
Windows XP, 7-7

agent events
exporting, 3-11
importing, 3-11
log maintenance, 3-14
notifications, 4-5
querying logs, 3-9
tracking, 3-8

agent installer
approved list, 5-2, 8-9
command line interface, 8-11, 8-12
downloading, 4-3, 7-14
modified packages, 4-4
overview, 8-2
Setup.ini Agent section, 8-25

Setup.ini arguments, 8-15
Setup.ini BlockNotification section, 8-34
Setup.ini EventLog section, 8-21
Setup.ini MessageRandomization
section, 8-27
Setup.ini Message section, 8-26
Setup.ini Prescan section, 8-29
Setup.ini Property section, 8-15
Setup.ini Proxy section, 8-28
Setup.ini Server section, 8-25
Setup.ini use, 8-14
upgrade preparation, 1-17
Windows Installer, 8-2

agents, 1-8
account passwords, 5-18
accounts, 1-10, 5-17
changing lockdown, 2-8
collecting logs, 2-10
collecting status, 2-10
component update locations, 4-5
console, 5-6
editing tags, 2-6
error codes, 13-26
event ID codes, 13-4
features and benefits, 1-9
manual component updates, 4-2
operating systems, 1-11
querying, 2-3
remote setup, 7-2
removing from list, 2-7
scheduled component updates, 4-3
settings, 5-19, 5-22
status icons, 5-9
system requirements, 1-11
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uninstallation, 10-2
use overview, 1-18

Application Lockdown, 1-9
Approved List, 5-10

adding or removing files, 5-14
checking or updating hashes, 5-12
configuring, 5-13
exporting or importing, 5-16
hashes, 5-12
installing or updating files, 5-15
setting up, 5-2, 8-9

C
configuration file. See agent configuration
file
console

feature comparison, 6-2

D
dashboard, 3-2

adding tabs, 3-4
default tabs, 3-3
tabs, 3-2
tab settings, 3-5

dashboard widgets. See widgets
default shares, 13-3
documentation, vii
documentation feedback, 12-6

E
error codes. See agents, error codes
event ID codes. See agents, event ID codes
events. See agent events; server events
Exploit Prevention, 1-9

H
hashes, 5-12

I
installation

customization, 8-14
methods, 8-2

installer. See agent installer

L
local accounts

enabling administrator, 13-2
enabling default shares, 13-3

N
Network Virus Protection, 8-4, 8-12
notifications, 4-5, 4-8

O
operating systems. See agents, operating
systems; server, operating systems

P
passwords. See agents, account passwords

R
remote tasks. See SLrst Program; SLtasks
Program
requirements. See agents, system
requirements; server, system requirements
Restricted User account

enabling, 5-19

S
Safe Lock. See agents; server
Safe Lock Intelligent Manager. See server
server, 1-2

accounts, 1-7
features and benefits, 1-3
message time groups, 7-29
notifications, 4-8
operating systems, 1-4
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remote tasks, 7-2, 7-21
system requirements, 1-4

server console. See web console
server events

exporting, 3-14
log maintenance, 3-14
querying logs, 3-13
tracking, 3-13

SLCmd Commands
For Application Lockdown, 6-26
For Approved List, 6-23
For Central Management, 6-8
For Configuration File, 6-65
For General Actions, 6-4
For notifications of file blocking, 6-64
For Optional Features, 6-10
For Predefined Trusted Updater, 6-56
For Predefined Trusted Updater
"Add", 6-61
For Restricted User Accounts, 6-20
For Scripts, 6-21
For Trusted Certifications, 6-51
For Trusted Hash List, 6-52
For Trusted Updater, 6-55
For Windows Update Support, 6-63
For Write Protection, 6-28

SLCmd Program, 6-4
commands. See SLCmd Commands
comparison to console functions, 6-2
using, 6-2

SLrst Program, 7-2
agent target files, 7-11–7-13
downloading installers, 4-3, 7-14
remote installation considerations, 7-3
remotely installing agents, 7-16
remotely restarting agents, 7-20

remotely uninstalling agents, 7-19
SLtasks Program, 7-21

message time groups, 7-29
remotely hotfixing agents, 7-28
remotely patching agents, 7-28

support
resolve issues faster, 12-4

system requirements. See agents, system
requirements; server, system requirements

T
tabs. See dashboard
tab widgets. See widgets
terminology, ix
Trend Micro Portable Security, 1-10
Trusted Updater, 5-15

U
uninstallation. See agents, uninstallation
upgrading. See agent installer, upgrade
preparation

W
web console

accounts. See web console accounts
activation codes, 4-13
agent statuses and settings, 2-4
changing lockdown, 2-8
collecting logs, 2-10
component updates, 4-2
dashboard. See dashboard
editing agent tags, 2-6
exporting agent events, 3-11
exporting server events, 3-14
importing agent events, 3-11
license management, 4-12, 4-13
log maintenance, 3-14
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marking events, 3-12
proxy settings, 4-11
querying agent events, 3-9
querying agents, 2-3
querying server events, 3-13
removing agents, 2-7
widgets. See widgets

web console accounts, 4-8
adding, 4-10
editing, 4-11

widgets, 3-5. See also dashboard
adding, 3-7
using, 3-6
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